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Copyright and Trademark Notice 
Copyright 
All material contained in this document is protected by copyright law. 

©2018 Arpelligo, Inc. (dba Accountable Software) All Rights Reserved 

Trademarks 
Forms Printer is a trademark of Arpelligo, Inc. (dba Accountable Software). Other company or product names 
mentioned may be trademarks or registered trademarks of their respective holders. 

Microsoft Dynamics GP is a trademark of Microsoft Corporation in the United States and/or other countries. 

Microsoft product screenshots reprinted with permission from Microsoft Corporation.  



 

Contacting Us 
Technical Support 
Accountable Software Technical Support is available Monday through Friday from 9:00 am to 5:00 pm EST. 
Technical Support can be reached in the following ways: 

610.983.3100 (voice) - support@accountable.com 

When you call, or E-mail Accountable Software for support, please include the following information: 

• Your name 
• Your company name and phone number 
• Product inquiring about and the version you are running (from the registration window) 
• A brief description of the problem. 

In addition, have this manual available when you are connected with Customer Support. You may be directed 
to various pages in the manual as you receive assistance. Please also be aware that all technical support 
issues are billable unless the issue you are calling about is the result of a defect in an Accountable Software 
product or accompanying documentation.   Customers without pre-paid support incidents, will be required to 
provide credit card information prior to opening an incident, but will not be charged if the call is non-billable.  
For the latest Accountable Software Support Policies, see the “Support” section of the Accountable Software 
Web site at https://www.accountable.com/Support/. 

Sales 
For more information, pricing details or to schedule a demo, please contact us at: 

610.983.3100 option: 1 - sales@accountable.com 

Web Site 
Product downloads, documentation and videos can be found on our website: www.accountable.com 

Resource Center 
From the Resource Center, you can access downloads, Renewals, Registration keys and support. Access to 
the Resource Center, our Partner and Customer portal, is available here: www.accountable.com/login 

Mailing Address 
70 Buckwalter Rd., Suite 900, Royersford, PA 19468  

mailto:support@accountable.com
mailto:sales@accountable.com


 

System Requirements 
Microsoft SQL Server Requirement 
While Forms Printer works with Microsoft SQL Server 2005 or higher, the SQL Server version compatible will 
be determined by the version of Dynamics GP and the requirements of that version. 

 

Report Tool Requirements 
Reporting Services 2005 or higher with Report Manager for SQL Reporting Services functionality 

Crystal Reports Version 9.0 or higher 

  



 

Understanding Forms Printer Modules 
Forms Printer Base System 
The Base System allows you to control delivery of very specific documents in the main Dynamics GP product. 
This integration is very seamless and allows for processing of these documents by batch, range and in every 
GP window that supports that document type. The list of supported documents includes: SOP, POP, RM 
Transactions, RM Statements, Invoicing Module Invoices, and Payroll and Payables Checks. 

Forms Printer Base System DOES NOT include the functionality of Forms Printer Plus or Forms Printer for 
Project. 

Forms Printer Base System GP Email Replacer 
Included as part of the Base System module, G Email Replacer allows systems not designed to support 
Microsoft’s Modern Authentication changes to continue to Email reports and Word Template forms with a 
very simple and fast setup. Once enabled, use GP as you always have related to Emailing. 

Form Printer Plus 
Forms Printer Plus allows printing of documents not integrated to by Forms Printer Base System or Forms 
Printer for Project, allowing you to define the window and button that will launch the report. This can include 
windows from Add-On modules, 3rd party products and customizations. 

The Forms Printer Plus module includes the functionality of the Forms Printer Base System but DOES NOT 
include the functionality of Forms Printer for Project. 

Forms Printer for Project Accounting 
Forms Printer for Project Accounting allows a tight integration to the Project Invoice and PO printing 
processes and offers delivery of these documents just as the Base System offers. 

Forms Printer for Project DOES NOT include the functionality of Forms Printer Base System or Forms Printer 
Plus. 

Forms Printer for Web Client 
Forms Printer for Web Client allows a limited set of Forms Printer features to be available in the Dynamics GP 
Web Client. A license for the Forms Printer for Web Client is available for each license of Forms Printer Base, 
Project or Plus that is installed. See Forms Printer for Web Client for details. 

Summary 
It is important to understand the integration of the Forms Printer Base System and Forms Printer for Project 
and how those integrations relate to the printing of their respective documents as well as understanding the 
capabilities and limitations of Forms Printer for Web Client. Please contact our sales and / or support teams 
with any questions on which module will be most productive for your needs  



 

Installation 
The installation process detailed below applies to all of Forms Printer whether you will be using Forms Printer 
Base System, Forms Printer for Project Accounting, Forms Printer Plus or Forms Printer for Web Client. 

Overview 
The initial installation of Forms Printer is performed in several steps, which are: 

1. First is the installation of the initial Forms Printer client application.  

2. Include Forms Printer client code in the Microsoft Dynamics GP client application set.  

3. Initiate the installation of SQL Server objects and data. 

4. The Forms Printer Registration keys are entered to enable the application.  

5. Finish the installs and setup. Once Forms Printer is registered, the next three setup steps can be 

completed in whatever order you wish. These steps are: 

• Install additional workstations with the client application 

• Enter Roles and Tasks in the new Dynamics GP security models  

• Add Report Engine Setup information.  

Installation Checklist 
Step Description X 

1 Download the latest version of Forms Printer  

2 Obtain registration keys for the downloaded version  

3 Run the installation executable on the first workstation  

4 Launch Dynamics GP using an Administrative user  

5 Include new code  

6 Install and Initialize tables in first Company  

7 Enter registration keys  

8 Install and Initialize tables in additional Companies  

9 Add Dynamics GP Roles and Tasks  
  



 

Installing the First Forms Printer Client Application 
The installation of the initial Forms Printer client application is different than subsequent installs because 3 
additional steps must be followed. Those steps are to:  Include Forms Printer in the Dynamics GP System 
Database, Enter Forms Printer Registration Keys, and Install SQL Server Objects in Additional Companies.  

Run the Installation 
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP client 
workstation: 

1. Download the Forms Printer Installation File 

a. Download the latest version of Forms Printer. Checking our web site for the most current 
version of the product before installation ensures that any updates or fixes are installed and 
is highly recommended. 

b. The file downloaded from the Accountable Software Resource Center will contain an 
installation file named Forms Printer XXXX.msi (where the XXXX will be the installing 
version).  

2. Double Click on the setup.msi installer file to begin the installation. 

3. Follow the installation wizard to complete the installation of Forms Printer. 

a. The installation program begins with a “Welcome” window.  Take a moment to verify that 
the proper version for you Dynamics GP application is being installed. When ready, click 
Next>. 

b. Review the license agreement, and if you agree, confirm your acceptance to the terms 
described within by clicking I Agree. Note: You cannot install Forms Printer if you do not 
accept the terms. When ready, click Next>. 

c. Review the Additional License Agreement required for using the Business Objects Runtime. 
If you agree, confirm your acceptance to the Business Objects terms described within by 
clicking I Agree. Note: You cannot install Forms Printer if you do not accept the terms. When 
ready, click Next>. 

d. Select the folder in which the Microsoft Dynamics GP application is installed. This folder is 
typically located on your local hard drive. The install program will attempt to default the 
installation to The Microsoft Dynamics GP Application folder. If the detected folder is not the 
location where Microsoft Dynamics GP is installed on your machine you will need to select 
the correct folder in which to install Forms Printer. When ready, click Next>. 

e. The Confirmation window provides a final opportunity to ensure the proper version 
installed. When ready, click Next>. The setup program will then begin to copy all files to the 
appropriate directories. 

f. When the installation has completed, the final window displays important information on 
documentation and other file locations. When ready, click Next>. 

g. The installation complete window is displayed. When ready, click Close. 

  



 

Include Forms Printer in the Dynamics GP Installation 
1. Launch Microsoft Dynamics GP as Administrator (or user with administrative privileges) 

2. Log in as ‘sa’ or a database administrator.  

3.  A dialog window prompting to include the new code will be displayed, as shown in the following 
illustration: 

Click Yes and wait until the process has completed. 

  

A progress bar will display, while the “unchunking” process is executing. At this point, our DYNAMICS.SET 
file will be modified to include the information required to run Forms Printer, and two dictionaries 
named “FPD1230.DIC” and ”ASI1655.DIC” will be created in your Microsoft Dynamics GP application 
folder. 

Install SQL Server Objects 
 After the new code is loaded, you must install Forms Printer to the SQL Server Database and will be 
prompted to do so after logging into Dynamics GP. When prompted, using the steps below and you must 
repeat this database installation for each Dynamics GP Company by logging into each company and repeating 
the steps: 

1. When presented with the dialog window prompting to install and initialize Custom Report 
Integration tables click Yes to initialize the new tables. 

2. When presented with the dialog window prompting to install and initialize Forms Printer tables click 
Yes to initialize the new tables. 

3. If running the Project Accounting module, you will be prompted with the dialog window asking to 
initialize Project Accounting tables click Yes to initialize the new tables. 

Install SQL Server Objects in Additional Companies 
To complete the SQL Server installation process, it is required that the following steps are completed for each 
Company: 

1. Log in as ‘sa’ or a database administrator.  

2. When presented with the dialog window prompting to install and initialize Custom Report 
Integration tables click Yes to initialize the new tables. 

3. When presented with the dialog window prompting to install and initialize Forms Printer tables click 
Yes to initialize the new tables. 

4. If running the Project Accounting module, you will be prompted with the dialog window asking to 
initialize Project Accounting tables click Yes to initialize the new tables. 



 

Enter Forms Printer Registration Keys 
Once the Database installation is completed you will be presented with the message to enter registration 
keys in companies other than the Lesson Company. To register Forms Printer, follow these steps: 

1. When prompted to register, click Yes to open the Forms Printer Registration window.  

2. If no registration prompt is presented, open the Accountable Software Registration window by 

clicking the Help icon, then selecting About Microsoft Dynamics GP.  The About Microsoft Dynamics 

GP window will open, and a Forms Printer Registration window will open as a companion window. 

3. Click the Register button to open the Forms Printer Registration window.  

4. Enter the registration keys exactly as you received them from Accountable Software for your 

Microsoft Dynamics GP installation.  

5. Registration keys are provided by Accountable Software directly. For more information or to obtain 

your registration keys, please log in to the My Account section of our web site at 

www.accountable.com/login, call (610) 983-3100, or E-mail sales@accountable.com.  

6. Click Register. If you mistyped the keys, you will receive a warning message. Try again. If you still 

receive a warning, contact Accountable Software for assistance at techsupport@accountable.com. 

7. Verify the Registration Keys. 

8. If the module(s) you are registering appear with a checkbox in the Registered column, the 

registration was successful.  

9. Click the Close. 

  

mailto:sales@accountable.com


 

Installing Forms Printer on Additional Workstations 
In order to use Forms Printer on additional workstations, you must follow the client installation steps on 
those workstations. Be sure to install the same version on all workstations. Note that once the previous steps 
have been completed, the SQL Server installation and registration key entry is completed and does not need 
to be repeated. For additional workstation installs, follow these steps: 

Run the Installation 
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP client 
workstation: 

1. Double Click on the setup.msi installer file to begin the installation. 

2. Follow the installation wizard to complete the installation of Forms Printer. 

a. The installation program begins with a “Welcome” window.  Take a moment to verify that 

the proper version for you Dynamics GP application is being installed. When ready, click 

Next>. 

b. Review the license agreement, and if you agree, confirm your acceptance to the terms 

described within by clicking I Agree. Note: You cannot install Forms Printer if you do not 

accept the terms. When ready, click Next>. 

c. Review the Additional License Agreement required for using the Business Objects Runtime. 

If you agree, confirm your acceptance to the Business Objects terms described within by 

clicking I Agree. Note: You cannot install Forms Printer if you do not accept the terms. When 

ready, click Next>. 

d. Select the folder in which the Microsoft Dynamics GP application is installed. This folder is 

typically located on your local hard. The install program will attempt to default the 

installation to The Microsoft Dynamics GP Application folder. If the detected folder is not the 

location where Microsoft Dynamics GP is installed on your machine you will need to select 

the correct folder in which to install Forms Printer. When ready, click Next>. 

e. The Confirmation window provides a final opportunity to ensure the proper version 

installed. When ready, click Next>. 

The setup program will then begin to copy all files to the appropriate directories. 

f. When the installation has completed, the final window displays important information on 

documentation and other file locations. When ready, click Next>. 

g. The installation complete window is displayed. When ready, click Close. 



 

Include Forms Printer in the Dynamics GP Installation 
1. Launch Microsoft Dynamics GP using the ‘Run as Administrator’ option (or a user with administrative 

privileges). 

2. Log in as ‘sa’ or a database administrator.  

3.  A dialog window prompting to include the new code will be displayed, as shown in the following 

illustration: 

Click Yes and wait until the process has completed. 

A progress bar will display, while the “unchunking” process is executing. At this point, our DYNAMICS.SET file 
will be modified to include the information required to run Forms Printer, and two dictionaries named 
“FPD1230.DIC” and “ASI1655.DIC” will be created in your Microsoft Dynamics GP application folder. 

Uninstalling Forms Printer 
If it becomes necessary to temporarily disable Forms Printer on a Microsoft Dynamics GP workstation, one 
can use the Microsoft Dynamics GP Tools->Customization->Customization Status Window to Disable the 
Forms Printer product for one login Session. 

In order to more permanently disable Forms Printer on a Workstation, one must edit the Microsoft Dynamics 
GP “Launch” file (typically named Dynamics.set) to remove references to the Forms Printer Product (ID = 
1230), and the Supporting “CRI” component (Product ID = 1655).  Microsoft Dynamics GP provides a facility 
for editing the launch file from the Tools->Setup->System->Edit Launch file menu.  The Microsoft Dynamics 
GP Help Topic from this window describes how to remove a product from the Launch File using a text editor. 

In order to Completely remove Forms Printer and the Components that it installed, one should remove it 
from the Launch file, then remove the runtime components using Windows Programs and Features Control 
Panel Applet, then optionally delete the FPD123.DIC Forms Printer Dictionary, delete the ASI1655.dic Custom 
Reports Dictionary file. To remove the SQL Server objects, drop the tables from the GP System database and 
each of the company databases that begin with “ASI123” and “ASI124”, and drop the stored procedures in 
the Microsoft Dynamics GP System and Company Databases that begin “zDP_ASI123” and “zDP_ASI124”.  



 

Configuration 
Once the installation of Forms Printer has been completed, the next step is to begin the configuration of 
Forms Printer Base and Forms Printer for Project and / or configure Forms Printer Plus.  

Overview 
Once the installation of Forms Printer is complete, the next step is to configure the one-time settings 
required to begin use of Forms Printer. Whether Forms Printer Base or Forms Printer Plus will be used, the 
initial configuration steps must be completed. If using both Base and Plus, the configuration needs to be done 
only one time and can be done using either the Forms Printer Setup window or the Forms Printer Plus Setup 
window. 

Configuration Checklist 
Step Description X 

1 Add Roles and Tasks  

2 Navigate to the Forms Printer Setup or Forms Printer Plus Setup Window  

3 

Enter Report Engine Setup Information 
• SQL Server Reporting Services Setup: 

o Report Server URL: ________________________________ 
 

o Web Services URL: ________________________________ 
 

• Crystal Reports Setup: 
o SQL User: _______________________________________ 

 
o Password: XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX 

 

4 

Enter E-mail From Setup Information 
 

 Default Outlook User 
  

 Exchange Address List 
  

 Manually Entered List 
_____________________________________________________ 

 

 

5 Add a new Report to Setup  

 

Choose Report Options:  
1. Choose Report Tool 
 

 

2. Select Report Path 
 

 

3. Enter Delivery Options 
 

 



 

Adding Roles and Tasks 
With the new Security model implemented in Microsoft Dynamics GP 10 and greater, it becomes necessary 
to enable logins to use or administer Forms Printer by placing the users in Dynamics GP Roles. These Roles 
are made of Dynamics GP Tasks that allow access to various programs and code resources.  

Roles 
When Forms Printer Is initialized and logged into the first time, by ‘sa’ or ‘DYNSA’, The Following Tasks and 
Roles are created: 

FORMS PRINTER (CRI) ADMIN  
This role allows administration of the “Custom Report Integration” (CRI) settings that Forms Printer uses to 
connect the Crystal Reports Reporting Engine to the SQL database. 

FORMS PRINTER OPTIONS ADM 
This role allows users to access the Forms Printer Setup window where the setup and administration of 
various reports printed by Forms Printer are maintained. 

FORMS PRINTER USER 
This role is for users all users of Dynamics GP that will be using Forms Printer in any capacity to print reports. 
While it currently uses the same settings as the FORMS PRINTER OPTIONS ADM role, it can be modified as 
needed to restrict access to setup windows. 

The screenshot below shows the Forms Printer Roles in the Security Role Lookup window: 

 

All GP users who need to use Forms Printer should have at least the FORMS PRINTER USER Role added to 
their user security role list. If all users need access to Forms Printer printing, one can add the Forms Printer 
Security Tasks directly to a broadly applicable role which many users already have been placed in, such as 
“ORDER PROCESSOR”.  



 

Below is a screenshot showing an example adding the Forms Printer Administrator/User Tasks to the General 
“Order Processor” Role add the Security Task ID’s for the Setup Windows, and Forms Printer Options 
Windows: 

 

  



 

Tasks 
The Task ID’s above, can be duplicated, and then modified, if you need to apply finer grained control to users 
with regards to what Forms Printer related windows the user can open. The Default Security Task ID’s for 
Forms Printer are defined as shown below: 

 

Also: See the specific added window Operations under the ADMIN_FP_CRI_01 Task ID for the System series. 

 

Also:  See the specific added window Operations under the ADMIN_FP_CRI_02 Task ID for the Purchasing, 
Sales, and System series. 



 

Report Engine Setup 
From the Forms Printer Setup window or the Forms Printer Plus Setup window, the Report Engine Setup 
menu option includes two listings: Crystal Reports Setup, and SQL Server Reporting Services Setup. Report 
Engine refers to the reporting tool used to print reports from Forms Printer. Select the Reporting Engine you 
wish to setup. 

Note: You may use both the Crystal and SRS Reporting Engines with different reports setup to use either engine. 

Window Navigation 
To open the Report Engine Setup window, you must first Open the Forms Printer Setup window or the 
Forms Printer Plus Setup window using the menu navigation: Microsoft Dynamics GP > Tools > Setup > 
Company > Forms Printer or Forms Printer Plus 

On the Setup window, select Report Engine Setup then either Crystal Reports Setup, or SQL Server Reporting 
Services Setup. 

This screenshot shows the Report Engine menu from the Forms Printer Setup window. 

 

  



 

Crystal Reports Setup 
Press this button to open the Report Integration Setup Window where the Report Authentication for Crystal 
Reports can be specified. 

Window Buttons 
The buttons on the Crystal Reports Setup Window include: 

Buttons Description 
Save Saves the current entry values and closes the Window. 

Window Fields  
Fields Description 
SQL User Name Enter a valid SQL login. 
SQL Password Enter the password for the SQL User 
Verify Password Verify the password by entering it again. 

Window Example 
The screenshot below shows the entries for Crystal Reports using an example SQL Login “FormsPrinter”. The 
SQL Server user entered here can be placed in the GP SQL "DYNGRP" role or can separately be given Read 
Only access to the Databases which your Forms Printer report(s) will access. 

 

  



 

SQL Server Reporting Services Setup 
Prior to using SQL Reporting Services [SRS] with Forms Printer, you must add SRS setup information.  The use 
of SRS with Forms Printer is dependent on an installed and properly functioning SRS installation.  

Note: Installing Forms Printer DOES NOT affect an existing SRS installation in any way, nor does it install SSRS or any 

files required to run an SSRS installation.  

Window Buttons 
The buttons on the SQL Server Reporting Services Setup Window include: 

Buttons Description 
OK Saves the current entry values and closes the Window. 

Cancel Closes the window without saving any changes to the 
current entry values. 

Window Fields  
Fields Description 

SSRS Report Server URL This editable text field is used to enter the path to the 
Report Server Web Application.  

SSRS Report Server Web Services URL 
This editable text field is used to enter the path to the 
specific Web Services asmx page in the Reporting Services 
Web Applications. 

Window Example 
The screenshot below shows these entries for a default installation of Reporting Services on an example Web 
Server named “webserver”. 

 

Note:  The SSRS Report Server Web Services URL typically would begin with the same value as the SSRS Report Server 

URL and it must end with either “ReportService2005.asmx” no matter which version of SSRS you are using 

unless you have a SharePoint integrated version, in which case it should end with “ReportService2006.asmx”. 

  



 

E-mail Setup 
The Forms Printer Setup, E-mail Setup menu option allows you to configure one or more E-mail sending 
methods from the E-mail Method Setup menu option, as well as define which E-mail addresses will be used 
as the possible Send From E-mails during E-mail Delivery Setup. This is done from the E-mail Setup menu 
option. 

Window Navigation 

 

 

Enter E-mail Send Method Setup Information 
The E-mail Method Setup window allows you to define additional or E-mail Methods including Outlook, SMTP 
and Exchange Web Services. 

Window Buttons 
The buttons on the Window include: 

Buttons Description 

Save Saves the current displayed E-Mail Method settings. 

Delete Permanently deletes the displayed E-Mail Method. 

Cancel Closes the window without saving changes. 

Auto Discover EWS Enabled when the Exchange Web Services Radio Button is selected,  

Send Test E-mail Opens the Send Test E-mail window. 

Modern Authentication 
Help Button 

Opens the help page on the Accountable website with additional details regarding the 
use and configuration for modern authentication implemented by Microsoft affecting 
EWS access.  
 
Help Page path: 
https://www.accountable.com/Knowledgebase/FormsPrinter/Forms-Printer-
Modern-Authentication-Help 
 
 

 
  

https://www.accountable.com/Knowledgebase/FormsPrinter/Forms-Printer-Modern-Authentication-Help
https://www.accountable.com/Knowledgebase/FormsPrinter/Forms-Printer-Modern-Authentication-Help
https://www.accountable.com/Knowledgebase/FormsPrinter/Forms-Printer-Modern-Authentication-Help


 

Window Fields  
Fields Description 
Mail Delivery Setup Name Textbox to enter or display the name of the E-mail Method.  

Mail Delivery Setup Lookup  Look up button which opens the Mail Methods Lookup window. 

Use this Setup for GP Mailing This checkbox is used to indicate the Email Send Method which should be 
used if using the GP Email Replacer functionality 

E-mail Send Method A radio group of the available Send Methods. 

Outlook on GP Client Radio button indicating the default Send Method. 

SMTP Server Radio button to enable the entry of SMTP required values. 

Exchange Web Services Radio button to enable the entry of EWS required values. 

Port Required Field for Entering the SMTP Port. 

Security Dropdown used to select the cryptographic protocol for the SMTP Server. 

SMTP Server Name Required string field is used to enter the SMTP Server Send Methods. 

E-mail Login Name / ID Required login for the selected SMTP or EWS Server. 

E-mail Login Password Required password for the selected SMTP or EWS Server. 

EWS URL The URL of the Exchange Web Services Server. 

Save to Sent Items of “From 
Account” instead of sending mailbox 

This checkbox, when checked, will allow sent Emails to be saved to the Sent 
Emails folder of the Email profile selected in the E-mail From dropdown in 
Forms Printer Setup. Note this is a global setting applying to all reports using 
the Send Method being configured. 

Use Default Forms Printer 
Multitenant App ID and Tenant ID 

This checkbox, when checked, will auto fill the Modern Auth App ID/Client ID 
and Modern Auth Tenant ID fields with the default values and disable them. 

Modern Auth App ID/Client ID* This entry field is used to enter the unique string representing the registration 
information provided by the oAuth client (Forms Printer).   

Modern Auth Tenant ID* 

This entry field is used to enter a unique string representing the Azure Active 
Directory Domain, or Tenant, which will Authorize email related requests to 
the Mail Server. 
 
 

* In Azure, these fields are in the format of a GUID (Globally Unique Identifier), a 128 Bit number represented as a 
dash separated alphanumeric string.  Example: 9ebed935-090e-4121-9484-391b8db6cc68 

Throttle Emails Checkbox to allow setting a per minute Email sending speed. 

Throttle Emails Per Minute 

This entry field, enabled by the Throttle Emails checkbox, allows a number to 
be entered which will define the maximum number of Emails that can be sent 
in one minute when using EWS. For further details on throttling, see 
Microsoft EWS Throttling help 

 
  



 

Outlook on GP Client Send Method 
By default, Forms Printer uses Outlook as the E-mail Send Method and no setup is required to configure 
Forms Printer to use the Outlook Send Method. It is required that the Outlook client is installed and that a 
working Outlook profile is created. 

Method Example 

 

  



 

SMTP Server Send Method 
SMTP, short for Simple Mail Transfer Protocol is a communication protocol for the transfer of E-mail. Forms 
Printer allows one or more SMTP servers to be defined for use as an E-mail Send Method when delivering 
documents. 

When selecting the SMTP Server E-mail Send Method the fields to enter Port, Security option, SMTP Server 
Name, E-mail Login Name, and E-mail Login Password will be enabled. Also enabled are the Throttle Emails 
checkbox, Use Default Forms Printer Multitenant App ID and Tenant ID checkbox and fields. 

Method Example 

 

 

  



 

Exchange Web Services Send Method 
Choosing the Exchange Web Services Send Method enables the fields E-mail Login Name/ID, the E-mail 
Password, and EQS URL as well as displays the Auto Discover EWS Button. 

When selecting the Exchange Web Services E-mail Send Method, the fields E-mail Login Name, and E-mail 
Login Password, and EWS URL will be enabled. Also enabled are the Save to Sent Items checkbox, Throttle 
Emails checkbox, Use Default Forms Printer Multitenant App ID and Tenant ID checkbox and fields, and the 
Autodiscover EWS button. 

Method Example 

 

 

https://docs.microsoft.com/en-us/exchange/client-developer/web-service-reference/web-services-
reference-for-exchange 

Send Test E-mail Window 
This window is used to select Mail Delivery Setup Names, enter test values, and send test Emails to verify 
settings for URL, Login, and security. 

https://docs.microsoft.com/en-us/exchange/client-developer/web-service-reference/web-services-reference-for-exchange
https://docs.microsoft.com/en-us/exchange/client-developer/web-service-reference/web-services-reference-for-exchange


 

Window Buttons 
The buttons on the Window include: 

Buttons Description 

Send Executes the E-mail send using the values entered on the Send Test E-mail window. 

Ok Closes the Send Test E-mail window. 

Window Fields  
Fields Description 
Mail Delivery Setup Name Textbox to enter or display the name of the E-mail Method.  

Mail Method Type Radio Group displaying the Email method of the selected Mail Delivery Setup Name. 

Send Option This dropdown displays the available Send Option based on the selected Mail Method Type. 

Delay Hours Text field to enter the number of hours the Email should be delayed before sending. 

From, To, CC, and BCC Text fields to enter valid recipient E-mail Addresses individually or in a semi-colon separated list. 

Reply To A valid E-mail address will be used as the To address when Replying to the E-mail. 

Subject Text to be displayed in the subject of the test E-mail. 

Message Body Plain text or HTML to be used in the body of the test E-mail. 

Window Example 

  

  



 

Set Up GP Email Replacer 
Choose the GP Email Replacer Method 
After configuring the Send Method you would like to use for GP Email Replacer, select the method in the E-
mail Send Method window and mark the Use this Setup for GP Mailing checkbox and click Save. 

 

  



 

Set the System Preferences 
Once the Send Method for GP Email Replacer has been selected, go to Microsoft Dynamics GP > Tools > 
Setup > System > System Preferences. There, select User Forms Printer from the Email Preferences - Server 
Type dropdown and click OK to save. 

 

Note:  The MAPI server type is replaced with Use Forms Printer in the dropdown and must be the option selected in 

order to use GP Email Replacer. 

 

At this point, you can use GP Emailing for reports and Form Templates as you did before the modern 
authentication changes. 

  



 

Sign in to your account 
One difference will be that, once per GP session, you will receive the prompt to log on with your Microsoft 
Email Account as shown in the following window example. 

 

Generating E-mail Progress window 
As the Email is sending, the Progress window will display as is expected with GP Emailing. 

Note:  One indication that Forms Printer is handling the Emailing of the document is the resizing of the Generating E-

mail Progress window show below. If the window resizes slightly larger, Forms Printer was used to send the 

document. 

 

  



 

Checking the Email Internet Header Information 
Emails sent by Forms Printer GP Email Replacer will have an entry added to the Email’s Internet Headers 
viewable from the Sent Email’s File > Properties, Internet Headers section as shown in the following window: 

 

  



 

Additional Functionality In GP Email Replacer 
When using the Forms Printer Base System GP Email Replacer, several additional features, beyond the 
standard GP Emailing, are available. Those are: A Token for the Email From Address, and a Token for the 
Attachment File Name. 

Token for the Email From Address in EWS 
Using the GP Email Replacer, users can add a token to the Email Body that will allow them to control the 
Email From Address on Emails sent through the GP Email Replacer and have the sent Emails Saved to that 
shared mailbox’s Sent items 

Add the following token anywhere in the GP Email Message Body:  

[FP_From=<EmailFromHere>] 

Replace the placeholder text <EmailFromHere> with the Email Address you would like the Email to come 
from. When the Email is sent, the token will be removed from the body. 

Note: You must grant “Send As permission” to the authenticated user, on the “From Account” mailbox. Links to 

instructions for this setup are below. 

Reference: https://learn.microsoft.com/en-us/microsoft-365/admin/add-users/give-mailbox-permissions-to-

another-user?view=o365-worldwide 

Reference:  https://learn.microsoft.com/en-us/exchange/recipients-in-exchange-online/manage-permissions-for-

recipients 

Token for the Attachment File Name 
When using EWS and the GP Email Replacer, users can allow custom naming of Report Attachment, instead 
of the GP hardcoded name of “Companyname_DocumentNumber.docx” 

To enable this feature, use the token:   

[FP_AttachName=This is your invoice.doc]  

Replace the placeholder text with the name of your file and place it anywhere in the GP Email  Message body.  

Note: The token value must have correct file extension (.doc,.pdf etc) in order to actually set the displayed filename for 

the attachment.  (this is a security restriction, so receivers of the email know what file type is attached). 

 

The file name may include a field or fields associated with a document type from the GP Message Setup window.   

 

  

https://learn.microsoft.com/en-us/microsoft-365/admin/add-users/give-mailbox-permissions-to-another-user?view=o365-worldwide
https://learn.microsoft.com/en-us/microsoft-365/admin/add-users/give-mailbox-permissions-to-another-user?view=o365-worldwide
https://learn.microsoft.com/en-us/exchange/recipients-in-exchange-online/manage-permissions-for-recipients
https://learn.microsoft.com/en-us/exchange/recipients-in-exchange-online/manage-permissions-for-recipients


 

Enter E-mail From Setup Information 
Before you can setup Forms Printer’s E-mail delivery, you must complete the E-mail From Setup. That is, the 
list of potential E-mail addresses your E-mails would come from. For example, you might want the E-mail to 
always come from the sending user, you might want to retrieve a list of possible from E-mail addresses from 
your Exchange Server, or you may wish to have a small, controlled list of From Addresses in the case where 
you want E-mails to come from “Sales” or “Customer Service” rather than an individual user. 

From the Forms Printer Setup window or the Forms Printer Plus Setup window, the E-mail From Setup menu 
option opens the E-mail From Setup window.  

E-mail From Setup Window 
Use this window to determine the list of “From” addresses available in the E-mail From dropdown list during 
setup. 

Note:  This step is only necessary if you plan to use Forms Printer to deliver forms and reports by E-Mail. 

To open the E-mail From Setup window, you must first Open the Forms Printer Setup window or the Forms 
Printer Plus Setup window using the menu navigation: Microsoft Dynamics GP > Tools > Setup > Company > 
Forms Printer.  Or Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer Plus. Then click the E-
mail Setup button and select E-mail From Setup to open the E-mail Setup window. 

Window Buttons 
The buttons on the Window include: 

Buttons Description 

Save Saves the current entry values and closes the Window. 

Cancel Closes the window without saving changes. 

Window Fields  
Fields Description 
Forms Printer E-mail “From” 
Choices Radio Group displaying radio button options 

Default Outlook User Radio Button Always use the current Outlook profile as the E-mail From Address. 

Exchange Address List Radio Button Retrieve a list of E-mail Addresses using an existing Address List in 
Exchange. 

Exchange Address List Textbox 
This field is displayed when the Exchange Address List radio button is 
selected. Here you would enter the name of the address list from which 
you will select your From Addresses. 

List of E-Mail Addresses, comma 
separated Radio Button Use a manually entered list of E-mail Addresses as the From List. 

List of E-Mail Addresses Textbox 
This field is displayed when the List Of E-Mail Addresses radio button is 
selected. Here you would enter a comma separated list of literal E-mail 
values from which you will select your From Addresses. 

 

  



 

Window Example 
The screenshot below shows the E-mail From Setup window. 

 

E-mail “From” Setup Options 
On the window, select the “From” choice for the source of your E-mail From List.  This setting is then applied 
to all workstations. The options are: 

Default Outlook User 
With this option selected, the E-mail From dropdown list will display “Default Outlook User” as the only 
choice and all E-mails will be sent from the current user’s Outlook Profile, if set up. 

Exchange Address List 
With this option selected, the Exchange Address List text box will be displayed. There you can enter an 
existing Address List from Exchange, such as the ‘Global Address List’ as shown below: 

 

Manually Entered List 
With this option selected, the List of E-Mail Addresses text box will be displayed. There you can enter a 
comma separated list of literal E-mail Address values which will be displayed as the ‘From’ E-mail choices 
during E-mail Delivery Setup. An example list is shown below: 



 

 

Additional Setup  
Logging Setup 
Before you can use Forms Printer’s Logging feature, it must be enabled in the Logging Setup window. 

To open the Forms Printer Logging Setup window, you must first Open the Forms Printer Setup window or 
the Forms Printer Plus Setup window using the menu navigation: Microsoft Dynamics GP > Tools > Setup > 
Company > Forms Printer.  Or Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer Plus. Then 
click Additional Setup then select Logging Setup to open the Forms Printer Logging Setup window. 

Window Navigation 

 

 

Window Buttons 
The buttons on the Window include: 

Buttons Description 
Save Saves the current entry values and closes the Window. 
Cancel Closes the window without saving changes. 

Window Fields  
Fields Description 
Report Logging Choices Radio Group displaying radio button options 
Disable Logging for all Companies 
Radio Button Default option. Do not log Forms Printer activity. 

Enable Logging for all Companies 
Radio Button Log Forms Printer activity in all GP Companies. 

Enable Logging with Specified 
Companies Disabled Radio Button Log Forms Printer activity except in specified Companies. 

List of Companies A list showing the GP companies with their Disabled status. 



 

Window Example 
The screenshot below shows the Forms Printer Logging Setup window. 

 

Disable Logging for all Companies 
By default, this option is selected and Forms Printer will not log any delivery activity.  

Enable Logging for all Companies 
With this option selected, Forms Printer will log delivery activity in all Companies. 

Enable Logging with Specified Companies Disabled 
With this option selected, Forms Printer will log delivery activity in any Companies not marked as Disabled. 



 

Logging Utilities 
Opens the Logging Utilities window  

(see Advanced Features > Logging Forms Printer Delivery > Logging Utilities) 

Logging Inquiry 
Opens the Logging Inquiry window  

(see Advanced Features > Logging Forms Printer Delivery > Logging Inquiry) 

Report Properties 
The Additional Setup > Report Properties menu opens the Report Properties Setup window where all of the 
entries previously handled with Microsoft Defaults File (Dex.ini) settings can now be maintained. 

The advantages to the Reports Properties window are that: 

• Properties can be managed in a central location rather than individual Dex.ini files. 
• Where appropriate, some settings can be controlled on a per User, Company, Report, and / or 

Master ID basis. 

Note: The original Dex.ini file method may still be used if desired. Forms Printer will first look to the Report Properties 

list for settings and use those if found. If NOT found in the Report Properties list, the Dex.ini settings of the user 

will be checked and used if found. If entries are missing from both the Report Properties list and ANY Dex.ini, the 

Default entry will be written to the Report Properties list and this value will apply TO ALL USERS.  

 If you intend to use the Dex.ini method you MUST manually add all entries to be used on ANY GP instance to ALL 

GP Dex.ini files. 

Window Navigation 

 

Window Buttons 
The buttons on the Window include: 

Buttons Description 
Save Saves the current property settings to the properties table. 
Delete Permanently removes the selected proper 
Add Clears any selections so that a new entry may be added 
Copy Creates a clone of the selected property entry allowing for a new entry to be added 

Window Fields  
Fields Description 



 

Properties List 
List showing properties saved to the properties table including the Property 
Name, Property Value, Report Index (unique ID of the report to which the 
property applies), User ID, Company, and Master ID. 

PropertyObject Dropdown to select the Property Object Type of ReprtSetup or PrimarySetup. 

Property Name Text field to enter a valid Property Name 

Property Value Text field to enter the value for the property 

Applies To Master ID Text field to enter a valid Customer or Vendor ID for properties that can be 
applied at the Master ID level. If not set, the property will apply to all. 

Master Type The Mater Type that coincides with the Applies To Master ID. Use CUS for 
Customer, VEN for Vendor. 

Instance For Future Use. Currently this is always Zero. 

Applies To User Dropdown to select an individual GP User to whom the property will apply.  

Applies To Report Dropdown to select an individual report to which the property will be applied.  

Applies To Company Dropdown to select the GP Company to which the property will be applied. 
Note:  Not all Report Properties apply to all reports and may not apply at the report, User, and / or Master ID level.  

 When Master ID, User, Report, and / or Company are not defined, the property setting will apply to all records. 

 See the Report Properties list for details regarding which entries are valid for each Property.. 

Window Example 
The screenshot below shows the Report Properties Setup window. 

 



 

There are two types of settings: Report Setup settings which can be applied to individual reports, and Primary 
Setup Settings which are system wide settings. There are also Defaults File Settings that are used from the GP 
Defaults File only.  

Below is a list of the user serviceable settings that can be added or maintained in the Report Properties Setup 
window. 

Report Setup Settings 
Description 

Setting Can Be Based On 

 

Setting User Company Report Master 

ASI_FP_TOPRINTERDELIVERYONLY 

Use Default Printer When 
Not Delivering 

Yes Yes Yes No 

ASIFP_CONSOLIDATEPRINTDELIVERY 

Improve SOP Print 
Performance 

Yes Yes Yes No 

ASIFP_ERRORONMISSINGATTACHMENT 

Raise Email Error if 
Additional Attachment 
Missing 

Yes Yes Yes No 

ASIFP_PER_CUSTOMER_DELIVERY 

Allow One E-mail & One 
Attachment per Customer 

Yes Yes Yes No 

ASIFP_PER_CUSTOMER_DELIVERY_DialogMsg 

Control Text of dialog when 
using Per Customer Delivery Yes Yes Yes No 

ASIFP_PER_CUSTOMER_DELIVERY_NOASKDIALOG 

Suppress the Per 
Customer Dialog 

Yes Yes Yes No 

ASIFP_SUPPRESS_STMT_DELIVERY_WHEN_NO_TRX 

Do not deliver if statement 
print options returns no 
transactions 

Yes Yes Yes Yes 

ASIFPDEFAULTBUTTONDELIVER 

Change Default Button on 
Print or Deliver Dialog 

Yes Yes Yes No 

ASIFPEmailResultDialog 

Suppress the E-mail 
Delivery Results Dialog 

Yes Yes Yes No 

ASIFPNoEmailAddressErrorLog 

Suppress the E-mail Error 
Report 

Yes Yes Yes No 

ASIFPPrintOrDeliver_DialogDeliverButtonTxt 

Change the Print or 
Deliver Dialog Button Text 

Yes Yes Yes No 

ASIFPPrintOrDeliver_DialogMsg 

Change the Print or 
Deliver Dialog Message  

Yes Yes Yes No 

FORCE_PRINT_OR_DELIVER 

Suppress the Print or 
Deliver Dialog  

Yes Yes Yes No 

ASIFP_OnlyNoEmailToFile Send To File If No Email Yes Yes Yes No 

ASICREATEFOLDER 
Create To File Delivery 
Export Folders if they do 
not exist 

Yes Yes Yes No 

ASI_USE_RW_IF_ALT_OR_MOD 

Ignore Forms Printer if 
User has security to 
Alternate or Modified 
Report 

Yes Yes Yes No 

  



 

 

Primary Setup Settings 

 

ASINoPrintDialogs  Control the Crystal 
Reports Print Dialogs 

*Yes Yes No No 

ASIFPCLEANUP 

Keep Number of 
SOP50200 Records Small 

*Yes Yes No No 

ASIFPUseOutlook Disable Outlook Usage *Yes Yes No No 

ASIUSECRINET 

Use the .NET version of 
Crystal Components 

*Yes Yes No No 

UsePerSiteParameter 

Pass extra parameters to 
SOP Pick / Pack for Per Site 
Option 

*Yes Yes No No 

ASICRIOLDDEFPRINTER 

Disable Terminal Server Per 
Session Default Printer when 
sending Crystal Reports To 
Printer 

No No No No 

ASICRIOLDDEFPRINTERSCR 

Disable Terminal Server Per 
Session Default Printer when 
sending Crystal Reports To 
Screen 

No No No No 

 ASISTOPGPEMAILVERIFY 
Suppress the GP Email verify 
functionality on Internet 
Information window. 

*Yes Yes No No 

 Password Protect File Export 
Password Protect PDF Direct 
Deposit Statements sent to 
file. 

Yes Yes Yes No 

 Password Protect Email Attachment 
Password Protect PDF Direct 
Deposit Statements attached 
to Email. 

Yes Yes Yes No 

 

Defaults File Settings – These Must be used from the GP Defaults File (Dex.ini) 

 ASIFPINITIAL Force re-initialization NA 

 ASIFPUSECOLLECTIONS Disable Collections 
Triggers if set to FALSE 

NA 

 

* Primary Setup options are user specific ONLY if GP is configured to use Per User Defaults File Settings 

Report Properties Settings 
The list below includes the details of the Report Properties settings used to control various advanced options 
of Forms Printer.  

ASIFP_CONSOLIDATEPRINTDELIVERY 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: SOP Reports Only - Per Report Supported 
Details 
This Boolean switch allows fewer print jobs to be created during batch or range delivery by consolidating all 
of the identical transaction setups into a single print jobs before sending to printer. 



 

ASIFP_ERRORONMISSINGATTACHMENT 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: Email Delivery Reports Only - Per Report Supported 
Details 
This switch, which must be manually added, when set to TRUE, enforces the Additional Attachments defined 
in Setup as required to send the E-mail. If a defined attachment is missing, the E-mail generates an error and 
is saved to the Outlook Drafts folder.  

ASIFP_PER_CUSTOMER_DELIVERY  
Default Value: FALSE 
Valid Values: Comma separated list of Report Indexes for the SOP document range of 10 to 73 
Scope: SOP Reports Only - Per Report Supported 
Details 
This switch is a comma separated list of SOP Document Report Indexes (Forms Printer’s internal ID number 
for reports) that can be assigned so that the selection and delivery of the specified report is by customer 
number rather than the default per transaction. When enabled, the switch causes the SOP50200 records to 
be iterated over in Customer ID order instead of Document Number order, and only one E-mail and one 
report is generated per customer, during E-mail delivery. 

This switch is a very in depth and complex. It requires changes to the design of your report in a way that 
makes the report unusable in Forms Printer for any other purpose. 

The steps to using this functionality are: 

1. Choose the report formats you plan to Deliver on a per Customer basis. 

2. Determine the Report Index for the report(s) by executing the SQL Statement below in the context of 
your System Database where Forms Printer has been installed.: 

SELECT [ASI_Report_Index], [ASIReportDisplayName]  

FROM [DYNAMICS].[dbo].[ASI12389] --Note hard coded System Database name 

WHERE ASI_Report_Index BETWEEN 10 and 73 --The range of SOP Documents 

ORDER BY ASI_Report_Index 

3. Modify your Dex.ini to include the entry and Index(s) you want to consolidate.  

For Example: ASIFP_PER_CUSTOMER_DELIVERY = 15,33 

This entry would consolidate Report Index 15 (SOP Orders Short Form Unposted) and 33 (SOP 
Quotes Blank Paper History).                                                             

4. Open a copy of your base report for that report format. 

5. Modify the report so that it restricts to a single Customer Number using the example below. 

The report restriction must be modified manually in the report since when this setting is active, the 
"Customer Number for this customer document group" is passed in the ‘Sop Number’ parameter 
field for the report instead of the SOP document number usually passed in. 

The selection formula change, shown below in red would be: 

{SOP50200.SOPTYPE} = {?SOP Type} AND 

{SOP50200.CUSTNMBR} = {?SOP Number} AND . . . 

Where the default entry would typically be in part: 



 

{SOP50200.SOPTYPE} = {?SOP Type} AND 

{SOP50200.SOP Number} = {?SOP Number} AND . . . 

6. Map your new report to the proper format in Forms Printer Setup. 

7. Print the report from a location where multiple documents will be printed such as Print Sales 
Documents.  

When the Print or Deliver dialog opens, and the ‘Deliver’ button is pressed, an additional informational dialog 
is opened, if the Dex.ini switch ASIFP_PER_CUSTOMER_DELIVERY_NOASKDIALOG if set to FALSE 

ASIFP_PER_CUSTOMER_DELIVERY_DialogMsg  
Default Value: {blank} 
Valid Values: string of max length 255 
Scope: SOP Reports Only and only when ASIFP_PER_CUSTOMER_DELIVERY is enabled - Per Report 
Supported 
Details 
This string switch allows you to define the 'Per Customer' Dialog prompting text. By default, it is "Special SOP 
Form Delivery Enabled:  Consolidated Customer Documents, 1 per Customer will be delivered: 
ASIFP_PER_CUSTOMER_DELIVERY".  

If not set in the Dex.ini, the default text is used. When displayed, that dialog offers buttons for "Continue" or 
"Cancel".  

ASIFP_PER_CUSTOMER_DELIVERY_NOASKDIALOG  
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: SOP Reports Only and only when ASIFP_PER_CUSTOMER_DELIVERY is enabled - Per Report 
Supported 
Details 
This Boolean switch is used only in conjunction with the ASIFP_PER_CUSTOMER_DELIVERY switch. It 
suppresses the special 'Per Customer' Dialog: 

"Special SOP Form Delivery Enabled:  Consolidated Customer Documents, 1 per Customer will be delivered: 
ASIFP_PER_CUSTOMER_DELIVERY" 

When displayed, that dialog offers buttons for "Continue" or "Cancel".  

ASIFP_SUPPRESS_STMT_DELIVERY_WHEN_NO_TRX 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: RM Statements Only - Per Report Supported - - Per Master ID (Customer) Supported 
Details 
This Boolean switch stops the E-mailing of Statements when there are no transactions to display on the 
statement, but the Statement Printing options still included the customer in the list of available statements. 

  



 

ASIFPCLEANUP 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: SOP Reports Only 
Details 
This Boolean switch tells Forms Printer to clear out records from the SOP50200 at the conclusion of printing. 
This is helpful to toggle off during report design when having data in the tables allows report preview. In 
some cases it is not recommended for SSRS report printing because the records can be removed before the 
SSRS report finishes 

ASIFPDEFAULTBUTTONDELIVER 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details  
This Boolean switch allows you to change which button is the default on the Print or Deliver dialog window. 
TRUE makes Deliver the default, FALSE makes Print the default. This means that the field has focus when the 
dialog opens and hitting the enter key selects that option, closes the dialog and continues the process. 

ASIFPEMAILNOPRINTER 
Default Value: N/A - This text entry must be manually added. 
Valid Value: Save as Draft 
Scope: Affects All Forms Printer Base Reports 
Details 
This text switch looks specifically for the value "Save as Draft".  It is used in conjunction with the Send to Print 
option of the If No E-mail Address setting. If no E-mail is found and Forms Printer instead sends the report to 
a defined printer, but that printer is not found, Forms Printer by default, will attempt to print using default 
printer settings. This setting allows you to control that behavior of attempting to print to the default printer 
and instead writes an error to the log stating, "Specified Printer <printer name> not found." 

ASIFPEmailResultDialog  
Default Value: TRUE 
Valid Values: TRUE | FALSE 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details 
This Boolean switch when set to TRUE allows, or when set to FALSE suppresses the E-mail Results Dialog box 
that is presented by default after one or more E-mails are sent for SOP Documents.   

ASIFPNoEmailAddressErrorLog 
Default Value: TRUE 
Valid Values: TRUE | FALSE 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details 
This Boolean switch suppresses the error report presented when delivering by E-mail and E-mail Addresses 
were missing. This is particularly useful when used with the Send to Printer option of the If No E-mail Address 
setting.  



 

ASIFPPrintOrDeliver_DialogMsg 
Default Value: blank 
Valid Values: “” | a string of 255 characters or less 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details 
This string switch allows you to define the Print or Deliver Dialog prompting text. By default, it is "Do you 
want to print to the printer or use the Forms Printer Delivery System?". If not set in the Dex.ini, the default 
text is used. 

ASIFPPrintOrDeliver_DialogDeliverButtonTxt 
Default Value: blank 
Valid Values: “” | Any valid string – recommended 7 characters or less 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details 
This text switch allows you to set the text of the Deliver button on the Print or Deliver dialog. If not set in the 
Dex.ini, the default text is used. 

ASIFPVBSTIMEOUT  
Default Value: 10000 (10 Seconds).  
Valid Values: Any valid number in milliseconds | -1 
Scope: System Wide Setting 
Details 
To avoid getting the "Script is taking longer than expected to execute" dialog, you can increase the script 
timeout with this numeric switch.  Example: modify the dex.ini setting on each workstation to 
ASIFPVBSTIMEOUT=-1 (negative 1) will disable the VBScript Script Control Timeout completely, inhibiting the 
dialog completely.  

ASIFPVBSTIMEOUT=10000 will set it to 10,000 milliseconds (10 Seconds), the default. (you may wish to set it 
to 30000 for instance). 

ASINoPrintDialogs 
Default Value: TRUE 
Valid Values: TRUE | FALSE 
Scope: All Printed Forms Printer Reports set to use Crystal Reports  
Details 
This setting can be set to TRUE in order to suppress the Print Dialog displayed by default from Crystal Reports 
when printing to printer.  

Note that Forms Printer also honors the GP NoPrintDialogs switch so the ASINoPrintDialogs can be used to 
exclusively suppress the Crystal Reports dialog while allowing the dialog for other reports through the 
system.  

  



 

ASIOUTLOOKFORCEASKPROFILE 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: System Wide Setting 
Details 
When set to TRUE, this switch will cause Forms Printer to have Outlook prompt for which profile to use 
when it starts. 
ASIOUTLOOKFORCEMAPIPROFILE 
Default Value: N/A - This text entry must be manually added. 
Valid Values: any valid Outlook Profile Name 
Scope: System Wide Setting 
Details 
When this switch is set to a value, that value will be used as the Outlook Profile name that Forms Printer will 
request Outlook to use when starting, this is useful in some Terminal Server Cases where the Outlook E-mail 
Control panel setting “use default profile” does not seem to work.  

ASIOUTLOOKREPLYPRESELECT 
Default Value: TRUE 
Valid Values: TRUE / FALSE 
Scope: System Wide Setting 
Details 
This switch controls the dialog presented to the user when E-mailing with the Reply To Selected E-mail 
setting set to TRUE. This notifies the user that the Reply is about to occur giving them an opportunity to 
select the desired E-mail and then clicking the Ok button to proceed. By setting this switch to FALSE, the 
dialog is suppressed and Forms Printer will automatically attempt to reply to the selected Outlook Item. If 
that item is not a Mail Item (for example a Calendar Entry) or it is not a Mail Item which accepts a reply (such 
as a system notification), then another dialog appears explaining the issue and allowing the user a chance to 
select an appropriate item. 

ASIUSECRINET 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: System Wide Setting 
Details: 
This Boolean switch, when set to TRUE is used to force Forms Printer to use the Crystal .Net 2008 
components. This is used when there is another application integrated to GP using the .NET components and 
Forms Printer’s Crystal components are conflicting. Note that the Crystal .NET components must be installed 
separately if this setting is going to be used. 

ASI_FP_TOPRINTERDELIVERYONLY 
Default Value: FALSE 
Valid Values: TRUE / FALSE 
Scope: Per Report Supported or as System Wide Setting 
Details 
This switch controls print behavior when the User selects Print from the Print or Deliver Dialog AND Specific 
Printer is the selected Print Option in Forms Printer Setup. By default, Forms Printer will honor the printer 
defined in Setup regardless of the User’s choice to Print or Deliver. When this entry is set to TRUE, it will 



 

allow Forms Printer to use the system Default Printer when Print is chosen and use the defined printer when 
Deliver is chosen from the Print or Deliver Dialog. 

FORCE_PRINT_OR_DELIVER  
Default Value: FALSE  
Valid Values: FALSE | PRINT | DELIVER  
Scope: Per Report Setup   
Details  
This string switch allows for values "FALSE", "PRINT" or "DELIVER". When set to PRINT or DELIVER, regardless 
of whether there are delivery options defined for a given Document, the Print or Delivery action will be 
determined by this switch without prompting the user. 

ASIFP_OnlyNoEmailToFile  
Default Value: N/A - This text entry must be manually added. 
Valid Values: FALSE | TRUE  
Scope: ReportSetup - Affects All Forms Printer Base Reports (except checks) - Per Report and Per 
Company Supported 
Details  
Report Property Entry allows documents to be sent to file when E-mail Delivery is used but the E-mail 
Address is blank. With the normal Setup options, Forms Printer can be set to go to the Drafts folder (the 
default behavior), or it can be set to print documents for records with no returned Email Address, using 
either the Default printer or a specifically chosen printer. If you instead want the document to go to file, you 
can use the following steps: 

1. Choose the To Email option and make all setup choices. 
2. Choose Printer using Default Printer for the If No E-mail Address option. 
3. Mark the To File option and setup the desired Export Path and file name where you would 

like to save documents that do not have an E-mail address. 
4. Use the Report Properties window to add the ASIFP_OnlyNoEmailToFile entry selecting the 

Report, and company the setting applies to and set the value to TRUE. 

Now, when the chosen Report is Delivered by E-mail, transactions for those master records missing an E-mail 
address will export to the selected folder and file name instead of going to Drafts or to the Printer. 

UsePerSiteParameter 
Default Value: FALSE 
Valid Values: TRUE / FALSE 
Scope: SOP Picking Tickets and Packing Slips Only – Effects ALL Formats 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer pass an additional parameter enabling 
the Picking Ticket and Packing Slip Per Site functionality in SOP Printing. In order to use this flag, any existing 
reports will need to be modified to include a new parameter. Additional recommended changes include 
modification to other parameters and to report selection criteria / Where clause. See the Sample SOP Picking 
Ticket report for changes. 

  



 

ASICREATEFOLDER 
Default Value: N/A 
Valid Values: TRUE / FALSE 
Scope: Affects All Forms Printer Base Reports - Per Report Supported 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer, when delivering To File, create any 
folders defined in the export path that do not exist. With this setting set to TRUE, Forms Printer evaluates 
each part of the To File Delivery path. Any part of the path determined to be a folder or sub folder is checked 
to see if it exists and if it does not, the folder is created. 

ASI_USE_RW_IF_ALT_OR_MOD  
Default Value: N/A 
Valid Values: TRUE / FALSE 
Scope: Affects All Forms Printer Base Reports - Per User, Company, and Report Supported 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer NOT print the report for the configured 
User, Company, and Report configuration IF the user’s security is set to use a modified or alternate version of 
the Report Writer report. 

ASISTOPGPEMAILVERIFY  
Default Value: N/A 
Valid Values: TRUE / FALSE 
Scope: System Wide Setting 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer suppress the Email Address verification 
that GP performs when leaving the Email To, Cc, and Bcc fields in the Internet Information window. As has 
been documented by GP, an issue exists in this window that causes a crash of GP if the System Preferences > 
Email Preferences > Server Type is set to MAPI and the GP client install includes .vbs files. It is important to 
note that this setting is system wide affecting all users and all uses of the Internet Information window for 
Customer, Vendor, and Item setup. 

ASICRIOLDDEFPRINTER  
Default Value: FALSE 
Valid Values: TRUE / FALSE 
Scope: System Wide Setting 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer used in a Terminal Server environment, 
when printing a Crystal Report set to use Printer Saved on Report, ignore newer functionality to retrieve the 
user’s per Session printer.  

  



 

ASICRIOLDDEFPRINTERSCR 
Default Value: FALSE 
Valid Values: TRUE / FALSE 
Scope: System Wide Setting 
Details 
This Boolean switch, when set to TRUE is used to have Forms Printer used in a Terminal Server environment, 
when previewing to screen a Crystal Report set to use Printer Saved on Report, ignore newer functionality to 
retrieve the user’s per Session printer.  

Password Protect File Export 
Default Value: N/A - This text entry must be manually added. 
Valid Values: Any Direct Deposit Field Token or Database Function 
Scope: Direct Deposit Statements Only 
Details 
This Boolean switch is used to have Forms Printer password protect Direct Deposit PDF files exported to a 
folder as defined in the Forms Printer Delivery System Setup. The value for this property would be any field 
token taken from the Editor window while setting up the Direct Deposit Statement of Earnings in Forms 
Printer Setup or a Database Function entered using valid syntax. For example, using the Editor, the field 
token for the User Defined 1 field of the Payroll Master table could be copied and pasted into the Report 
Property value as {<RF>'User Defined 1' of table UPR_MSTR,0}. Forms Printer would then use the value of 
that field foreach Employee as the password for the PDF exported to file. 

Password Protect Email Attachment 
Default Value: N/A - This text entry must be manually added. 
Valid Values: Any Direct Deposit Field Token or Database Function 
Scope: Direct Deposit Statements Only 
Details 
This Boolean switch is used to have Forms Printer password protect Direct Deposit PDF files defined as the 
Email Attachment in the Forms Printer Delivery System Setup. The value for this property would be any field 
token taken from the Editor window while setting up the Direct Deposit Statement of Earnings in Forms 
Printer Setup or a Database Function entered using valid syntax. For example, using the Editor, the field 
token for the User Defined 1 field of the Payroll Master table could be copied and pasted into the Report 
Property value as {<RF>'User Defined 1' of table UPR_MSTR,0}. Forms Printer would then use the value of 
that field foreach Employee as the password for the PDF Email Attachment.  



 

Microsoft Dynamics Defaults File Settings 
These settings remain available ONLY from the Defaults File (Dex.ini). They are not part of the Report 
Properties functionality. 

ASIFPINITIAL 
Default Value: FALSE 
Valid Values: TRUE | FALSE 
Scope: System Wide Setting 
Details 
This Boolean switch, when set to TRUE, will force Forms Printer to re-initialize the table and stored procedure 
initialization process that occurs automatically during the product installation. 

ASIFPUSECOLLECTIONS 
Default Value: TRUE. 
Valid Values: TRUE | FALSE 
Scope: System Wide Setting 
Details 
When this switch is set to FALSE, triggers used by Forms Printer when Collections Management is loaded are 
disabled.  

  



 

Out of Use Settings 
Defaults File Settings that are no longer in use as of the Build 150 series are listed below. 

ASIFP_ENABLE_DATABASE_FUNCTIONS 
Status: No Longer Used – See Database Functions 

ASIFP_SOP_DONTASK_JUST_PRINT 
Status: No Longer Used – See FORCE_PRINT_OR_DELIVER 

ASIFP_SOP_FORCE_PRINT_OR_DELIVER  
Status: No Longer Used – See FORCE_PRINT_OR_DELIVER 

ASIFPOutlookFolder 
Status: No Longer Used – See E-mail Setup 

ASIFPUseOutlook 
Status: No Longer Used – See E-mail Setup 

ASIFPNAVLISTPRINT 
Status: No Longer Used 

  



 

Setup 
Forms Printer Base and Project 
Once the installation of Forms Printer has been completed, the next step is to begin the setup of Forms 
Printer Base System, GP Email Replacer, and / or Forms Printer Plus.  

Forms Printer Base GP Email Replacer 
GP Email Replacer is used to Email reports and Word Template forms from GP on versions that do not 
support Microsoft’s Modern Authenticated Email. 

Click here for Steps to Set Up GP Email Replacer. 

Overview 
Once the Configuration of Forms Printer is complete, the next step is to decide which Dynamics GP reports 
you want to replace with a Crystal or SSRS report. Following the steps in this guide you will choose the Report 
Tool, select a report, and define the options to control the delivery of the report to file, printer and E-mail. 

  



 

Forms Printer Setup Window 
The Forms Printer setup window is used to include the reports and define the options Forms Printer will use 
when replacing Report Writer Reports in Dynamics GP. 

Window Navigation 
To open the Forms Printer Setup window, use the following menu path in Dynamics GP: 

Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer 

The screenshot below shows the menu path. 

 

Window Buttons 
Buttons Description 
Save Saves any changes made to window values. 

New This button lists choices for adding new entries. The available values 
vary depending upon the entry currently selected in the tree view. 

Delete Deletes the currently selected entry from the tree view. 

Report Engine Setup Displays the Report Engine Setup menu options for setup of the 
available reporting tools. 

E-Mail Setup Opens the E-mail Setup window 
  



 

Window Fields and Controls 
Fields Description 
Report / Company / SOP 
Document Type ID / Class ID / 
Master Record List 

This treeview list is used to display and modify the list of reports, 
Companies, SOP Document Type ID, Class ID, and Master records that are 
setup to use Forms Printer. 

Setup Options Pane This editable page is used to determine the various settings for the record 
selected in the treeview. 

Report Tool This dropdown list is used to select the Reporting engine desired for the 
selected Report or Company.  

Report Path If using Crystal Reports this field and  

Report Path Lookup This button is used to browse for, and select report mapped to the 
selected GP Form.  

To File Checkbox to have the report exported to a file when Delivered. 

     File Format The File Format selection determines the format for the exported 
document. See the Report Formats section for details. 

     Folder This text field shows the directory in which Forms Printer will create the 
exported file.  

     Folder Lookup This button is used to browse for, and select the To File export folder. 
    Select File Name Button This button opens the Select File Name window. 

To Printer Selecting the To Printer checkbox enables the Delivery System printer 
output.  

     Printer Selection This Dropdown displays a list of options for printer selection or print 
behavior. 

     Printer Display This read only field displays the printer selected when Specific Printer is 
used.  

     Print Setup Button This button opens the Print window where a printer and its properties 
can be chosen.  

     Copies To Print  This entry field is hidden by default and is displayed when a choice other 
than Specific Printer is selected in the Printer Selection Dropdown. 

To E-mail Selecting the To E-mail checkbox, allows delivery of the selected 
document by E-mail.  

     Using Outlook This radio button indicates that the installed, local, Outlook client will be 
used to deliver the document by E-mail. 

     Using Crystal MAPI 
This radio button, enabled only when the Report Tool is Crystal Reports, 
indicates that Crystal’s internal MAPI E-mailing functionality will be used 
to deliver the document by E-mail. 

     E-mail From 
This dropdown, populated by the E-mail Setup choice and enabled only if 
Microsoft Outlook is installed, shows the E-mail addresses available to 
select as the E-mail From Address.  

     E-mail To Source This dropdown list allows selection of the Master Record Address Source 
from which Forms Printer will retrieve the E-mail To Address. 

E-mail To This dropdown list allows you to select the Master Record Address from 
which Forms Printer will retrieve the E-mail To Address.  

Additional E-mail To 
Addresses 

This link opens the Additional E-mail Addresses Setup window allowing 
the setup of additional E-mail recipients. The link will be displayed in red 
when a script has been entered. 

Scripted E-mail to Addresses This link opens the Scripted E-mail List window allowing entry of a SQL 
script which returns a custom list of Mail To, CC and / or Bcc E-mail 



 

Addresses for E-mail delivery. The link will be displayed in red when a 
script has been entered. 

Replies Sent To This text field allows for the entry of an E-mail address that will receive 
the E-mail if the recipient replies to the E-mail.  

Send Option This dropdown list allows the selection of the destination for the created 
E-mail.  

Hours To Delay 
This entry field is enabled when the Send Option dropdown list is set to 
Save to Outlook Outbox Delayed allowing the delivered E-mail to be sent 
at a time in the future. 

If No E-mail Address 
This dropdown allows you to define the default behavior to follow when 
the Master Record does not have a defined E-mail address in the field(s) 
defined by the E-mail To setup.  

Printer This read only field displays the selected Printer when the If No E-mail 
Address selection is set to Specific Printer. 

Printer Setup Button This button is used to choose Print options when the If No E-mail Address 
selection is set to Specific Printer. 

Multiple Documents per E-mail 
This checkbox creates a single E-mail for each unique E-mail To address in 
a batch or range, and attaches all documents for that contact to each E-
mail.   

Additional Attachments 

This link opens the Include Additional Attachments window where files, 
including those attached in the GP Attachments Setup, can be chosen as 
attachments to the E-mail in addition to the Dynamics GP transaction. 
The link will be displayed in red when attachments have been added. 
See Additional Attachments window for details. 

Attachment Format This dropdown list allows you to specify the file format for the document 
as an E-mail attachment.  

Attachment Name This text field allows the entering of the E-mail attachment name.  

Editor Button 

This button opens the Subject and Attachment Name Editor window 
where the E-mail Attachment Name can be defined to include text and 
tokens from fields related to the document. See Subject and Attachment 
Name Editor window for details. 

Message & Subject This radio group allows for the selection of the setup source that will be 
used for the E-mail Subject and E-mail message body.  

Message ID This field displays the Message ID to be used when E-mailing the selected 
document type.  

Message ID Lookup Button This button opens the E-mail Messages lookup window. See E-mail 
Messages window for details. 

Editor Button This button opens the Message Editor window. See Message Editor 
window for details. 

Message Description This read only field displays the Message Description of the selected 
Message ID. 

Subject  This field is used to enter the text as it will appear in the E-mail Subject 
line.  

Editor Button 

This button opens the Subject and Attachment Name Editor window 
where the E-mail Subject can be defined to include text and tokens from 
fields related to the document. See Subject and Attachment Name Editor 
window for details. 



 

Window Example 
This screenshot shows the Forms Printer window as it will appear prior to adding any report records. 

NOTE: If you are upgrading Forms Printer, all of the reports you had setup in your earlier version will be migrated to the 

new setup and you will see your settings listed here. 

 

The list of reports, Companies, SOP Document Type IDs, Class IDs and Master Records which will be 
controlled by Forms Printer are displayed in the treeview. Upon installation and prior to the first added 
Report, this list is blank.  

Once you’ve added a report for printing with Forms Printer, you can then add one or more Companies 
beneath the report entry if different settings per company are desired.  

Finally, once a Company has been added, you can add one or more SOP Document Type IDs, Class IDs or 
Master Records beneath the Company allowing a Type ID, Class or Master record to have specific settings for 
report or delivery. 

  

Report / 

Company / 

Class /Type ID / 

Master Record / List  

Setup  

Options  

Pane  



 

Adding a New Report  
Include New Report Steps 

1. Click the New button from the control area. 

2. Select Include New Report from the dropdown menu. 

3. From the Include New Report window, select a Product. 

4. The Product is the Dynamics GP module or 3rd party containing the report to be added. 

5. Select the Series. 

6. The Series is the Dynamics GP series containing the report to be added. 

7. Select the Report from the dropdown list. 

8. The Report drop down list is the Dynamics GP reports available. 

9. Click Save. 

Include New Report Window 
Window Buttons 
The buttons on the Window include: 

Buttons Description 

Save Saves the current entry values, closes the Window and adds the selected report to Forms 
Printer Setup. 

Cancel Closes the window without saving changes or returning the selected report. 

Window Fields  
Fields Description 
Product This dropdown lists the products loaded in the current user’s Dynamics GP System 

Series This dropdown shows the available Series list for the selected Product. 

Report This dropdown includes the available reports in the selected product and Series. Note that 
reports already added to setup will not be listed. 

Window Example 
The screenshot below shows the Include a New Report window. 

 
 

Entering Basic Setup Options 
For each of the records added to the Report / Company / SOP Document Type ID / Class ID / Master Record 
list, the Setup Options Pane is used to determine the individual settings for report engine, report source, 
printing and Delivery. 



 

NOTE: When adding a new entry to the Report / Company / SOP Document Type ID / Class ID / Master 
Record list each record will, BY DEFAULT, be set to “To Printer’ with number of Copies set to 1. Also note that 
all entries must have at least one Delivery Setting either “To File”, “To Printer”, or “To E-mail”. 

Setup Options Pane Example 
Below is a screenshot example of the Forms Printer Setup window showing SOP Document Type ID, Customer 
and Class ID entries in the Report / Company / SOP Document Type ID / Class ID / Master Record list and 
Setup options Pane. 

 

 

 

Report Tool 
Use the Report Tool dropdown to select from the available report designer tools integrated with Forms 
Printer. Those include Report Writer, Crystal Reports, and SQL Server Reporting Services. When selecting 
SSRS or Crystal, the Report Engine setup for that tool must be completed.  



 

Report Writer 
Report Writer is the default Report Tool setting for a newly added report. With this setting chosen, 
Forms Printer then enables the To Printer checkbox. With the ‘To Printer‘ checkbox unselected, 
Forms Printer does not attempt to control the report. To use Forms Printer’s To Printer setting, mark 
the checkbox and select a printer. 

Note:  At the report level, you can leave Report Writer as the selected Report Tool while still allowing added 

Company level settings to use either SSRS or Crystal Reports. This would mean that Forms Printer is 

used to control printing for only specified companies added beneath the report. 

Once a report is added to Forms Printer Setup, the Report Tool dropdown allows the user to choose 
between Report Writer, Crystal Reports and SQL Reporting Services. There are some specific 
behaviors that it is important to understand when selecting the Report Writer Report Tool.  

When the Report Tool is Report Writer . . . 

1. … Forms Printer’s ‘To File’ and ‘To E-mail’ functionality is disabled. Only Crystal Reports and 

SSRS reports can be E-mailed or sent to file by Forms Printer. 

2. … the Report setup can be saved with no Delivery Options selected. If To Printer is 

unchecked, the Printer Selection will be cleared when the setup is saved. 

3. … and To Printer is unchecked, Forms Printer will not attempt to control the report for the 

selected Report Level. 

4. … and the To Printer Delivery option is checked, Forms Printer will send the printing of that 

Report to Report Writer, and you will not be able to use the Word Template option for that 

report. 

5. … You can still define other levels beneath the report and select Crystal or SSRS as the 

Report Tool so that Forms Printer can be used for ‘To File’ and ‘To E-mail’ delivery.  

Crystal Reports 
With Crystal Reports selected, the Report Path field and lookup are enabled, allowing you to enter or 
browse to the desired rpt file. 

SQL Reporting Services 
With SQL Reporting Services the Report Path field can be used to enter the desired published Report 
from Reporting Services. The Report Lookup is used to select the desired Report from the Select 
Report window. 

Report Path 
The Report Path Lookup is used to display the report selected from the file selection window opened by the 
Report Lookup button. Note that the report path and name can be manually entered in the Report Path field. 

Report Lookup 
When using Crystal Reports as the report Tool, this button opens the file selection window. When using SSRS, 
this lookup is used to select the published Report from the Select Report window of Reporting Services.  



 

Entering Delivery Options 
Once the Report and report path have been selected and saved, the chosen report and format are now ready 
to be printed by Forms Printer. Optionally, additional Delivery options can also be defined for controlling 
Forms Printer’s To File, To Printer and To E-mail Delivery.  

To File 
Mark the To File checkbox to have the report exported to a file each time the selected report format is 
delivered. To complete this delivery option, a File Format and file path are selected. 

File Format 
The File Format selection determines the format for the exported document. See the Report Formats section 
for details. 

Folder 
The folder field displays the export path the report will be exported to when Delivered. When selecting the 
To File option, there are two methods for determining both the path AND the resulting Export File Name. 
Those are either using the Folder Lookup button or the Select File Name button.  

Folder Lookup Button 
The folder lookup button is used to choose ONLY the path and folder the report will be exported to when 
Delivered. This is the path to the directory and does not include the file name. If this method is used, Forms 
Printer automatically names the file to ensure a unique file name is created during each export. See 
Understanding File and Folder Naming Rules and Conventions for details. 

*Understanding To File Naming Rules and Conventions 
When delivering to file with Forms Printer, part of the setup is to choose the folder location to which the file 
will be exported. This is done by using the Folder Lookup button where only the folder is chosen. No file 
name is specified. In this case, Forms Printer will create the file name at the time of export using the 
following rules: 

1. When printing single documents, the file is named with the convention:  

DocumentType<sp>DocumentNumber<sp>SystemDate<sp>SystemTime<.>extension 

For Example, sales order number “ORD0001”, might export as:   

Order ORD0001 06-25-27 8 30 27AM.PDF 

2. When printing batches or ranges of documents, the file is named with the convention:  
DocumentType<sp>FirstDocNumber<sp>to<sp>LastDocNumber<sp>SystemDate<sp> 
SystemTime<.>extension  

 
For Example a batch with sales orders “ORD01” to “ORD05” might be exported as:  

Order ORD01 to ORD05 06-25-01 8 30 27AM.PDF  

Note:  If the document being exported has any custom master record settings, for ANY master record, then 

Forms Printer will create individual files per document, even when printing batches or ranges. 

 
3. The exception to this convention is Statements. Because Statements do not have a document 

number, the naming convention is: 



 

DocumentType<sp>CustomerNumber<sp> 
(or FirstCustomerNumber<sp>to<sp>LastCustomerNumber)SystemDate<sp> 
System Time<.>extension 

Select File Name Button 
The Select File Name button opens the Select File Name window which is used to create a custom file path 
and/or file name for use when exporting to file through the delivery system. This feature allows the folder 
and / or file name to be created at runtime based on data associated with the document. For example, rather 
than defaulting the file name to the Forms Printer naming convention of Document Type, number and date 
time, you could create a file that gets its file name from each Purchase Order’s PO Number.  

*Understanding To File Folder Behavior 
When creating the file path, there are several rules that Forms Printer will follow. Those are: 

1. If the created file path and name do not contain a period “.” after the last backslash “\”, Forms 
Printer assumes you are trying to define only a file path and NOT a path and name. It will look for the 
entered value as a path.  
 
For example, if we intended to create pdf files with the name “MyFile”, in a folder called “Reports” 
on drive “X”, we would enter: 
  X:\Reports\MyFile.pdf 
 
If, instead, let’s examine the behavior if we left off the file extension, entering only: 
  X:\Reports\MyFile 
 
Forms Printer would evaluate “MyFile” as a subfolder of the “Reports” folder on drive “X”. If a folder 
with the name “MyFile” was not found, the export to file would fail. If the defined folder is found, 
Forms Printer will create export file using the naming convention detailed in Understanding File and 
Folder Naming Rules. 

 
2. The defined folder path MUST exist and be a valid path from the printing workstation. Forms Printer 

will not try to create the folder path at runtime. If the folder does not exist, documents defined to go 
to that folder will fail and must be reprinted. 
 

3. Any part of the file / folder name can be parameterized but when parameterizing the folder path, 
remember Rule #2.  
 
For example, the folder path below would assume that no file name has been added because there is 
no period. Forms Printer would expect there to be a folder with the Vendor ID as its name and if 
found, will create export file using the naming convention detailed in Understanding File and Folder 
Naming Rules. 

X:\Reports\{<RF>’Vendor ID’ of table POP_PO,0}\ 

In this example, the entire folder path and file name are defined so a pdf file named for the PO 
Number would be created in the “Reports” folder on the “X” drive: 

X:\Reports\{<RF>’PO Number’ of table POP_PO,0}.pdf 



 

 
4. The file extension defined must match the extension selected in the File Format dropdown on the 

Forms Printer Setup window. If they do not match, the name of the file will be as specified in the 
Select File Name window but that actual file format will be that of the File Format dropdown 
selection. 
 

5. If a duplicate file name is created as a result of exporting to file, Forms Printer will overwrite the 
existing file WITHOUT WARNING. 

To Printer 
Selecting the To Printer checkbox enables the Delivery System printer output. By default, this option is 
checked when a new report is added. When marked, this option will send a copy of the report to printer 
whenever the delivery system is used. Left unmarked, the report will only print to the printer if the ‘Print’ 
option is selected on the Report Destination Window. 

When a report is added to Forms Printer and the Report Tool is set to Crystal or SQL Reporting Services, the 
To Printer, Printer Selection Dropdown, and Printer name fields have specific control of the report. When 
printing to printer that is important to understand.  

Some things to note about the To Printer settings are: 

1. If the To Printer checkbox is checked, and the user chooses to Deliver, Forms Printer will always send 

the report using the print options selected. 

 
2. If the To Printer checkbox is not selected the Printer Selection value chosen is still used as the default 

printer when selecting Print from the Print or Deliver Dialog of Forms Printer.  

Printer Selection 
This dropdown determines where the document will be printed when used within Microsoft Dynamics GP. 
The valid choices are described below. 

• Printer Saved On Report – Crystal Reports ONLY 
This setting will direct the Crystal report to the printer saved in the Crystal Report Designer Print 
Setup window when the report was designed or modified. If the report has no defined printer or the 
defined printer is not available from the workstation, the default system printer will be used. 

• Default System Printer 
This setting instructs Forms Printer to print the selected Crystal report to the default printer defined 
on the user’s workstation. 

• Ask Each Time Report Prints 
This setting will allow you to select the printer at the time the report is printed. Using this setting will 
direct the report to the selection made during the printing process. 

• Specific Printer 
This setting will allow you to select the printer at the time the report is printed. Using this setting will 
direct the report to the selection made during the printing process. 

Printer Display  
This read only field displays the printer selected when Specific Printer is used. 



 

Printer Setup Button 
This button is enabled when Specific Printer is chosen for the Printer Selection Dropdown. The button opens 
the Print dialog where a printer and settings can be defined. 

Copies To Print 
The Copies To Print field is hidden by default. It is displayed when the Printer Selection dropdown is set to a 
selection other than Specific Printer. The number of copies determines the quantity output to the printer 
when the report is printed. This quantity will override any quantity selected from the print dialog within the 
report print setup, or the system default print setup. If using ‘Ask Each Time Report Prints’, then the number 
of copies entered in the properties window will be used. 

Note:  If the To Printer checkbox is selected for a Report or Company, a copy of the document will be printed every 
 time the Delivery System is used. To have the document print to the printer only when specified, mark the ‘To 
 Printer’ checkbox, set the desired ‘Print Using’ and ‘Number of Copies’ options, then unmark the To Printer 
 checkbox.  This will allow Forms Printer to use your printer settings, but only print to the printer when ‘Printer or 
 Delivery System’ is selected from the Report Destination window, and Printer is selected from the Delivery 
 System Dialog window.  Note that this functionality DOES NOT apply to Master Records. 

 

Number of copies can also be set using the optional Print Dialog window. When printing, Forms Printer reads 
the Microsoft Dynamics GP ‘NoPrintDialogs’ setting in the Dex.ini file. If NoPrintDialogs=FALSE, then the user 
will be presented with the Print Dialog window. This can be overridden for Forms Printer Reports only, by 
using the ASINoPrintDialogs=TRUE dex.ini setting. The Dialog window allows Number Of Copies and Collate 
options to be entered, as well as page ranges when used with Crystal runtime, or displays a complete printer 
selection dialog with the Currently installed Crystal XI-R2 Runtime. 

To E-mail 
Selecting the ‘To E-mail’ checkbox, allows delivery of the selected document by E-mail.  

During E-mail setup, it may be helpful to consider Forms Printer many advanced features related to E-mailing 
including: 

• HTML Formatted E-mail Body – create an HTML Formatted E-mail body with colors, images, etc. 

• Database Functions – write custom SQL Functions to return content for E-mails and File Exporting 

• Scripted E-mail Addresses – custom SQL Selects to retrieve E-mail Addresses using custom rules 

Using Outlook  
Forms Printer will automatically detect whether Microsoft Outlook is installed, and enable or disable the 
Microsoft Outlook Radio button and E-mail options available for use with Outlook E-mailing. 

Note:  If using SSRS as the Report Tool, only Using Outlook is enabled. 

Using Crystal MAPI 
If Outlook is not detected and the Reporting engine is Crystal Reports, then Forms Printer will use the Crystal 
Reports MAPI mailing functionality, and automatically mark the Crystal MAPI Radio button, disabling the 
option to use Microsoft Outlook. Even if Outlook is installed, you may still choose to use Crystal MAPI Mail by 
selecting the Crystal MAPI Radio button. 

Because of the limits of the Crystal API, certain functionality is unavailable when not using Outlook. 



 

• The functional limits when using Crystal MAPI functionality are: 

• You cannot specify an ‘E-mail From’ profile.  

• The default profile will be used as the ‘From’ address. 

• You cannot name the attachment.  

• The attachment name will be the same as the Crystal Report used to create it. 

• You cannot specify the Send Option.  

• The E-mail will be sent automatically to the recipient. 

Note: In order to use the ‘To E-mail’ feature of the Forms Printer Delivery System, the client workstation must have a 

Messaging Application Programming Interface (MAPI) compliant E-mail application loaded. The full version of 

Microsoft Outlook is currently the only supported MAPI client According to the Crystal /Business Objects/SAP web 

site. 

 To have access to all of Forms Printer’s E-mailing functionality, it is recommended to use Microsoft Outlook 2000 

or Greater. 

E-mail From 
The E-mail From dropdown list is populated in three ways. First, the selection Default Mail User is always 
added automatically, second is the list based on entries or selections made in the E-mail From Setup window, 
and lastly it displays any saved value for the selected entry already saved in setup. 

From the dropdown, you have the option to use the Default Outlook User or specify a specific E-mail Address 
to use as the Send On Behalf Of E-mail From Address. If using an E-mail Address other than the default user, 
the default user must have Delegate permissions in Outlook. For more information about this topic, please 
see the Outlook help documentation regarding Delegates. 

Scripted E-mail From Button 
The Scripted E-mail From button opens the Scripted Email List window where custom rules can be used to 
determine the E-mail From address used when Delivering by E-mail.  

Scripted Email List Window 
When the Scripted Email List window opens, if the E-mail From dropdown of Forms Printer Setup has ‘Default 
Mail user’ selected, the Scripted Email List window will show an example of how a stored proc with 
parameters could be called. See details in Scripted E-mail From and To Addresses in the Advanced Features 
section of this Guide. 

E-mail To Source 
The E-mail To  dropdown list allows you to select the Master Record Address from which Forms Printer will 
retrieve the E-mail To Address. The choices are: 

• Internet Information User Defined E-mail Field 
This selection is the legacy setting from Forms Printer and uses the Internet Information window’s E-
mail field value. This E-mail address is stored per Master Record, per Address, in the original Internet 
Information E-mail field of the Internet Information window. The Master record is either the 
Customer or Vendor for which the document was created, depending on the document type being 
printed 



 

• Internet Information E-mail Addresses (To, CC and BCC) 
This selection uses the newer E-mail To, CC and BCC fields from the Internet Addresses window. This 
E-mail address is stored per Master Record, per Address. The Master record is either the Customer 
or Vendor for which the document was created, depending on the document type being printed 

• Dynamics GP Setup 
This selection uses the options for E-mail source from the Dynamics GP E-mail setup.  For more 
information on that setup, see the Dynamics GP help 

E-mail To 
The E-mail To dropdown list allows you to select the Master Record Address from which Forms Printer will 
retrieve the E-mail To Address. Used in conjunction with the E-mail To Source selection, the E-mail To list 
either shows the available options, or if using the Dynamics GP Setup option, is disabled. 

Alternatively, the option Scripted Mail To List can be selected allowing the results of the Scripted Mail To 
Addresses list to control the E-mail To address for the selected entry. 

Additional E-mail To Addresses 
The Additional Addresses link opens the Additional Addresses Setup window. This link will be displayed in red 
when additional addresses have been entered.  

Additional Addresses Setup Window 
This window allows you to define addresses to mail to, other than the primary address selected in the E-mail 
To  dropdown list. The screenshot below shows this window. 

 

Mail Address Type 
Determines whether the selected address will be added to the E-mail To, Cc, or Bcc list of the E-mail. 

Required 
Mark this checkbox to have the E-mail halted when the selected address is blank. If using Crystal MAPI for E-
mailing, the E-mail will not be created if the Primary or any Required E-mail Address is blank. If using Outlook, 



 

the E-mail will be created, however the ‘Send Option’ will be ignored, and the E-mail will be saved as a Draft. 
In either case, the error will be reported on the Delivery System Error Log, which prints after an E-mailing 
error is encountered. 

Use E-mail Address Of 
The ‘E-mail Address Of’ dropdown list allows you to select the Master Record Address from which Forms 
Printer will retrieve the additional E-mail Address. This E-mail address is stored per Master Record, per 
Address, in the Internet Information window. The Master record is either the Customer or Vendor for which 
the document was created, depending on the document type being printed. 

E-mail CC List 
The E-mail CC List allows you to manually enter additional addresses to be Carbon Copied.  

E-mail BCC List 
The E-mail CC List allows you to manually enter additional addresses to be Carbon Copied. 

Note:  E-mail Addresses in the CC and BCC lists must be separated with a Semi-Colon. If you enter a combination of 

manual addresses and dynamically selected addresses, Forms Printer will use both to create a complete E-mail 

To, Cc and Bcc list. 

Scripted E-mail To Addresses 
The Scripted Mail to Addresses button opens the Scripted E-mail List window. This window allows you to 
manually add a SQL script which returns a custom list of Mail To, CC and / or Bcc E-mail Addresses for E-mail 
delivery. See Scripted E-mail To Addresses in the Advanced Features section for details. 

Replies Sent To 
This text field allows for the entry of an E-mail address that will receive the E-mail if the recipient replies to 
the E-mail. 

Note: For the Reply To functionality to work properly, the E-mail must be sent to an E-mail address outside of the 

Exchange domain sending the E-mail. 

Send Option 
The Send Option dropdown list allows you to select the destination for the created E-mail. The selections for 
Send Options are: 

Send Directly to E-mail Recipient 
Automatically sends the E-mail. 

Save To Outlook Drafts folder 
Creates the E-mail in the Drafts folder. E-mail must be sent manually. 

Save to Outlook Outbox 
Creates the E-mail and saves it to the Outbox. E-mail must be sent manually. 

Save to Outlook Outbox Delayed 
Creates the E-mail and saves it to the Outbox. E-mail will be sent automatically at the specified time 
selected by the Hours to Delay option. 



 

Hours To Delay 
The Hours to delay option is enabled when the Send Option dropdown list is set to ‘Save to Outlook 
Outbox Delayed’. Setting this number adds the specified number of hours to the current system 
time, and uses that to set the E-mail’s delayed send property. For example, if the E-mail was created 
at 10:15 AM, and the Send option was set to Save To Outlook Outbox delayed, with an Hours To 
Delay setting of 12, the E-mail would be created in the Outbox, and would stay there until 10:15 PM, 
and then it would be E-mailed to the selected Recipients. 

Display Created E-mail 
Creates the E-mail displays the E-mail rather than sending or saving it. Once any required 
modifications are made, the E-mail can be modified and then saved or sent manually. 

Reply To Selected E-mail 
By default, Forms Printer will prompt the user notifying them that the Reply To Selected E-mail is 
about to run, giving the user a chance to select the E-mail they wish to reply to. After clicking Ok on 
the dialog, the document and E-mail body, as defined in Forms Printer Setup, will be attached as a 
reply to the user’s selected E-mail. 

*Important points to understand when using the Reply To Selected E-mail feature: 
1. The user must select an E-mail Item. A message will be generated if the selected Item is not an E-mail 

which can be replied to giving the user one additional chance to select the correct Reply To E-mail 
Item.  
 

2. The feature is disabled when E-mailing a batch or range of documents. The documents will be 
created as defined in Setup but will be saved to the Drafts folder as new E-mails in the case of batch 
or range E-mailing. 
 

3. The feature will work whether the user has already clicked Reply or not. 
 

4. The feature works when using the Inline Reply or the Pop Out reply. 
 

5. This feature ALWAYS uses the Reply All option when replying to the selected E-mail. 
 

6. The dialog notifying the user to select the Reply To E-mail can be disabled in the Dex.ini. See 
ASIOUTLOOKREPLYPRESELECT for more details on this setting. 

If No E-mail Address 
This dropdown determines the default behavior Forms Printer follows when the Master Record does not 
have an E-mail address in the field(s) defined by the E-mail To selection. The If No E-mail Address choices are: 

Save to Drafts Folder 
Using this option, Forms Printer will create the E-mail including the Subject, Body and attachment(s). The 
created E-mail will then be saved to the sending user’s Drafts folder. 

Print Using Default Printer 
Using this option, instead of sending the transaction to E-mail, Forms Printer will print the document using 
the printing user’s default printer. 



 

Specific Printer 
Using this option, instead of sending the transaction to E-mail, Forms Printer will print the document using 
the Printer  

Printer 
This read only field displays the printer selected using the Printer Setup button when If No E-mail 
Address is set to Specific Printer. 

Printer Setup Button 
This setup button opens the Print dialog where a printer and properties can be selected for the 
Printer setup when If No E-mail Address is set to Specific Printer. 

Multiple Document Attachments per E-mail 
When printing a batch or range of SOP, POP, or RM documents with Forms Printer, this checkbox indicates to 
Forms Printer to look at each transaction in the Batch or Range, look at the Forms Printer Setup Delivery 
Options, each transaction’s intended E-mail To recipient, and then create a single E-mail for each unique E-
mail To address. All of the documents for that E-mail To recipient are added as attachments to that single E-
mail.   

Additional Attachments 
The Additional Attachments link opens the Include Additional Attachments window where files other that the 
transaction can be configured for inclusion on the created E-mail. 

Include Additional Attachments Window 
The Additional Attachments window allows files to be selected for attachment to the E-mail when a 
Dynamics GP document is being delivered To Mail. These files can be selected by name or they can be 
included using hardcoded text and parameter fields from specific tables, system tables, and global fields. 
When the E-mail is created Forms Printer will fill in any parameters using data associated with the document 
being E-mailed, retrieve the file from the file system and attach it to the E-mail along with the Dynamics GP 
document before completing the defined delivery.  

Note:  If the defined document(s) does not exist at the time the E-mail is generated, Forms Printer WILL STILL CONTINUE 

WITH DELIVERY. Failure to retrieve a defined file DOES NOT STOP the E-mail. To stop the E-mail and display an 

error, set the Dex.ini entry ASIFP_ERRORONMISSINGATTACHMENT = TRUE. 

Window Buttons 
Buttons Description 

Save This button saves any changes made and closes the Additional 
Attachments window. 

Cancel This button closes the Additional Attachments window without saving 
any changes made. 

Window Fields and Controls 
Fields Description 

Include GP E-mail Attachments This checkbox instructs Forms Printer to use the GP Attachments if 
present.  

Add This button opens the Select File Name window where files and paths 
containing report fields can be built or selected. 

Edit This button opens the Attachment Path and File Name window. 



 

Delete This button removes the highlighted file from the list of attached 
documents. 

File List This list field displays the included attachments. 
Window Example 
The screenshot below shows an example of a list of files to be added as attachments to the delivered E-mail. 

 

Include GP E-mail Attachments 
This checkbox instructs Forms Printer to examine the GP Attachment setup for attachments rolled down or 
added to Sales and Purchasing transactions, and are marked to be included in E-mails in the Select 
Attachments to Send in E-mail window. See the Dynamics GP Attachments documentation for more on how 
the GP attachment functionality is setup and used.  

Add 
The Add button opens the Select File Name window where files and paths containing report fields can be 
built or selected. The Select File Name window is used to type in, select or build a path and file name for the 
file(s) to be attached. When building the path or name using parameter fields, any part of the file name or 
path can be replaced with one or more parameters. 

See Select File Name window for details. 

Note:  Tokens appear in the Path and File Name surrounded by {}. These brackets and all of the text that appears 

between them are required in order for Forms Printer to replace the tag with the correct information. The tokens  

shown in the path will be replaced with the actual value of the fields when the E-mail is created. The text of these 

tokens should not be altered in any way. 

Edit 
The Edit button opens the Attachment Path and File Name window, displaying the file and path highlighted 
on the Include Additional Attachments window. From there, changes to the file name and path can be made 
by making manual changes or by selecting a new file. 

Delete 
The Delete button removes the highlighted file from the list of attached documents. 



 

File List 
The File List field displays each of the files that will be included as attachments to the E-mail when delivered. 

Attachment Format 
The Attachment Format dropdown list displays the available file formats that can be created by the selected 
Report Tool. See Report Formats for a list of file format types for each Report Tool. 

Attachment Name 
The Attachment Name field is used to enter text that will be used as the file attachment name in the E-mail 
created by Forms Printer. To create a calculated Attachment Name, use the Attachment Name Editor. 

Note: When creating an attachment name, the following characters should be avoided, as they are invalid in the name 

of a file:  \ / ? * : “ <> | 

  

Attachment Name Editor Button 
The Attachment Name Editor button opens the Subject and Attachment Name Editor window where a 
calculated attachment name can be created using a combination of entered text and tokens. 

  



 

Message and Subject 
The Message and Subject radio group allow for the selection of the Subject and Message Source, using either 
settings already defined in Dynamics GP or  

The Message and Subject choices are: 

From Forms Printer 
This selection allows for the selection and setup of the E-mail message and Subject using the options 
chosen in the Forms Printer Setup window. 

From Dynamics GP 
This selection disables the Message ID and Subject fields in Forms Printer Setup. This indicates that 
Forms Printer will retrieve the E-mail Message and Subject from the matching Document Type Setup 
defined in the Dynamics GP Message Setup window (opened from Microsoft Dynamics GP > Tools > 
Setup > Company > E-mail Message Setup) and mapped in the Dynamics GP Sales E-mail Setup, 
Purchasing E-mail Setup, Customer E-mail Options, and Vendor E-mail Options windows. Forms 
Printer uses the same methodology as GP for selecting the Message ID which determines the Body 
and Subject of the E-mail, looking first to the Customer or Vendor and then defaulting to the per 
document setup if no per Master ID option is defined. 

Note: Forms Printer does not use other Dynamics GP settings (Embed Document in Message Body, 

Attachment Options, and File Attachment Format) even when using the From Dynamics GP Message 

and Subject setting. 

 

 To use the Dynamics GP feature E-mail Address based on Doc Type if Forms Printer, see E-mail To 

Source. 

Message ID 
The Message ID field shows the selected ID value of the selected E-mail Message. 

Message ID Lookup 
The Message ID Lookup button opens the E-mail Messages window. An example of the E-mail 
Messages window is shown below.  

E-mail Messages Window 
The E-mail Messages window lists the Messages created and saved using the Message Editor 
window.  Use this window to select a Message ID to return to Setup.  

Window Example 
A screenshot of the E-mail Messages window is below. 



 

 

Message ID Editor Button 
The Message ID Editor button opens the Message Editor window where new Messages can be 
created, and existing messages can be modified or deleted. See Message Editor window for details. 

Message Description 
The read only Message Description field displays the description of the selected Message. 

Subject 
The Subject field is used to display and enter a string that will be used as the E-mail subject when Forms 
Printer delivers by E-mail.  

Subject Editor Button 
The Subject Editor button opens the Subject and Attachment Name Editor window. See Subject and 
Attachment Name Editor window for details. 

  



 

Shared Windows and Lookups 
Several windows, lookups and selections are referenced from multiple locations in Forms Printer. Those 
resources are detailed below. Links to these resources are found throughout the documentation, in-line with 
the description of the functionality or feature using them. 

Database Function Lookup 
The Database Function lookup is used to select a SQL User-Defined Function for use as part of the Forms 
Printer Delivery Options. The window can be opened from the To File Name, Scripted E-mail List, Subject and 
Attachment Name Editor, and Message Editor windows. 

The use of Database Functions is described in detail in the Advanced Features, Database Functions section of 
this User Guide. 

Window Buttons 
Buttons Description 

Select Returns the selected Database Function to the window that it was 
opened from and closes the Database Function Lookup window. 

Cancel 
Closes the Database Function Lookup window and returns to the 
window that it was opened from without returning a Database Function 
value. 

Refresh 
Enabled when Use database is set to Entered Database, the Refresh 
button returns a list of Database Functions from the database typed 
into the Entered Database entry field. 

Window Fields and Controls 
Fields Description 

Use Database This radio group contains the options for setting Database context 
when retrieving the Database Function list. 

Company Database 

This radio button displays a list of company specific Database Functions. 
When using this option, the database function will not be Qualified with 
Company Database when used. This allows it to be executed in the 
current company context in GP. It is important to note that the function 
must exist in all GP Companies that will access Forms Printer setup 
using this function. 

System Database 
This radio button displays a list of System Database specific Functions. 
When using this option, the database function will be Qualified with 
System Database when used. 

Entered Database This radio button enables the Database name field and the Refresh 
button. 

Database Name 
This string input field allows for the entry of a known SQL Database on 
the Dynamics GP SQL Server. When using this option, the database 
function will be Qualified with entered Database when used.  

Database Function Name Displays a list of Scalar, SQL User-Defined Functions from the current 
Company Database.  

Parameters / Datatypes Displays the name and datatype of the parameter(s) required by the 
SQL User-Defined Function. 

  



 

Window Example 

 

  



 

Message Editor 
The Message Editor Window is used to create the body for E-mails to be delivered by Forms Printer. The 
created messages are saved with an ID and Description and can be applied to multiple documents in Forms 
Printer Setup. 

The message text can be manually entered, or it can be a combination of manually entered text and tokens 
added using the Select Form Fields, Select System Fields, and Select Global Fields lists.  

More advanced options for creating the E-mail Message include: 

• Database Functions – write custom SQL Functions to return parts of, or all of the E-mail body. 

• HTML Formatted E-mail Body – create an HTML Formatted E-mail body with colors, images, etc. 

When the message is created and assigned to a particular document, Forms Printer will fill in any 
parameters using data associated with the document being E-mailed. 

 

Window Buttons 
Buttons Description 

Save Saves any changes made to the Message and closes the Message Editor 
window. 

Clear Removes all contents in the Message field. 
Delete Deletes the currently selected Message ID. 

Window Fields and Controls 
Fields Description 

Select Form Fields 
The Select Form Fields List displays the form tables and fields available 
to be used as Tokens for the selected document type. Double clicking 
on a field adds that field as a token to the message text. 

Select System Fields 
The Select System Fields List displays system tables and fields available 
to be used as Tokens for the selected document type. Double clicking 
on a field adds that field as a token to the message text. 

Select Global Fields 
The Select Global Fields List displays global fields available to be used as 
Tokens for the selected document type. Double clicking on a field adds 
that field as a token to the message text. 

Browse Data 
The Browse Data button displays a list of the first 5 unique values in the 
selected Form Table column. This is provided as an easy way to 
determine the contents of a given field. 

Database Function This read only field shows the Database Function returned from the 
Database Function Lookup. 

Database Function Lookup This button opens the Database Function Lookup window. 

Database Function Insert This button adds the Database Function shown in the Database 
Function field to the Message field. 

Message Field This text field allows typing and cut & paste of strings, text, and tokens 
that will be used in the E-mail body. 

  



 

Window Example 
The screenshot below shows an example of a parameterized message for an unposted Sales Order Processing 
document. 

 

 

Note:  Tokens appear in the Message Editor Text field surrounded by {}. These brackets and all of the text that appears 

between them are required in order for Forms Printer to pull the correct information. The Tokens shown in the 

message will be replaced with the actual value of the fields when the E-mail is created. These Tokens should not 

be altered in any way. 

Note:  Because Message Tokens are based on document specific tables, the messages created are available to be used 

only by the document group for which they were created. A message created for a Statement can be used as the 

message when E-mailing statements. A message created for Unposted Sales Transactions, however, can be used 

for all unposted Quotes, Orders, Invoice, Returns, and Backorders. A Message created for Historical Sales 

Documents may be used only for posted Quotes, Orders, Invoice, Returns, and Backorders. Messages for 

Purchase Orders may be used only for Purchase Order formats.  

  



 

Report Formats 
When using Forms Printer to export reports to file or E-mail reports as an attachment, you must select the 
file type for the exported file or attachment. The file type options vary depending upon whether Crystal 
Reports or SQL Server Reporting Services is used to generate the report.  

Below is a list of the formats available for each tool. For details regarding these extensions, see the 
manufacturer documentation provided with Crystal Reports or SQL Reporting Services. 

Crystal Reports File Formats 

Adobe PDF 

Microsoft Office Excel Worksheet 

HTML Document 

Microsoft Office Word Document 

Rich Text Format 

Crystal Report 

Comma Separated Text File 

Tab Delimited Text File 

Text Document 

 

SQL Server Reporting Services Rendering Extensions 

Adobe PDF 

XML Document 

Image 

HMTL 4.0 Document 

HTML 3.2 Document 

MHTML Document 

Microsoft Office Excel Worksheet 

Comma Separated Text File 

Microsoft Office Word Document 

 

  



 

Subject and Attachment Name Editor 
The Subject and Attachment Name Editor Window is used to create the E-mail subject and attachment. This 
text can be manually entered text, or a combination of manually entered text and parameter fields added 
from specific report tables, system tables, and global fields. When the field is created and assigned to a 
particular document, Forms Printer will fill in any Tokens using data associated with the document being E-
mailed. 

Window Buttons 
Buttons Description 
Clear This button removes the Subject / Attachment field contents. 

Ok 
This button closes the Subject and Attachment Name Editor window 
and returns the contents of the Subject / Attachment field to the setup 
window. 

Window Fields and Controls 
Fields Description 

Select Form Fields 
The Select Form Fields List displays the form tables and fields available 
to be used as Tokens for the selected document type. Double clicking 
on a field adds that field as a token to the Subject / Attachment field. 

Select System Fields 
The Select System Fields List displays system tables and fields available 
to be used as Tokens for the selected document type. Double clicking 
on a field adds that field as a token to the Subject / Attachment field. 

Select Global Fields 
The Select Global Fields List displays global fields available to be used as 
Tokens for the selected document type. Double clicking on a field adds 
that field as a token to the Subject / Attachment field. 

Browse Data 
The Browse Data button displays a list of the first 5 unique values in the 
selected Form Table column. This is provided as an easy way to 
determine the contents of a given field. 

Database Function This read only field shows the Database Function returned from the 
Database Function Lookup. 

Database Function Lookup This button opens the Database Function Lookup window. 

Database Function Insert This button adds the Database Function shown in the Database 
Function field to the Subject / Attachment field. 

Subject / Attachment Field This text field allows inserting, typing and cut & paste of strings and 
tokens that will be used in the E-mail Subject or Attachment. 

  



 

Window Example 
The screenshot below shows an example of a parameterized subject or attachment name.  

 

Note:  Because Subject and Attachment Tokens are based on document specific tables, the texts created are available 

to be used only by the document group for which they were created. A Subject created for a Statement can be 

used as the Subject when E-mailing statements. A Subject created for unposted Sales Transactions, however, can 

be used for all unposted Quotes, Orders, Invoice, Returns, and Backorders. A Subject created for Historical Sales 

Documents may be used only for posted Quotes, Orders, Invoice, Returns, and Backorders. Subjects for Purchase 

Orders may be used only for Purchase Order formats.  

 

  



 

Select File Name Window 
The Select File Name window is used to define a file path using a combination of text and Token values.  

The Select File Name window can be opened from the Forms Printer Setup window’s To File Delivery Setup, 
and the Subject and Attachment Name Editor window. 

The use of Database Functions is described in detail in the Advanced Features, Database Functions section of 
this User Guide. 

Window Buttons 
Buttons Description 
Clear This button removes the Subject / Attachment field contents. 

Ok 
This button closes the Subject and Attachment Name Editor window 
and returns the contents of the Subject / Attachment field to the setup 
window. 

Window Fields and Controls 
Fields Description 

Select Form Fields 
The Select Form Fields List displays the form tables and fields available 
to be used as parameters for the selected document type. Double 
clicking on a field adds that field to File Name field. 

Select System Fields 
The Select System Fields List displays system tables and fields available 
to be used as parameters for the selected document type. Double 
clicking on a field adds that field File Name field. 

Select Global Fields 
The Select Global Fields List displays global fields available to be used as 
parameters for the selected document type. Double clicking on a field 
adds that field to the File Name field. 

Browse Data 
The Browse Data button displays a list of the first 5 unique values in the 
selected Form Table column. This is provided as an easy way to 
determine the contents of a given field. 

Database Function This read only field shows the Database Function returned from the 
Database Function Lookup. 

Database Function Lookup This button opens the Database Function Lookup window. 

Database Function Insert This button adds the Database Function shown in the Database 
Function field to the Subject / Attachment field. 

Subject / Attachment Field This text field allows inserting, typing and cut & paste of strings and 
tokens that will be used in the File Name field. 



 

Window Example 

 

  



 

Adding a Company Record 
NOTE: Only Add Companies if you want DIFFERENT settings between companies, SOP Document Type IDs, Class IDs or 

Master Records. If all Companies, SOP Document Type IDs, Class IDs or Master Records will use the same report 

and settings, you do not need to add Company Records. 

1. Select a Report in the Report / Company / Class ID / Master Record List. 

2. Click the New button from the control area (or right click in the treeview). 

3. Select Include New Company for Selected Report from the dropdown menu. 

4. From the Include a New Company window, select a Company from the dropdown list. 

5. Click Save. 

6. This screenshot of the Include a New Company window shows an example of the Product, Series, 

and report fields as well as the selected Company to be added. 

 

Adding a SOP Document Type ID Record 
NOTE: Only add SOP Document Type ID records if you want DIFFERENT settings between Type IDs. If all Type ID Records 

will use the same report and settings, you do not need to add Type ID Record entries. If you have a Type ID, a 

Class ID, or a Customer defined in Setup, the Customer’s settings will take precedence over the Class ID. Both 

Customer and Class ID will take precedence over the Type ID. 

1. Select a Company in the Report / Company / SOP Document Type ID / Class ID / Master Record List. 

2. Click the New button from the control area (or right click in the treeview). 

3. Select Include New SOP Documents Type ID Record for Selected Report and Company from the 

menu. 

4. From the Include a New Document Type ID window, select a Type ID by clicking on the Type ID 

Lookup. 

5. This will open a lookup window where you can select a Type ID and return it to the Include a New 

Type ID window. 

6. Click Save. 

7. This screenshot of the Include a New Document Type ID window shows the selected report and 

Company to which the Type ID is being added. 



 

 

Adding a Class ID Record 
NOTE: Only Add Class ID Records if you want DIFFERENT settings between Class IDs. If all Class ID Records will use the 

same report and settings, you do not need to add Class ID Record entries. If you have a SOP Document Type ID 

and/or Class ID and a customer in that Class ID defined in Setup, the Customer’s settings will take precedence 

over the Class and the SOP Document Type ID. 

1. Select a Company in the Report / Company / Class ID / Master Record List. 

2. Click the New button from the control area (or right click in the treeview). 

3. Select Include New Class ID Record for Selected Report and Company from the menu. 

4. From the Include a New Class ID window, select a Class ID by clicking on the Class ID Lookup. 

5. This will open a lookup window where you can select a Class ID and return it to the Include a New 

Class ID window. 

6. Click Save. 

7. This screenshot of the Include a New Class ID window shows the selected report and Company to 

which the Class ID is being added. 

 

Adding a Master Record 
NOTE: Only Add Master Records if you want DIFFERENT settings between Master Records. If all Master Records will use 

the same report and settings, you do not need to add Master Record entries. If you have a SOP Document Type ID 

and/or Class ID and a customer in that Class ID defined in Setup, the Customer’s settings will take precedence 

over the Class and the Type ID. 

1. Select a Company in the Report / Company / Class ID / Master Record List. 

2. Click the New button from the control area (or right click in the treeview). 

3. Select Include New Master Record for Selected Report and Company from the menu. 



 

4. From the Include a New Master ID window, select a Master ID by clicking on the Master ID Lookup. 

5. This will open a lookup window where you can select a Master ID and return it to the Include a New 

Master ID window. 

6. Click Save. 

7. This screenshot of the Include a New Master ID window shows the selected report and Company to 

which the Master ID is being added. 

 

Printing with Base System and Project 
Once the Forms Printer Delivery System has been setup, you can print using the normal processes for each 
document type. When printing documents with Delivery System Options, you will be presented with the 
Report Destination window, with the destination choices of ‘Screen’, ‘Printer or Delivery System’, and ‘File’. 

Choosing Screen outputs the document to either the Crystal Reports or SRS Preview window. 

Choosing Printer or Delivery System displays the Delivery System Dialog window. The Delivery System Dialog 
window allows you to select from ‘Printer’ or ‘Delivery System’. 

Choosing Printer disregards the ‘To File’ and ‘To Mail’, as well as all of the Delivery System Master 
Record Setup options, and prints the report directly to the printer defined in the Delivery System 
Document Setup window. 

Choosing Delivery System allows Forms Printer to deliver each document to the destination defined 
in either the Delivery System Document Setup window. 

Choosing File disregards the Delivery System Document Setup options, and exports the Report to the file and 
format selected in the Report Destination window.  

When choosing File, the Export Types dropdown list will display all of the available Report export types. 

Note:  Several Dialogs are presented during Forms Printer Print and Delivery. Many of these dialogs are customizable, or 

in some case can be suppressed to aid in streamlining your printing  and Delivery processes. 
 

  



 

Sample Reports in Forms Printer Base 
The installation of Forms Printer includes sample reports for Forms Printer Base and Forms Printer for 
Project. These reports are found in the Forms Printer subfolder of the Dynamics GP directory on any machine 
where Forms Printer has been installed. 

There you will see subfolders for Crystal and SSRS Reports and within those folders, a directory with reports 
organized by Series. 

For more information on using and modifying the sample reports, see the reporting tool specific sections for: 

Crystal Reports Sample Reports 
The Crystal Reports provided with Forms Printer are samples, intended to be used as templates and are 
meant to be generic examples, rather than the solution to every printing situation. These reports will need to 
be modified in order to handle specific needs. Before modifying the sample reports, it is recommended that 
you have an understanding of Crystal reports. If you are unfamiliar with Crystal reports, the quick setup is the 
easiest way to get up and running with the sample reports. If your report modification includes adding tables 
to the sample reports, follow the instructions in the Modifying Sample Reports section pertaining to your 
database type. 

Installed Sample Reports 
The Forms Printer Crystal Reports templates are installed into the following folder: [Dynamics GP Application 
Folder]\Forms Printer\Crystal Report Templates 

Within that subfolder are several subfolders for the supported Dynamics GP series. 

Using Sample Reports 
The template reports installed with Forms Printer are “generic”, that is: they are designed to work 
immediately after installation without the need for modification. Of course, you will at least want to make 
cosmetic changes to the logo and company name, etc. These changes can be made very simply without 
complex modification to the report. 

However, if you are adding tables to the report, or making other more significant changes you must follow 
the report modification instructions in the Modifying Sample Reports section. 

Modifying Sample Crystal Reports 
In order to modify the Forms Printer Base sample reports for use in your environment, you will need to have 
an installed copy of Crystal Reports application. Contact your partner or SAP for licensing and purchasing 
questions. 

Steps for Customizing Crystal Report Sample Reports 
Step 1. Note Current DSN    
Make note of the settings for the DSN used by Microsoft Dynamics GP. (Start->Control Panel->Administrative 
Tools->Data Sources (ODBC) 

Step 2. Create a Temporary DSN 
Use similar settings to create a temporary named second DSN, using a unique name for the Data Source 
Name. For example, use ASIFPTemp. This temporary DSN may be set to use a Microsoft Dynamics GP 
company database (EX: TWO) as the default, but it is not required. 



 

Step 3. Set Datasource on Report 
a. Open the sample report using the Crystal Report Designer. 

b. From the toolbar, click Database. 

c. From the dropdown menu, select ‘Set Datasource Location…’ 

d. From the ‘Replace with’ list at the bottom of the window, expand ‘Create New Connection’. 

e. Expand ‘ODBC (RDO)’.  

f. From the ODBC (RDO) window, Select the ASIFPTemp DSN from the Data Source Name list, and 

then click ‘Next’. 

g. From ‘Connection Information’, enter a valid User ID and Password. 

h. From the Database dropdown list, select your Company Database. 

i. Click ‘Finish’. 

j. Back on the Set Datasource Location window, expand ‘report’ in the ‘Current Data Source’ list. 

k. Highlight the DSN listed. 

l. From the ‘Replace with’ list, highlight the ASIFPTemp DSN listed below ‘ODBC (RDO). 

m. When both DSNs have been highlighted, click ‘Update’. 

n. Click ‘Close’ when finished. 

Step 4. Add SQL Objects, as Needed 
If additional Tables, Views or Stored Procedures are needed, follow the Crystal Reports Application 
documentation for adding tables in the Crystal Report Designer using the ASIFPTemp DSN.  

Step 5. Save the Report 
Save the Crystal Report in the directory used in the Forms Printer setup. 

NOTE:  Repeat Steps II through V for each Sample Report you need to modify. 

Step 6. Remove the Temporary DSN 
Once each of the reports you intend to modify have been corrected, delete the ASIFPTemp DSN 
created in Step I. This allows the generic report to be printed from multiple company databases using 
the DSN used to log into Microsoft Dynamics GP. 

SQL Reporting Services Sample Reports 
Installed Sample Reports 
The Forms Printer SQL Reporting Services templates are installed into the following folder: 

[Dynamics GP Application Folder]\Forms Printer\SRS Report Templates 

Within that subfolder are several subfolders for the supported Dynamics GP series. 

Modifying Sample SSRS Reports 
Note that the sample reports are provided as a reference only so that you have a quick and easy way to 
evaluate or demo the product. Changes to, and support of, these reports is subject to normal support 
incident policy and Accountable Software makes no claim as the accuracy or supportability of the report 
content. 



 

The SQL Server Reporting Services (SSRS) reports that ship with Forms Printer are samples intended to be 
used as templates for designing reporting solutions. They will need to be modified before use with Forms 
Printer in a production environment. 

 The reports may be customized and deployed using the SQL Server Business Intelligence Development Studio 
application, the Report Builder Available from the SSRS Report Manager web page, or the Visual Studio 
application.  

Use the following steps to customize a Forms Printer SSRS report, and deploy it to your Report Server, for use 
by Forms Printer in Dynamics GP. 

Steps for Customizing SSRS Sample Reports 
Step 1. Create New Report Server Project.  
Modification of an SSRS report first requires the creation of a new Report Server project in your application. 

Launch either Business Intelligence Development Studio or Visual Studio. 

Create a new Report Server project by using the Report Server template. The Report Server template can be 
found under Business Intelligence Projects in the New Project window. 

 

Step 2. Create New Shared Data Source 
All Forms Printer SSRS reports are configured to use a data source called GPCompany for data retrieval. You 
will need to create this data source in your project. The new data source should point to a Dynamics GP 
company database on your SQL Server. To create the data source, right click on the Shared Data Sources 
folder in the Solution Explorer window and select the context menu item to add a new data source. Name the 
data source GPCompany and set the connection string to point to a Dynamics GP company database in your 
SQL Server. 



 

 

Step 3. Add Forms Printer SSRS Report to Project 
Next, you will need to add the SSRS report that you wish to modify into your project. In the Solution Explorer 
window, right click on the Reports folder and select Add, then Existing Item. Browse the file system to find 
the Dynamics GP install folder. The Forms Printer SSRS reports are located in Dynamics GP Series sub folders 
of the folder SSRS Report Templates, a sub folder of the Dynamics GP client application folder.   

Add the report(s) that you wish to modify. The report layout, and SQL query can then be modified as desired. 

 



 

 

All parameters that are passed to each report by Forms Printer are already defined in the report. 
Note that the order and data type of the report parameters are important for proper execution of 
the report by Forms Printer. 

Step 4. Deploy Modified Report to Report Server 
Once you have completed customizing the report, it can be deployed to your Report Server. Before deploying 
the report, configure the deployment properties of the project in order to specify the location of the Report 
Server and the target folders on the Report Server for your report and data source. The deployment 
properties can be set by opening the project property page from the project menu or from the project folder 
context menu in the Solution Explorer window. 



 

 

Once the deployment properties have been set, the report can be deployed to the Report Server by selecting 
Deploy from the Build menu or from the context menu of the report in the Solution Explorer window. 

After the deployment has completed successfully, the report can be selected for use in the Forms Printer 
Setup window in Dynamics GP. 

Deploying Unmodified Forms Printer SSRS Reports to a Report Server 
There may be circumstances when you wish to deploy an unmodified Forms Printer SSRS report to your 
Reporting Services Report Server, for instance, when preparing a product demonstration.  In such cases, the 
Reporting Services Report Manager web application can be used to perform the task. The Report Manager 
application allows report files to be uploaded to the Report Server database, which is equivalent to 
publishing the reports. Follow these steps to deploy a Forms Printer SSRS report to the Reporting Services 
Report Server, for later use by Forms Printer in Dynamics GP. 

1. Upload Report File To Report Server 

Launch your web browser and navigate to the Reporting Services Report Manager web application. 
By default, the URL is http://<servername>/Reports. Click the Upload File link on the Contents tab 
of the Home page, or on any folder page. This will open the Upload File web page. Browse to the 
report file on your file system that you wish to upload and select it. The Forms Printer SSRS reports 
are located in the Stub SRS Reports folder beneath the Dynamics GP install folder. 

Press OK to upload the report file into the Report Server database. 



 

 

2. Configure Report Data Source 

Once a report has been published on the Report Server using the Report Manager, you will need to 
configure its data source. All Forms Printer SSRS reports are configured to use a data source called 
GPCompany for data retrieval. If this data source does not exist on your Report Server, then you can 
associate the report with any existing data source that points to a GP company database. To do this, 
click on the link for the report in Report Manager to open the report. Next click on the Properties tab 
at the top of the page, and then click on the Data Source tab at the side of the page. In the Data 
Sources page you can browse and select an existing GP company data source for your report. 

 



 

 

After you have applied the change to the data source of your report, the report is ready for use by Forms 
Printer. The report can be selected for use in the Forms Printer Setup window in Dynamics GP. 

Multi Company SQL Server Reporting Services Reports 
We recommend two techniques for configuring SSRS reports for use in a multi company environment. 

1. Publish a Copy Of Each Report For Each Company 

Using the Report Manager Web application, a report can be published to multiple folder locations on the 
Report Server, with each copy configured to use a different company specific data source. 

2. Configure Each Report to Dynamically Select a Company at Run Time 

Using the report designer application, the data source definition of the report can be modified to use the 
value of a report parameter, in order to specify the company database in which to execute the report query. 

 

This will require changing the report from using a shared data source to using an embedded data source. The 
connection string of the embedded data source can be defined as an expression that dynamically sets the 



 

company database from a report parameter value. Below is a screenshot of the Data source window using a 
dynamic connection string. 

 

Use the following steps to configure a particular report to use a report parameter value for company 
selection: 

1. Open the report in a Report Server project in Business Intelligence Development Studio or Visual 

Studio. 

2. Select the Data tab of the report in the design surface. 

3. Open the Dataset window for the GP Company dataset, by clicking on the ellipsis button next to 

the Dataset drop down list in the Data tab. 

4. Open the Data Source window for the dataset, by clicking on the Data Source ellipsis button in 

the Query tab of the Dataset window. 

5. Uncheck the Use shared data source reference check box. 

6. Set the data source type to Microsoft SQL Server. 

7. Enter an expression for the connection string, setting the Initial Catalog to be the value of the 

report parameter that specifies the current company database in Dynamics GP:  

8. ="Data Source=localhost; Initial Catalog=" & Parameters!CompanyID.Value 



 

9. Specify the credentials for the data source. 

10. Save and publish the report to the Report Server. 

Report Requirements and Considerations 
The reports you choose to use when printing with Forms Printer Base System can be simple modifications to 
the Crystal or SRS report templates shipped with Forms Printer or they can be created from scratch in your 
tool of choice. 

In either case it is important to note that ALL Forms Printer reports have certain requirements and critical 
considerations regarding their design and content. 

Report Requirements 
The requirements for reports to be printed using Forms Printer are all based upon the report’s parameters. 
Reports used in Forms Printer will error if the following parameter requirements are not met. The 
requirements are: 

1. The Minimum Parameter Count - Your report may have more than the required parameters but 

may not have fewer than those indicated in the templates or errors will occur and the report will 

not print. 

2. The Parameter Order  

3. The Parameter’s Data Type 

Important Considerations 
Along with Parameter Requirements, each report has important considerations which must be understood, 
and in MOST cases, heeded so that the report can display as intended. These important considerations 
include: 

1. Report Tables 

2. Report Table Joins 

3. Report Selection Criteria 

While a report used in Forms Printer will not error without the suggested tables, joins and selection criteria, 
there is a VERY likely chance that the report will not display the correct data intended by the Dynamics GP 
printing process if any of these considerations are not followed.  



 

Forms Printer Plus 
Overview 
Once the Configuration of Forms Printer is complete, the next step is to add Forms Printer Plus reports, 
choosing how the report should be launched, selecting the report to be run, mapping fields from the window 
to the report, and deciding on delivery to file, printer and E-mail.  

To begin this process, open the Forms Printer Plus Setup Window, launch the Forms Printer Plus Setup 
Wizard by clicking on the New button on the Forms Printer Plus Setup window. 

Once you have created a report setup, it will appear in the Forms Printer Plus Setup treeview and you will be 
able to edit its various options directly in each tab of Forms Printer Plus Setup. For details on the Forms 
Printer Plus Setup window tabs, see the section below detailing the Forms Printer Plus Setup Wizard.  

 



 

Forms Printer Plus Setup Window 
The Forms Printer Plus Setup window is used to view and modify previously defined report setups as well as 
to launch the Forms Printer Plus Setup Wizard where new reports can be defined. 

Window Navigation 
To access the setup information, use the Menu item: 

 Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer Plus 

The screenshot below shows the menu path. 

 

Window Buttons 
Buttons Description 
Save Saves any changes made to window values. 

New This button opens the Forms Printer Plus Setup Wizard where a new report 
setup can be defined. 

Delete Deletes the currently selected report from the tree view. 

Report Engine Setup 
Displays the Report Engine Setup menu options for setup of the available 
reporting tools. Note that this window is shared with Forms Printer and Plus. If 
using both products, setup only needs to be done once. 

Window Fields 
Fields Description 

Tree view 
This treeview list is used to display and modify the list of reports that are setup in 
Forms Printer Plus. The tree view lists defined reports using the hierarchy of 
Product, Series, Form, Company, and Report display name. 

Setup Options Pane This editable page shows the tabs used to modify the various settings for the 
record selected in the treeview. 



 

Window Example 
This screenshot shows the Forms Printer Plus Setup window as it will appear before adding report records.  

 

Forms Printer Plus Setup Wizard 
The Forms Printer Plus Wizard is used to create new report setups. After launching the wizard from Forms 
Printer Plus Setup, you will navigate through each tab, defining the required information on that tab. Once 
complete, click the Next button to be taken to the net tab in the sequence.  

Each tab includes a brief explanation of the tab’s functionality as well as the same set of basic navigation 
buttons defined below. 

Wizard Buttons 
Button Description 

Cancel Closes the Setup wizard without saving the report setup. 

Previous Navigates back one tab in the setup process. 

Next Navigates to the next tab in the setup process. 

Save After entering all required setup information, this button closes the wizard and 
creates the new report setup, displayed in the Forms Printer Plus Setup window. 

This treeview will display 
created reports setups 

using 

Product >  

Series >  

Form > 

 Company >  

Report Display Name  

This pane will display the various 

Report Setup Tabs  

Used to view and modify created reports setups 



 

Wizard Tabs 
Using the Wizard buttons allows the user to navigate through each of the Wizard tabs, choosing options for 
setup. 

Welcome Tab 
The Welcome tab displays a brief description of the steps that will be performed in the Setup Wizard. 

Window Example - Welcome 

 



 

Company Tab 
The Company tab is used to define in which company(s) the defined report should be run.  

Tab Buttons 
Button Description 

Companies 

This radio group is used to determine whether the report setup will be available in 
All Companies or within a Specific Company. By default, the setup will be available 
in all companies. To define the setup for an individual company, mark the Specific 
Company radio option then use the Specific Company list to choose the company in 
which the setup will be available. 

Tab Fields 
Field Description 

Select Company 

This list box, enabled when the Specific Company radio button is selected, 
displays the available companies within Dynamics GP. If the report setup being 
created is intended to be available in a single company, use this list to choose the 
company in which the report will be available. 

 

Window Example 

 

Note: Once a report setup is created and saved using the “All Companies” selection, you will NOT be able to define a 

report setup using the Specific Company selection using the same Window and Button as a setup using the ‘All 

Companies’ selection. You can define multiple reports for the same window using the Additional menu or other 

buttons. 



 

Window Tab 
The Window tab is used to select the window to which the Forms Printer Plus report should be attached. 

Tab Buttons 
Button Description 

Help Me Choose 
This button puts the wizard into a “Picker” mode that assists the user in selecting 
the window on which the report will be available. See the Help Me Choose 
Window Picker for details. 

Window Lookup 
This button opens the Window Lookup window allowing the user to manually 
select the window on which the report will be available. See the Window Lookup 
Window for details. 

Tab Fields 
Field Description 

Product This display only text fields shows the product in which the window returned by 
either the Help Me Choose process or the Window Lookup exists. 

Series This display only text fields shows the series of the window returned by either the 
Help Me Choose process or the Window Lookup. 

Form This display only text fields shows the Form of the window returned by either the 
Help Me Choose process or the Window Lookup. 

Window This display only text fields shows the window returned by either the Help Me 
Choose process or the Window Lookup. 

 

Window Example 

 



 

Window Lookup Window 
The Window Lookup window, aside from having an awkward name, is used to select the window on which a 
Forms Printer Plus report will be available. The selection of the window is made manually on this window by 
choosing the source product, series, and form. 

Note:  If unsure of the Product, Series, Form or window, the Help Me Choose option provides a ‘point and click’ selector 

that will identify these elements automatically.  

Tab Buttons 
Button Description 

Select This button closes the Window Lookup window and returns the selected information to the wizard. 

Cancel This button closes the Window Lookup window without returning information to the wizard. 

Tab Fields 
Field Description 

Product This dropdown list displays a list of products included in the current Dynamics GP system. 
Use it to select the product in which the intended window exists. 

Series Once the Product is selected, this dropdown lists the series that exist in that product. Use it 
to select the series in which the intended. 

Forms Once the Series is chosen, this list shows the available forms within the selected series and 
product. Use it to select the form on which the intended window exists. 

Window Once the Form is selected, this list displays the windows available on the selected form. Use 
it to choose the window on which the report should be available. 

Window Example 

 



 

Help Me Choose - Window Picker 
The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Window tab, this 
mode is used to click on the window on which the Forms Printer Plus report is to be available. To choose the 
GP window using the picker, first click on the Help Me Choose button from the Window tab. Dynamics GP 
will be brought to the foreground and Picker mode is indicated by a change in the cursor to the image shown 
below: 

 

While in Picker Mode, navigate Dynamics GP through the normal menu selection or other navigation 
methods and open the window on which the report is to be attached. Once open, click on the window to 
select it and return the window information back to the Forms Printer Plus Window tab. 

Below is an example of a Dynamics GP window about to be selected in Picker mode. 

 

Note: You may find that not all fields on the window are selectable with the Picker. If this is the case, use the Field 

Lookup window to manually select from a list of available fields.  

While in Picker mode, you can cancel and return to the wizard by clicking the Cancel Picker button on the 

Window tab. 



 

Print Initiation Tab 
The Print Initiation tab is used to determine the process by which the report will be run. The choice is made 
to have the report run from the Additional menu or from a button on the window selected on the Window 
tab. 

Tab Buttons 
Button Description 

Help Me Choose 
This button puts the wizard into a “Picker” mode that assists the user in selecting 
the button to be used in launching the report. See the Help Me Choose Field Picker 
for details. 

Field Lookup 
This button opens the Field Lookup window allowing the user to manually select 
button to be used in launching the report. See the Field Lookup Window for 
details. 

Tab Fields 

Field Description 

Product This displays the product containing the selected window. 

Window This displays the selected window. 

Print From This radio group determines whether the report will be run from the Additional 
menu or from a button on the window. 

Additional Menu This radio button option is the default. When selected, the report will be available 
from the window from the Additional menu on the selected window. 

Menu Name Enabled when the Additional Menu radio button is selected, this field is used to 
enter text as it should appear on the menu when selecting the report to run. 

Window Button This radio button option is selected when the report is to be run by clicking on a 
button on the selected window. 

Window Button 
Displayed and enabled when the Window Button radio button is selected, this field 
displays the name of the window button chosen by either the Lookup of Picker 
process.  

 

Note: When set to Window Button for the Print From setting, Forms Printer Plus will run the report defined after the 

other normal processing defined for the selected button. 

 

  



 

Window Example 

  

Field Lookup Window  
The Field Lookup window, when opened from the Print Initiation tab is used to select the button from which 
the Forms Printer Plus report will be run. The selection of the button is made manually on this window by 
choosing from the list of buttons available on the window chosen on the Window tab. 

Note:  If unsure of the button, the Help Me Choose option provides a ‘point and click’ selector that will identify the 

button by clicking on it.  

Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard and clicking the 

Cancel Picker button shown in place of the Help Me Choose button. 

Window Buttons 
Button Description 

Select This button closes the Field Lookup window and returns the selected information to 
the wizard. 

Cancel This button closes the Field Lookup window without returning information to the 
wizard. 

Window Fields 
Field Description 

Form Displays the form name of the selected window. 

Window Displays the name of the selected window on which the report will be run. 

Include Local Fields 
This checkbox changes which fields are shown in the Fields list. With the box 
checked, all fields created as part of the current form will be shown along with 
table fields and window controls, such as buttons, dropdown lists, etc. 



 

Fields 
This list displays all of the buttons available on the selected window. Choose the 
desired button and then click the Select button to close the Field Lookup window 
and return the selection to the wizard. 

Window Example – Field Lookup  

 

Help Me Choose - Button Picker 
The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Print Initiation 
tab, this mode is used to click on the button from which the Forms Printer Plus report is to be run. To choose 
the button using the picker, first click on the Help Me Choose button from the Print Initiation tab. Dynamics 
GP will be brought to the foreground. If the window chosen from the Window tab was not closed, it should 
be the focused window. If it isn’t, navigate Dynamics GP through the normal menu selection or other 
navigation methods and open the window chosen on the Window tab.  

Once the window is open, Picker mode will be indicated by a change in the cursor to the image shown below: 

 

Click on the desired window button to select it and return the button information back to the Forms Printer 
Plus Print Initiation tab. 

  



 

Note: In Dynamics GP 2015 R2, a new window ribbon bar was implemented. The Forms Printer Plus Button Picker 

WILL NOT recognize buttons on this ribbon. You will need to use the Field Lookup window and select the print 

button manually if using the R2 ribbon bar. 

Because the window has already been selected in the Window tab, Picker Mode will not allow any button except 

those on the selected window to be returned to the wizard. 

Picker mode can be canceled at any by returning to the Forms Printer Plus Setup or Wizard and clicking the 

Cancel Picker button shown in place of the Help Me Choose button. 

You may find that not all fields on the window are selectable with the Picker. If this is the case, use the Field 

Lookup window to manually select from a list of available fields.  

Report Tab 
The Report tab is used to determine whether the Forms Printer Plus report will be a Crystal or SSRS report. 
With that determination made, the path to the Crystal Report or the selection of the published SSRS report is 
made. 

Tab Buttons 
Button Description 

Report Lookup 
This button opens either the Open window to select the physical Crystal report file or 
the SSRS report list to select the published SSRS report depending upon the selection 
made in the Report Type radio group. 

 

Tab Fields 
Field Description 

Report Type This radio group is used to select between the available report types: Crystal 
Reports or SQL Reporting Services reports. 

Crystal Report 

This default radio option enables the Report Path Lookup button to browse the file 
system for the physical Crystal Report .rpt file. 
 
Note:  Crystal Reports added through Forms Printer Plus follow the same “generic” data 

connection rules as those used in Forms Printer Base. See the Crystal Report Setup 

section for details. 

SQL Reporting Services This option enables the Report Path Lookup button to open the Select Report 
window listing the published SSRS reports. 

Report Path This text field displays the path / url and name of the report selected by the Report 
Lookup button. 

  



 

Window Example 

 



 

Parameters Tab 
The Parameters tab is used to display the parameters on the selected report and choose how the values for 
those parameters will be supplied. The value passed to the report’s parameters can come from manually 
entered values entered by the user at the time the report prints, manually entered input when the report 
setup is defined, or from field values on the selected window. 

Tab Buttons 

Button Description 

Help Me Choose 
This button puts the wizard into a “Picker” mode that assists the user in selecting 
the button to be used in launching the report. See the Help Me Choose Field Picker 
for details. 

Field Lookup 
This button opens the Field Lookup window allowing the user to manually select 
button to be used in launching the report. See the Field Lookup Window for 
details. 

Tab Fields 

Field Description 

Parameters This field lists each of the parameters found on the report selected on the Report 
tab. 

How parameter values 
are obtained 

This radio group determines how the parameter selected in the Parameters list 
will be populated at the time the report runs. 

Data Type This read only field shows the data type of the parameter as defined in the report. 

Prompt for value using 
the following text 

This radio button option and text box enable the selected parameter value to be 
supplied by the end user manually. The text entered into the text field will be 
presented to the user in a dialog box where they must type a value to be passed to 
the selected parameter. 

Use the following value This radio button option enables a text box where a value for the parameter can 
be defined and saved during setup. 

Get the value from the 
following window field 

This radio button option and text box enable the selected parameter value to be 
supplied from a field value on the window selected on the Window tab.  
 
The field to be used can be selected manually using the Field Lookup Parameter 
window or by point and click with the Help Me Choose Parameter Field Picker. 

Use Default value from 
the report 

This radio button is enabled if the selected report parameter has a predefined 
default value. This selection allows Forms Printer Plus to ‘ignore’ the selected 
parameter and not try to pass a value to it.  

Current User ID This radio button allows you to pass the User ID of the currently logged in user to a 
parameter on the report.  

Current Company ID 

This radio button allows the Company ID string to be passed to a report 
parameter. This enables the company to be referenced for Datasource access in 
printing SSRS reports. In SSRS and Crystal Reports it provides a way to 
programmatically access company specific information or control formatting 
based on company. 

 

Note: If the selected report has more than one parameter, you will need to select each parameter individually in the 

parameters list by clicking on it to highlight it. Then, define the manner in which its value is to be obtained by 

selecting the desired radio button option and supplying the required value. 



 

Window Example 

 

 



 

Field Lookup – Parameter Window  
The Parameter Field Lookup window, when opened from the Print Initiation tab is used to select the button 
from which the Forms Printer Plus report will be run. The selection of the button is made manually on this 
window by choosing from the list of buttons available on the window chosen on the Window tab. 

Note:  If unsure of the button, the Help Me Choose option provides a ‘point and click’ selector that will identify the 

button by clicking on it.  

Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard and clicking the 

Cancel Picker button shown in place of the Help Me Choose button. 

Window Buttons 
Button Description 

Select This button closes the Field Lookup window and returns the selected information to 
the wizard. 

Cancel This button closes the Field Lookup window without returning information to the 
wizard. 

Window Fields 
Field Description 

Form Displays the form name of the selected window. 

Window Displays the name of the selected window on which the report will be run. 

Include Local Fields 
This checkbox changes which fields are shown in the Fields list. With the box 
checked, all fields created as part of the current form will be shown along with 
table fields and window controls, such as buttons, dropdown lists, etc. 

Fields 

This list displays all of the fields available from the selected window which can be 
chosen to supply the parameter value. Choose the desired field and then click the 
Select button to close the Field Lookup window and return the selection to the 
wizard. 

Window Example 

 



 

Help Me Choose – Parameter Field Picker 
The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Parameter tab, 
this mode is used to map parameters on the select report with fields on the window that can supply that 
value to the parameter. To choose the field using the picker, first click on the Help Me Choose button from 
the Parameter tab. Dynamics GP will be brought to the foreground. If the window chosen from the Window 
tab was not closed, it should be the focused window. If it isn’t, navigate Dynamics GP through the normal 
menu selection or other navigation methods and open the window chosen on the Window tab.  

Once the window is open, Picker mode will be indicated by a change in the cursor to the image shown below: 

 

Click on the desired Field to select it and return the field information back to the Forms Printer Plus 
Parameter tab. 

Note: Only fields visible on the window can be selected while in Picker mode. Many other hidden fields are available 

with valid data and may be desired as the source of a parameter’s value. To select any of these hidden fields, you 

must use the Field Lookup where the entire list of fields on the window are displayed. 

Because the window has already been selected in the Window tab, Picker Mode will not allow any field except 

those on the selected window to be returned to the wizard. 

 Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard and clicking the 

Cancel Picker button shown in pace of the Help Me Choose button. 

 

Delivery Options Tab 
The Delivery Options tab is used to define default options relating to report dissemination. When printing a 
Forms Printer Plus report, the end user will be presented with a Report Options window where Preview, 
Print, and To File options will be available. In addition, the option to Deliver will also be available from the 
Print Options menu. The settings for this selection are determined on the Delivery Options tab. All settings 
determined in this setup become the default when Deliver is selected from the Report Options window and 
all delivery options apply automatically without the need for end user intervention or selection. 



 

Window Example 

 

Window Fields and Controls 
Fields Description 
To File Mark this checkbox to have the report exported to a file each time it is 

delivered, regardless of whether ‘File’ was selected as the destination on the 
Report Destination window. 

     File Format The File Format selection determines the format for the exported document. 
     Save Folder Determines the directory in which Forms Printer Plus will create the exported 

file. This is the path to the directory, and does not include the file name. This 
folder can be determined in one of two ways: 

1. Using the Folder Browse Button. Forms Printer Plus automatically 

names the file to ensure a unique file name is created. The file is 

named with the convention: Report Name System Date System 

Time.format 

Where Report Name is the Report Setup Name entered on the Review 
tab.  
For Example: My Plus Report 06 25 01 8 30 27AM.PDF 



 

2. Using the editor window to build the folder path using manually 

entered text and / or tags from window field values. 

NOTE: Whether manually selected, entered, or built through tags, the folder 
must exist. Forms Printer Plus will not create the folder. 

Folder Path This button opens the Folder Path window which allows the building of the 
Export Directory when using the To File feature of Forms Printer Plus. See the 
Folder Path section for more detail. 

To Printer Selecting the To Printer checkbox enables the Forms Printer Plus printer 
output. Marking this option will send a copy of the report to the printer 
whenever the Deliver option is used. Left unmarked, the report will only print 
to the printer if the ‘Print’ option is selected on the Report Destination 
Window. 

     Print Using Print Using determines where the document will be printed when used within 
Microsoft Dynamics GP. The valid choices are described below. 
Printer Saved On Report – Crystal Reports ONLY 

This setting will direct the Crystal report to the printer saved in the 
Crystal Report Designer Print Setup window when the report was 
designed or modified. If the report has no defined printer or the 
defined printer is not available from the workstation, the default 
system printer will be used. 
 

Default System Printer 
This setting instructs Forms Printer Plus to print the selected report to 
the default printer defined on the user’s workstation. 
 

Ask Each Time Report Prints 
This setting will allow you to select the printer at the time the report 
is printed. Using this setting will direct the report to the selection 
made during the printing process. 

Specific Printer  
 The specific Printer option enables the Printer selection button where 

a Print window can be opened and used to define the printer and its 
default settings. 

     Copies To Print Number of copies determines the quantity output to the printer when the 
report is printed. This quantity will override any quantity selected from the 
print dialog within the report print setup, or the system default print setup. If 
using ‘Ask Each Time Report Prints’, then the number of copies entered in the 
properties window will be used.  

To Mail Selecting the ‘To Mail’ checkbox, allows delivery of the selected document by 
E-mail.  

     Use Outlook Forms Printer Plus will automatically detect whether Microsoft Outlook is 
installed, and enable or disable the Microsoft Outlook Radio button and some 
of the E-mail options accordingly. 
 
Note: If using SSRS as the Reporting Engine only Use Outlook is enabled. 

     Use Crystal MAPI If Outlook is not detected and the Reporting engine is Crystal Reports, then 
Forms Printer Plus will use the Crystal Reports MAPI mailing functionality, and 



 

automatically mark the Crystal MAPI Radio button, disabling the option to use 
Microsoft Outlook. Even if Outlook is installed, you may still choose to use 
Crystal MAPI Mail by selecting the Crystal MAPI Radio button. 
Because of the limits of the Crystal API, certain functionality is unavailable 
when not using Outlook. 
The functional limits when using Crystal MAPI functionality are: 

1. You cannot specify an ‘E-mail From’ address.  

The default profile will be used as the ‘From’ address. 
2. You cannot name the attachment.  

The attachment name will be the same as the Crystal Report used to 
create it. 

3. You cannot specify the Send Option.  

The E-mail will be sent automatically to the recipient. 
     Mail From The ‘E-mail From’ dropdown list will be enabled if Microsoft Outlook is 

installed. This dropdown list is populated by default from the Outlook Global 
Address List. Here you have the option to use the default Outlook User, or 
specify a specific E-mail Address to use as the ‘Send On Behalf Of’ mail ‘From’. 
If using an E-mail Address other than default user, the default user must have 
‘Delegate’ permissions in Outlook. For more information about this topic, 
please see the Outlook help documentation regarding Delegates. 
Note: In order to use the ‘To Mail’ feature of the Forms Printer Plus 

Delivery, the client workstation must have a Messaging Application 
Programming Interface (MAPI) compliant E-mail application loaded. 
The full version of Microsoft Outlook is currently the only supported 
MAPI client According to the Crystal /Business Objects/SAP web site. 

 To have access to all of Forms Printer Plus’s E-mailing functionality, it 
is recommended to use Microsoft Outlook 2000 or Greater. 
 
Additional help with E-mail issues can be found in the Troubleshooting 
E-mail Errors section of this document. 
 

     Mail To The E-mail To radio group allows a selection of Prompt, Manual, or Scripted. 
To have the printing user enter an E-mail address at the time the E-mail is 
created, leave the default of ‘Prompt’. To enter a hardcoded E-mail at the time 
of setup, mark the Manually entered option and enter a valid E-mail Address 
or semi colon separated list of addresses. 
 

     Scripted Mail To Button This link opens the Scripted E-mail List window allowing entry of a SQL script 
which returns a custom list of Mail Tos. 

Send Option The Send Option dropdown list allows you to select the destination for the 
created E-mail. 
The selections for Send Options are described below. 

• Send Directly to E-mail Recipient: Automatically sends the E-mail. 

• Save To Outlook Drafts folder: Creates the E-mail in the Drafts folder. 

E-mail must be sent manually. 



 

• Save to Outlook Outbox: Creates the E-mail and saves it to the 

Outbox. E-mail must be sent manually. 

• Save to Outlook Outbox Delayed: Creates the E-mail and saves it to 

the Outbox. E-mail will be sent automatically at the specified time 

selected by the Hours to Delay option. 

• Display created E-mail: Creates the E-mail displays the E-mail rather 

than sending or saving it. Once any required modifications are made, 

the E-mail can be modified and then saved or sent manually. 

• Reply To Selected E-mail: By default, Forms Printer will prompt the 

user notifying them that the Reply To Selected E-mail is about to run, 

giving the user a chance to select the E-mail they wish to reply to. 

After clicking Ok on the dialog, the document and E-mail body, as 

defined in Forms Printer Setup, will be attached as a reply to the 

user’s selected E-mail. 

Note: Several important points need to be understood when using the Reply 

To Selected E-mail feature: 

1. The user must select an E-mail Item. A message will be generated if the 

selected Item is not an E-mail which can be replied to giving the user 

one additional chance to select the correct Reply To E-mail Item.  

2. The feature is disabled when E-mailing a batch or range of documents. 

The documents will be created as defined in Setup but will be saved to 

the Drafts folder as new E-mails in the case of batch or range E-mailing. 

3. The feature will work whether the user has already clicked Reply or not. 

4. The feature works when using the Inline Reply or the Pop Out reply. 

5. This feature ALWAYS uses the Reply All option when replying to the 

selected E-mail. 

6. The dialog notifying the user to select the Reply To E-mail can be 

disabled in the Dex.ini. See ASIOUTLOOKREPLYPRESELECT for more 

details on this setting. 

          Hours To Delay The Hours to delay option is enabled when the Send Option dropdown list is 
set to ‘Save to Outlook Outbox Delayed’. Setting this number adds the 
specified number of hours to the current system time, and uses that to set the 
E-mail’s delayed send property. For example, if the E-mail was created at 
10:15 AM, and the Send option was set to Save To Outlook Outbox delayed, 
with an Hours To Delay setting of 12, the E-mail would be created in the 
Outbox, and would stay there until 10:15 PM, and then it would be E-mailed to 
the selected Recipients. 

Attachment Format The Attachment Format dropdown list allows you to specify the format for the 
E-mail attachment.   



 

Attachment Name The Attachment Name allows you to enter the text, as it will appear in the E-
mail for the attachment name. To create a calculated Attachment Name, open 
the Subject and Attachment Name Editor window using the expansion button.  
When creating an attachment name, the following characters should be 
avoided, as they are invalid in the name of a file: 
   \ / ? * : “ <> | 
 
See the Editor Window for specifics on creating a parameterized Attachment 
Name. 

     Subject  E-mail Subject sets the text, as it will appear in the E-mail Subject line. To 
create a calculated subject, open the E-mail Subject Editor window using the 
expansion button. See the Editor Window for specifics on creating a 
parameterized Subject. 

     Message This field displays the Message as it will appear in the E-mail body. To create a 
calculated Message, open the E-mail Message Editor window using the 
expansion button. See the Editor Window for specifics on creating a 
parameterized Message. 

  
 

Review Tab 
The review tab provides includes a field for naming the report setup as well as a summary of the options 
selected across all of the setup tabs in the wizard. Use it as an opportunity to check that the setup is as 
expected. 

*At this point you can move back and forth between the various setup tabs as needed to correct or adjust 
settings.  

Once completed, clicking the Save button will create the setup and return to the Forms Printer Plus Setup 
window. If there are any issues, a dialog box identifying information that might be missing or incorrect is 
displayed. 

Window Fields 
Field Description 

Report Setup Name This field is used to enter the display name of the report setup. 

Review pane The review pane shows the selections made on the various windows. 
 



 

Window Example 

  

Note: Be aware that a change on one tab can have affects across all of the other tabs in the setup. A change to the 

selected window or report for example can greatly change the setup thereby facilitating the need to redo most if 

not all of the setup. 

 

  



 

Forms Printer for Web Client 
Forms Printer for Web Client allows for a limited set of Forms Printer Base, Project and Plus capabilities to be 
available in the Dynamics GP Web Client. With Forms Printer for Web Client, the user can: 

Print to Screen 
When printing to screen, the document is saved to user's temp folder on server as a PDF. The PDF is then 
transferred to the user’s selected client temporary folder and is opened on the client with the client’s default 
PDF reader. 

Note that Print to Screen works only when the Silverlight application has been trusted. If Silverlight has not 
been trusted, the pdf document created will be saved to the client temporary folder. 

Print to Printer 
When printing to a printer, the document is saved to user's temp folder on server as a PDF. The PDF is 
transferred to the user’s selected client temporary folder and is then printed on the client machine with the 
user’s default printer. 

Print to File 
When printing to file, the document is saved to user's temporary folder on server in selected format. Then, 
the document is transferred to user’s selected client temporary folder. 

When choosing to print to file from the Web Client using Forms Printer, the file path on the Report 
Destination window is disable and will be set to the user’s client temporary folder. The file format must be 
selected from the File Format dropdown list which is populated using the Report Export formats for the 
report engine in use. The file naming convention follows the Forms Printer standards for single documents, 
batches and ranges as defined here: File Export. 

Web Client Functional Differences 
It is important to understand the differences between Forms Printer and Forms Printer for Web Client 
functionality. 

Forms Printer Setup 
The Forms Printer Setup windows are not supported on the Web Client. All setup must be performed on a 
local client machine. 

Forms Printer Delivery System 
In the Web Client, the Forms Printer Delivery setup does not apply. Forms Printer will replace the Report 
Writer report with the report selected in Forms Printer Setup, including all levels from document through 
Master Record setup. 

Any predefined To File, To Printer, or To E-mail settings will be ignored in the Web Client. Only the user 
selected Print to Screen, Printer or File options affect the report output. 

Check Printing 
The Forms Printer functionality for printing Payroll and Payables checks has been disabled in the Web Client.  



 

Advanced Features 
Database Functions 
The Database Function feature for Forms Printer allows administrators of Forms Printer Setup to access a SQL 
User-Defined function which generates a text output as part of Forms Printer’s Delivery setup. 

Intended Use 
The Database function feature can be used in the setup of the File Export path and name, the E-mail Subject, 
E-mail Body, and E-mail Attachment Name for all reports in Forms Printer Base System which support File 
Export and E-mail. 

Important Restrictions 
This feature has some important limitations on functionality that must be understood before attempting to 
use the feature. 

Those limitations include: 

1. Scalar-valued Functions ONLY – The User-Defined SQL Function must be a scalar-valued function.  

2. String / Text Output ONLY – The SQL Database Function must output a string or text.  

Note: The User-Defined SQL Function can accept any data type, perform any operations needed, manipulate and 

retrieve any data needed, so long as it ultimately passes back a string /text result. Returning formatted text, it 

would be possible return more than one “row” of data generated by the function. 

Database Context 
It is important to understand the database context when using Database Functions in Forms Printer. When 
using the Database Function Lookup window, three options for Database context are presented: Company, 
System, and Entered. This is shown in the window snaphot below: 

 

When using the Editor window’s Insert as shown below, the context of the Lookup will be used as the 
function is added to the current Setup field. 

 

Company Database 
When selecting Company Database from the Database Function Lookup window, any function inserted into a 
setup field will NOT have the company qualifier. For example: 

{<DF>[dbo].[ASI_FormatDate](@inDate, @inFormat) 

In this way, the function and setup can be used across multiple GP companies as long as the function exists in 
all Company Databases. 



 

 

System Database 
When selecting System Database from the Database Function Lookup window, any function inserted into a 
setup field will have the Dynamcis GP System Database qualifier. For example: 

{<DF>[DYNAMICS].[dbo].[ASI_FormatDate](@inDate, @inFormat) 

In this way, the function and setup will always be executed in the context of the system database. 

Entered Database 
When selecting Company Database from the Database Function Lookup window, any function inserted into a 
setup field will NOT have the company qualifier. For example: 

{<DF>[AdventureWorks].[dbo].[ASI_FormatDate](@inDate, @inFormat) 

In this way, the function and setup will always be executed in the context of the entered database. 

Passing Parameters 
Any value from the available Forms Printer fields list or hard coded values can be passed as parameters to the 
named SQL Database Function.  All HARDCODED string and date parameters must be surround by single 
quotes. Tokens passed as parameters DO NOT need quotes as they will be evaluated by Forms Printer and set 
as needed for their data type. 

Possibilities 
The Database Function feature opens up many possibilities for data access and use in Forms Printer Delivery. 
You can use it to format fields in a custom way, as our example below shows. You can use it to access tables 
and fields not currently in the available list, you can even use it to calculate the entire returned value for 
something like the E-mail Subject, file export or E-mail body. 

 

  



 

Database Function Examples  
Scenario 1:  Format a Date 
We have a requirement to export our SOP Invoices in PDF format to a named network location and include as 
part of the exported file name the SOP Document Date formatted as follows: 

 Four digit year, a dash separator, two digit day, a dash separator and Month Name as text 

For Example, a US formatted date of 9/25/2018 needs to be: 

 2018-25-September 

To accomplish this, we create the example ASI_FormatDate SQL function shown below in our GP Company 
database “TWO”. The function accepts a date and formatting string. It passes back a string of the date year, 
month and day values formatted using that passed in formatting string. 

In our example, we have a drive called “X” with a subfolder called “SOP Invoices”. We want to export our SOP 
invoices to that folder in PDF format with the word “Invoice”, the SOP Document Number, and our specially 
formatted Document Date all part of the file name. 

The full text we would enter into the Select Text Window in Forms Printer Setup would be: 

X:\SOP Invoices\Invoice {<RF>'SOP Number' of table SOP_HDR_WORK,0}-
{<DF>[TWO].[dbo].[ASI_FormatDate]({<RF>'Document Date' of table SOP_HDR_WORK,0}, 

'year yyyy-dd-MMMM')}.pdf 

 

Statement Breakdown 
Statement Parts Explanation 
X:\SOP Invoices\Invoice  
-  
.pdf  

Literal text parts of the export file and path. 

{<RF>'SOP Number' of table SOP_HDR_WORK,0} The SOP Document number token that will be part of 
the file name. 

{} The outer brackets of the Database Function. 

<DF>  The Database Function Type Indicator 

[ASI_FormatDate]() The name of the SQL Database function with open 
and close parenthesis. 

[TWO].[dbo]. The fully qualified database and owner of the SQL 
Function.  

'year yyyy-dd-MMMM' An example string variable passed to the example SQL 
Database Function. 

{<RF>'Document Date' of table 
SOP_HDR_WORK,0} 

The Document Date Token that will be passed a s a 
variable to the SQL Database function. 

  



 

Result 
The resulting example path and file name for invoice number “12345” dated 9/25/18 would be: 

 X:\SOP Invoices\Invoice 12345-2018-25-September.pdf 

Example SQL Database Function 
Below is an example SQL Database Function that uses the SQL Format Function to format any passed in date 
to any valid passed in formatting string. 

USE TWO 
GO 
IF EXISTS (SELECT * FROM sys.objects WHERE object_id = OBJECT_ID(N'ASI_FormatDate')  
AND type in (N'FN', N'IF', N'TF', N'FS', N'FT')) 
BEGIN 
 DROP FUNCTION [dbo].[ASI_FormatDate]  
END  
GO 
 
-- ========================================================================== 
-- Author:  Dave Novak 
-- Create date:  11-18-17 
-- Description: Returns the passed date formatted  
--   with the passed in custom formatting string  
 
-- Notes:  For more details on supported values 
--   See Pre-defined Date and Time formats for the FORMAT Function 
--   https://msdn.microsoft.com/en-us/library/ee634813.aspx 
--   and 
--   Custom Date and Time formats for the FORMAT Function 
--   https://msdn.microsoft.com/en-us/library/ee634398.aspx 
 
-- ========================================================================== 
CREATE FUNCTION [dbo].[ASI_FormatDate]  
( 
 -- Add the parameters for the function here 
 @inDate datetime, 
 @inFormat varchar(50) 
) 
RETURNS varchar(50) 
AS 
BEGIN 
 -- Declare the return variable here 
 DECLARE @OutFormattedDate varchar(50) 
 
 SET @OutFormattedDate = FORMAT(@inDate, @inFormat) 
 
  
 -- Return the result of the function 
 RETURN @OutFormattedDate 
 
END 
GO 
--Give Access to GP Users 
GRANT EXECUTE ON [dbo].[ASI_FormatDate]  TO DYNGRP 
GO 

  

https://msdn.microsoft.com/en-us/library/ee634813.aspx
https://msdn.microsoft.com/en-us/library/ee634398.aspx


 

Scenario 2: Return a Custom E-mail Subject 
We have a requirement to access a date field in a custom table to determine the due date of our SOP Invoice 
Transaction(s) and set the E-mail Subject according to the document’s due date status. 

To accomplish this, we create the example ASI_GetPaymentE-mailSubject SQL function show below. The 
function accepts the SOP Type integer and SOP Number String. It passes back a string formatted as Document 
Date Month, a space, Document Date Year, a space a dash and a space, and a custom Payment message 
which will then be used as the E-mail Subject.  

The full text we would enter into the Select Text Window in Forms Printer Setup would be: 

{<DF>[TWO].[dbo].[ASI_GetInvoiceE-mailSubject]( {<RF>'SOP Type' of table SOP_HDR_WORK,0}, 
{<RF>'SOP Number' of table SOP_HDR_WORK,0})} - Reminder of Upcoming Payment 

Statement Breakdown 
Statement Parts Explanation 

{<RF>'SOP Type' of table SOP_HDR_WORK,0} SOP Type token that will be passed to the SQL Database 
Function. 

{<RF>'SOP Number' of table SOP_HDR_WORK,0} SOP Document token passed to the SQL Database function. 

{} The outer brackets of the Database Function. 

<DF>  The Database Function Type Indicator 

[ASI_ GetInvoiceE-mailSubject]() Name of the SQL Database function with open and close 
parenthesis. 

[TWO].[dbo]. The fully qualified database and owner of the SQL Function.  

- Reminder of Upcoming Payment Text included in the message 
 

Result 
The resulting E-mail Subject for an Invoice due last month but within the Grace Period might look like: 

 November 2018 – Payment Grace Period Reminder 

  



 

Example SQL Database Function 
Below is an example SQL Database Function that uses the SQL Format Function to format any passed in date 
to any valid passed in formatting string. 

IF EXISTS (SELECT * FROM sys.objects 
WHERE object_id = OBJECT_ID(N' ASI_GetPaymentE-mailSubject')  
AND type in (N'FN', N'IF', N'TF', N'FS', N'FT')) 
BEGIN 
 DROP FUNCTION [dbo].[ASI_GetPaymentE-mailSubject]  
END  
GO 
 
CREATE FUNCTION [dbo].[ASI_GetPaymentE-mailSubject]  
( 
 -- Add the parameters for the function here 
  @SOPType int, 
  @SOPNumber varchar(15) 
) 
RETURNS varchar(255) 
AS 
BEGIN 
 -- Declare the return variable here 
 DECLARE @Subject varchar(255) 
 DECLARE @PaymentDateMonth varchar(9) 
 DECLARE @PaymentDateYear char(4) 
 DECLARE @MessageType varchar(200) 
 DECLARE @PaymentDate datetime 
 DECLARE @DateDiff int 
 
 -- Add the T-SQL statements to compute the return value here 
 SELECT @PaymentDateMonth = DATENAME(month,[DateDue]),  
  @PaymentDateYear = Year([DateDue]),     
  @PaymentDate = [DateDue]  
 FROM  MyCustomTable  
 WHERE  DocType = @SOPType AND InvoiceNumber = @SOPNumber 
 
 SELECT @DateDiff = DATEDIFF(day, @PaymentDate, GETDATE()) 
 
 SELECT @MessageType =  
 CASE 
  WHEN @PaymentDate < DATEADD(day,-30,CAST(CONVERT(VARCHAR(10), GETDATE(), 111) AS 
    DATETIME)) THEN 'Past Due Payment' 
  WHEN @PaymentDate <  CAST(CONVERT(VARCHAR(10), GETDATE(), 111) AS  
   DATETIME)  THEN ' - payment Grace Period Reminder' 
  WHEN @PaymentDate <  DATEADD(day,30,CAST(CONVERT(VARCHAR(10), GETDATE(), 111) AS 
    DATETIME)) THEN ' - Reminder of Payment Due This Month' 
  ELSE 'Reminder of Upcoming Payment' 
 END  
 SELECT @Subject = @PaymentDateMonth + ' ' + @PaymentDateYear + ' - ' + @MessageType  
 -- Return the result of the function 
 RETURN @Subject 
 
END 
 
GO 
--Give Access to GP Users 
GRANT EXECUTE ON [dbo].[ASI_GetPaymentE-mailSubject]  TO DYNGRP 
GO 

  



 

HTML Formatted E-mailing 
In addition to text E-mails, Forms Printer supports an HTML formatted E-mail Body. It uses standard HTML 
and allows, with just a few restrictions, the ability to reference anything you might have in an HTML 
formatted E-mail. 

Important Notes 
1. In order for Forms Printer to identify your HTML as markup, you must begin with the <html> tag. 

2. There is not WYSIWYG editor for the HTML in Forms Printer so you can either write it directly in the 

Message Editor window or more preferredly, you can paste in code created elsewhere. 

3. You can reference images in your HTML using one of two methods. First, using paths to image files 

on a public web server such as: 

 <img border="0" hspace="0" alt="Accountable Software" align="baseline"   
  src="https://www.accountable.com/Images/AccountableLogo.png"> 

Or, only if you first send the E-mail to drafts or to screen - you can reference a local file path that is 
valid from your GP workstations. In this case, Outlook will embed the image upon creating the E-
mail. For example, this html path to a local image: 

 <img border="0" hspace="0" alt="" align="baseline"src="C:\Pictures\ASILogo.png"> 

Becomes an embedded image such as this in the sent E-mail: 

 <img width=377 height=93 style='width:3.927in;height:.9687in' 
 id="Picture_x0020_1"  src="cid:image001.png@01D36A19.754FFF60"> 

4. Due to improvements in the handling of the characters “{“ and “}”used in Forms Printer, the HTML 

functionality now allows the use of those characters in the HTML. This means that elements can now 

be defined using the <style> tag in the html document header. 

 

  



 

Example HTML Code 
 

<html> 

<head></head> 

<body style="font-family: "Lucinda Sans", serif; font-size:11pt;> 

<p>Hello,<br/>  

I have attached the invoice to your recent order {<RF>'SOP Number' of table SOP_HDR_WORK,0}. 
Please follow these steps when making payment:</p> 

<ol> 

 <li>Review Invoice 

 <li>Contact us for ACH / Wire Information 

 <li>Send Payment Notification referencing your Invoice Number 

</ol> 

<p>Best Regards,<br/> <div style="color:DarkSlateBlue; font-family:"Monotype Corsiva"; font-
size:26pt;">Stevie R. Vaughan</div></p> 

<p>Customer Service Representative</p> 

<p>Accountable Software<br/>70 Buckwalter Rd Suite 900 Royersford, PA 19468<br/>Tel. (610) 
983-3100</p> 

<p>&#160;<img border="0" hspace="0" alt="" align="baseline" 
src="https://www.accountable.com/Images/AccountableLogo.png"></p> 

<p><small>The information contained in this message may be privileged, confidential and 
protected from disclosure. If the reader of this message is not the intended recipient, or an 
employee or agent responsible for delivering this message to the intended recipient, you are 
hereby notified that any dissemination, distribution or copying of this communication is 
strictly prohibited. If you have received this communication in error, please notify your 
representative immediately and delete this message from your computer. Thank you.</small></p> 

</body> 

</html> 

  



 

Example HTML E-mail Result 
Below is the generated E-mail created by the sample HTML. 

 

 

  



 

Report Properties (Formerly Microsoft Dynamics GP Defaults) 
Microsoft Dynamics GP Defaults File Settings Replaced By Report Properties  
Forms Printer now uses the Report Properties Setup window to control the settings previously added as 
Microsoft Dynamics GP Defaults File (Dex.ini) Settings. See Report Properties Setup for details. 

In addition to Forms Printer’s functionality found on the Setup window, a series of Microsoft Dynamics GP 
Defaults File (Dex.ini) switches can also help configure Forms Printer for specific needs and environments. 
The list of switches which are user serviceable are detailed below. 

Note: Altering Forms Printer settings not documented here is not recommended. Please feel free to contact technical 

support for assistance with using the Default File Settings. 

Defaults File List 
Controlling the Print or Deliver Dialogs 

Change Default Button on Print or Deliver Dialog ASIFPDEFAULTBUTTONDELIVER 

Change the Print or Deliver Dialog Button Text ASIFPPrintOrDeliver_DialogDeliverButtonTxt 

Change the Print or Deliver Dialog Message ASIFPPrintOrDeliver_DialogMsg 

Suppress the Print or Deliver Dialog ASIFP_SOP_FORCE_PRINT_OR_DELIVER 

Suppress the E-mail Delivery Results Dialog ASIFPEmailResultDialog 

Controlling Other Dialogs and Error Logs 
Control the Crystal Reports Print Dialogs ASINoPrintDialogs 

Suppress the E-mail Error Report ASIFPNoEmailAddressErrorLog 

Suppress the Per Customer Dialog ASIFP_PER_CUSTOMER_DELIVERY_NOASKDIALOG 

Delay or suppress the ASI_Script Execute Dialog ASIFPVBSTIMEOUT 

Controlling Outlook and E-mail Behavior 
Show the Reply To Preselection Dialog ASIOUTLOOKREPLYPRESELECT 

Control No E-mail Print Behavior ASIFPEMAILNOPRINTER 

Control missing E-mail Attachment Behavior ASIFP_ERRORONMISSINGATTACHMENT 

Allow One E-mail & One Attachment per Customer ASIFP_PER_CUSTOMER_DELIVERY 

Disable Outlook Usage ASIFPUseOutlook 

Prompt for Outlook Profile ASIOUTLOOKFORCEASKPROFILE 

Set Outlook Profile to Specified Value ASIOUTLOOKFORCEMAPIPROFILE 

Improve Print Performance ASIFP_CONSOLIDATEPRINTDELIVERY 

Miscellaneous Administrative Settings 
Keep Number of SOP50200 Records Small ASIFPCLEANUP  

Force re-initialization ASIFPINITIAL 

Use the .NET version of Crystal Components ASIUSECRINET 

Disable Collections Triggers ASIFPUSECOLLECTIONS 

Controlling Print Behavior 
Use Default Printer When Not Delivering ASI_FP_TOPRINTERDELIVERYONLY 



 

Settings No Longer Used 
Suppress the Print or Deliver Dialog ASIFP_SOP_DONTASK_JUST_PRINT 

Consolidating SOP Printing by Customer ASIFPNAVLISTPRINT 

Set E-mail From List ASIFPOutlookFolder 
 

 

  



 

Scripted E-mail From and To Addresses 
The Scripted E-mail From and Scripted E-mail To Addresses can be used to write a custom SQL Select 
statement, SQL Stored Procedure, or SQL Function that returns E-mail addresses for the From, To, Cc, and Bcc 
fields of E-mails delivered by Forms Printer. 

Typical examples of the use of this functionality include instances when E-mail addresses are stored in a table 
other than the Internet Addresses table, or a rule is needed to determine which E-mail address should be 
returned based on information related to the document or master record.  

Window Buttons 
Buttons Description 
Save This button saves the changes to the Script and closes the window. 
Clear This button removes the Script contents. 
Delete This button removes the Script contents and closes the window. 

Window Fields and Controls 
Fields Description 

Select Form Fields 
The Select Form Fields List displays the form tables and fields available 
to be used as parameters for the selected document type. Double 
clicking on a field adds that field to the script text. 

Select System Fields 
The Select System Fields List displays system tables and fields available 
to be used as parameters for the selected document type. Double 
clicking on a field adds that field to the script text. 

Select Global Fields 
The Select Global Fields List displays global fields available to be used as 
parameters for the selected document type. Double clicking on a field 
adds that field to the script text. 

Browse Data 
The Browse Data button displays a list of the first 5 unique values in the 
selected Form Table column. This is provided as an easy way to 
determine the contents of a given field. 

Script Input 
The Script Input field allows the user to enter a valid SQL script. 
Supported syntax includes SELECT AND EXEC statements for SQL Tables, 
SQL Views, SQL Functions and Stored Procedures. 

Script Help The Script Help button opens the Scripted E-mail Help window which 
displays a basic explanation on the use of the Scripted E-mail feature. 

Test 
The Run Query Button opens the Scripted E-mail Query Test window 
where the entered script can be tested for syntax and proper data 
return based on entered parameters. 

  



 

Window Example – E-mail To 

 

Window Example – E-mail From 

 



 

Scripted E-mail Query Test 
The Scripted E-mail Query Test window verifies the script entered on the Scripted E-mail List window. Any 
error in the Script’s syntax, references or parameters will be displayed by a dialog box once the Run Query 
button is pressed. 

Window Fields 
Fields Description 
Parameter Name The Parameter name list shows parameters created by the entered script. 

Parameter Value The Parameter Value list allows you to enter values for each of the Parameter in 
the script allow you to test the results for one or more records as needed. 

Run Query The Run Query Button executes the entered script passing to the script any 
entered parameters. 

Results 

The results pane shows the returned data from the execution of the query. The 
data is listed in the form of the returnable fields: 

Mail From:  Displays a Mail From E-mail addresses returned by the script. 
Mail To:  Displays a semicolon separated list of the E-mail To E-mail 

addresses returned by the script. 
CC To:  Displays a semicolon separated list of the CC To E-mail addresses 

returned by the script. 
BCC To: Displays a semicolon separated list of the BCC To E-mail addresses 

returned by the script. 

Window Example 

 

  



 

 

Important Notes on Scripted E-mail From and To Addresses: 
1. The Scripted E-mail To Addresses can return 1 or more E-mail addresses for the E-mail To, CC, and 

BCC fields. When the script finds more than 1 record matching the selection formula, the records will 
be returned in a semicolon separated list. Scripted E-mail From must return a single E-mail address. 
 

2. The result of executing the E-mail From Script is the single column Mail From. 
 
The result of executing the E-mail To Script is a return of three columns: 

o Mail To 
o Cc 
o Bcc  

If you do not wish to include one or more of these, return a blank column from the script by using 
empty quotes. For example, if we wanted to return the E-mail To and Bcc but not the Cc we would 
enter something similar to: 

SELECT  
 <EmailToField> AS MailTo,  
 '' AS CC,  
 <EmailBccField> AS BCC  
FROM <EmailSourceTable> 

 
3. The context of the script execution is based on the current Dynamics GP company. If you need to 

execute the script in the context of a different database, you may add the database and owner 
qualifiers.  
For example, to execute a script in the Dynamics database with owner “dbo”  you might use syntax: 

SELECT 
 <EmailToField> AS MailTo, 
 <EmailCcField> AS CC, 
 <EmailBccField> AS BCC 
FROM DYNAMICS.dbo.<EmailSourceTable> 

 
4. The Scripted Address lists can be used to return all E-mail addresses for the E-mail. Or you can 

combine them with the E-mail To option, and Additional Mail To Addresses from the Forms Printer 
Setup Window.  
 
To use the Scripted Address lists to return all of the E-mail addresses, select the Scripted Mail to List 
option from the E-mail To dropdown list on the Forms Printer Setup window and leave the Additional 
Mail to Addresses blank.  
 

5. BE CAUTIOUS WHEN ENTERING YOUR SCRIPT.  YOU ARE RESPONSIBLE FOR ENSURING THE PROPER 
SCRIPT AND SELECTION CRITERIA HAVE BEEN ENTERED. AN INCOORECTLY ENTERED SCRIPT CAN 
SEND E-MAILS TO INDIVIDUALS YOU DID NOT INTEND.  
 
One way to test the script without the possibility of sending incorrect E-mails is to set the Send 
Option to go to the Drafts folder. That way, you can verify the E-mails created by your script. 



 

 

Pre and Post Processing Stored Procedures 
With the addition of Pre and Post Processing Stored procedures, Forms Printer can now call named stored 
procedures that administrators and implementors can use to execute custom processing as part of the Forms 
Printer printing process.  

At this time, there are two Pre-Processors, or processors that is run BEFORE Forms Printer runs the reports. 
The Pre-Processors are used to determine which records to include and which records to exclude from the 
print run. The Preprocessors are called once for each unique record in the table used by Forms Printer to 
drive the report. 

The Post Processor is called once after the reports are printed. It is called for ALL documents and document 
types printed by Forms Printer. While there are currently only two specific pre-processors, the post processor 
can be used to record information about any or all reports printed. 

*Important Notes 
1. You are not required to create any of these procedures. You only create the procedures you intend 

to use. 

2. You must MANUALLY create the Pre and or Post Stored Procedure in each GP Company database in 
which you plan to use them. 

3. The names of the Stored Procedures must be exactly as specified. 

4. The parameters of the report must be exactly as specified in the example stored procedures. 

5. You must allow execute permissions for the Stored Procedure to DYNGRP or at a minimum to those 
GP users that will run statements. 

6. If the Stored Procedure does not exist or fails for any reason, Forms Printer will CONTINUE and the 
reports will be run WITHOUT applying any custom rules or post processing. 

7. If you create the procedure but then decide not to use it, it is recommended that you delete or 
rename the procedure as Forms Printer will call the procedure if it is found. 

  



 

RM Statements Pre-Processing 
The RM Statement Pre-Processing functionality allows implementors to create, and have Forms Printer 
execute, , one of two SQL Stored Procedures that applies custom rules for determining which records to 
include in a Statement print run. This custom processing occurs in addition to the restrictions that already 
exist on the statement printing window in GP. 

The two Stored Procedures are: 

• ASIFP_RM_STATEMENT_PRE_PROCESSING _EXT: This is the extended version of the RM Statements 
Preprocessing script. It includes an expanded set of parameters to identify the Customer, Report and 
Statement ID as it is being delivered.  

Note: The ASIFP_RM_STATEMENT_PRE_PROCESSING _EXT proc, if it is created, will be used IN PLACE OF the 

ASIFP_RM_STATEMENT_PRE_PROCESSING proc, and the ASIFP_RM_STATEMENT_PRE_PROCESSING 

procedure WILL NOT BE CALLED. 

• ASIFP_RM_STATEMENT_PRE_PROCESSING: This is the basic version of the RM Statements Preprocessing 
procedure and accepts a minimum number of parameters allowing for basic handling of preprocessing. 

*Important Notes 
1. You must MANUALLY create the Stored Procedure in each GP Company database in which you plan 

to use the Statement Pre-Processing functionality. 

2. The name of the Stored Procedure must be exactly as specified, either: 
ASIFP_RM_STATEMENT_PRE_PROCESSING or ASIFP_RM_STATEMENT_PRE_PROCESSING_EXT 

3. The parameters of the report must be exactly as specified in the example stored procedure. 

4. You must allow execute permissions for the Stored Procedure to DYNGRP or at a minimum to those 
GP users that will run statements. 

5. If the Stored Procedure does not exist or fails for any reason, Forms Printer will CONTINUE and the 
statements will be run WITHOUT applying any custom rules intended in the Pre-Processing Stored 
Procedure. 

6. Any Customer record that does not return a 1 from the pre-processor will not have records in the 
ASI12304 and ASI12305 tables. 

7. In order to use the Pre-Processor correctly, your report should be based, in part, on the ASI12304 
and ASI12305 tables table although, you could use the Pre-Processor to call your own custom 
processing of records. 

  



 

ASIFP_RM_STATEMENT_PRE_PROCESSING Example  
In the example below, when printing with Forms Printer, using a report with the name 
“MyCustomStatement”, only the Statement for Customer Number “AARONFIT0001” will be included in the 
statement processing. 

CREATE PROCEDURE dbo.ASIFP_RM_STATEMENT_PRE_PROCESSING 
@ReportPathandName VARCHAR(255), 
@CustomerNumber VARCHAR(15) 
AS       
BEGIN  
 
 DECLARE @Include bit = 1  
 DECLARE @localReportName VARCHAR(255) 
 -- TO DO:  
 -- Enter your calculation below  
 -- to set the returned parameter @Include to 0 (false) or 1 (true) 
 -- Optionally use the passed in @ReportPathanName to determine your rules 
 IF @ReportPathandName LIKE '%MyCustomStatement%' 
  BEGIN 
   SELECT @Include = CASE 
   WHEN @CustomerNumber = 'AARONFIT0001' THEN  
    1 
   ELSE  
    0                                                                                         
   END  
  END 
-- End of calculation 
 
SELECT @Include 
END 
 
GO  
 
GRANT EXEC ON [dbo].[ASIFP_RM_STATEMENT_PRE_PROCESSING] TO DYNGRP 
 
GO 

  



 

ASIFP_RM_STATEMENT_PRE_PROCESSING_EXT Example  
 
CREATE PROCEDURE [dbo].ASIFP_RM_STATEMENT_PRE_PROCESSING_EXT  
 @ReportPath VARCHAR(255), 
 @CustomerNumber VARCHAR(15), 
 @ReportIndex integer, 
 @StatementID VARCHAR(15), 
 @Reprint integer -- 1 = "YES" 0 = "NO" 
 
AS  
BEGIN  
DECLARE @Include bit = 1 
 
If @Reprint = 1 
 BEGIN 
  SELECT @Include =  
   CASE WHEN @CustomerNumber <> 'AARONFIT0001' -- ONLY INCLUDE 
AARONFIT0001 Statements when reprinting 
    THEN 1  
    ELSE 0  
   END  
 END 
ElSE -- Not a Reprinted Statement so always include 
 BEGIN 
  SET @Include=1 
 END 
 
SELECT @Include 
 
END  
 
GO 
 
GRANT EXECUTE ON ASIFP_RM_STATEMENT_PRE_PROCESSING_EXT TO DYNGRP 
 
GO  



 

SOP Document Pre-Processing 
The SOP Document Pre-Processing functionality allows implementors to create, and have Forms Printer 
execute, one of two SQL Stored Procedures that applies custom rules for determining which records to 
include in a SOP Document print run.  

The two Stored Procedures are: 

• ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT: This is the extended version of the SOP Preprocessing 
script. It includes all of the parameters needed to identify the exact record in the SOP50200 table as it is 
being delivered.  

Note: The ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT proc, if it is created, will be used IN PLACE OF the 

ASIFP_SOP_DOCUMENT_PRE_PROCESSING proc, and the ASIFP_SOP_DOCUMENT_PRE_PROCESSING 

procedure WILL NOT BE CALLED. 

 

• ASIFP_SOP_DOCUMENT_PRE_PROCESSING: This is the basic version of the SOP Preprocessing procedure 
and accepts a minimum number of parameters allowing for basic handling of preprocessing. 
 

The first parameter to either SOP Pre-Processor Stored Procedure is Report Index. This unique Identifier can 
be used to select from the ASI12389, ASI12390, and other tables to determine which report is being printed 
and make decisions based the report’s setup information. 

The result of the ASIFP_SOP_DOCUMENT_PRE_PROCESSING Stored Procedure is evaluated by Forms Printer 
after each SOP Document is passed to it. If the return value is one (“1”), this indicates that the document 
should be included in the print run and the record is left in the SOP50200 table. If a zero (“0”) is returned, 
Forms Printer removes the record for that SOP Document from the SOP50200 table so that it will not be 
included in the Print run. 

*Important Notes 
1. You must MANUALLY create the Stored Procedure in each GP Company database in which you plan 

to use the Statement Pre-Processing functionality. 

2. The name of the Stored Procedure must be exactly as specified, either : 
ASIFP_SOP_DOCUMENT_PRE_PROCESSING or ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT 

3. The parameters of the report must be exactly as specified in the example stored procedure. 

4. You must allow execute permissions for the Stored Procedure to DYNGRP or at a minimum to those 
GP users that will run statements. 

5. If the Stored Procedure does not exist or fails for any reason, Forms Printer will CONTINUE and the 
SOP Documents will be run WITHOUT applying any custom rules intended in the Pre-Processing 
Stored Procedure. 

6. Any SOP Transaction record that does not return a 1 from the pre-processor will not have records in 
the SOPO50200 table. 

7. In order to use the Pre-Processor correctly, your report should be based, in part, on the SOP50200 
table although, you could use the Pre-Processor to call your own custom processing of records. 



 

8. If the stored procedure exists, it will be called every time a SOP Document is printed with Forms 
Printer. It is up to you to properly handle the result from the proc. 

ASIFP_SOP_DOCUMENT_PRE_PROCESSING Example 
 
CREATE PROCEDURE [dbo].[ASIFP_SOP_DOCUMENT_PRE_PROCESSING] 
@inReportIndex integer, 
@SOPType integer, 
@SOPNumber VARCHAR(21) 
AS       
BEGIN  
 DECLARE @Include bit = 1  
 --CHECK SOME THINGS TO SEE IF @Include should be 0 (false) 
 
 SELECT @Include =  
  CASE 
   WHEN @SOPType = 3 then  
    1 
   ELSE  
     1                                                                                                                                                                                                         
  END  
 
 SELECT @Include 
 
END 
 
GO 
 
GRANT EXEC ON [dbo].[ASIFP_SOP_DOCUMENT_PRE_PROCESSING] TO DYNGRP 
 
GO 
 

  



 

ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT Example 
 
CREATE PROCEDURE [dbo].[ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT] 
@inReportIndex integer, 
@UserID VARCHAR(15), 
@SequenceNumber integer, 
@DocType integer, 
@LocationCode VARCHAR(10), 
@PrintSequence integer, 
@SOPType integer, 
@SOPNumber VARCHAR(21) 
AS       
BEGIN  
 DECLARE @Include bit = 1  
 --CHECK SOME THINGS TO SEE IF @Include should be 0 (false) 
 
 SELECT  @Include =  
  CASE 
   WHEN @SOPType = 3 then  
    1 
   ELSE  
    1                                                                                                                                                                                                           
  END  
 SELECT @Include 
END 
 
GO 
 
GRANT EXEC ON [dbo].[ASIFP_SOP_DOCUMENT_PRE_PROCESSING_EXT] TO DYNGRP 
 
GO 
  



 

Post-Processing 
The Post-Processing functionality allows implementors to create, and have Forms Printer execute, a SQL 
Stored Procedure to run custom functionality at the completion of the Forms Printer print job.  

*Important Notes 
1. You must MANUALLY create the Stored Procedure in each GP Company database in which you plan 

to use the Post-Processing functionality. 

2. The name of the Stored Procedure must be exactly as specified: ASIFP_POST_PROCESSING 

3. The parameters of the report must be exactly as specified in the example stored procedure. 

4. You must allow execute permissions for the Stored Procedure to DYNGRP or at a minimum to those 
GP users that will run statements. 

5. If the Stored Procedure does not exist or fails for any reason, Forms Printer will CONTINUE and the 
report process will complete WITHOUT the Pos-Processing Stored Procedure executing. 

6. The Post Processor is called ONCE at the completion of the document print / delivery by Forms 
Printer.  

7. Based on the Report Index, or ReportGroupName you can determine which temporary table contains 
the records delivered and use that information in your custom post process. 

  



 

Example Stored Procedure 
In the example below, when printing with Forms Printer, using a report from the “SOP_Forms” group, a 
custom statement will be run and in all other cases nothing would occur. 

CREATE PROCEDURE ASIFP_POST_PROCESSING  
 @PrintingUser varchar(15), --The GP User who printed the documents 
 @GPSystemDate datetime, -- The GP System Date  
 @ReportIndex int = 0, --SELECT ASI_Report_Index FROM ASI12389 
 @ReportGroupName varchar(255) = 0, -- See list below 
 @SequenceNumber integer, --If not Zero, is Print Job Sequence number in Temp Table 
 @DocType integer, -- If not zero, this is the Type ID printed in GP (SOP Only) 
 @UseDeliverySystem integer, -- 1 indicates this print job was done using Deliver 
 @HasEmailError integer, -- 1 Indicates at least one Error Occurred in Emailing 
 @HasExportError integer,-- 1 Indicates at least one Error Occurred Exporting File 
 @NumberofEmailsCreated integer, -- Number of Emails Created by Delivery Process 
 @NumberofEmailErrors integer, -- Number of Errors during Email Delivery  
       -- (which means creation NOT Outlook errors sending) 
 @NumberofDocumentsIncluded integer -- Total number of docs attached to Emails 
AS 
BEGIN 
 DECLARE @PostProcessComplete bit = 1  
 SET NOCOUNT ON; 
 --Parameter 
 -- @ReportGroupName VALUES 
  --SOP_Forms 
  --Statement 
  --RM_Document 
  --POP_Purchase_Order 
  --PA_POP_Purchase_Order 
  --PM_Remittance 
  --Invoicing_Forms 
  --Mnfg_QA 
  --PA_Forms 
    -- Insert statements for procedure here 
 IF @ReportGroupName = 'SOP_Forms'   
 BEGIN 
  -- Possibly call an update or insert here  
    
  
  SELECT @PostProcessComplete = 1 
 END 
 ELSE  
 BEGIN 
  SELECT @PostProcessComplete = 0                                                                                                                                                                                                          
 END  
 
END 
GO 
GRANT EXEC ON ASIFP_POST_PROCESSING TO DYNGRP 
GO 
  



 

Logging Forms Printer Delivery 
Forms Printer allows a logging feature which will record information each time a user previews, prints, sends 
to file, or Emails a document defined in Forms Printer Base System Setup. This includes recording documents 
setup to use Crystal Reports, SSRS reports, as well as Report Writer reports. 

Logging is turned off by default and must be enabled before logging occurs. See the Enable Forms Printer 
Logging for details on how to set up Logging. 

Understanding Log Types 
When Forms Printer Logging is enabled, two types of logs are recorded: The Setup Log which records the 
existing Forms Printer Setup, and the Transaction log which records information about the document being 
delivered. 

Setup Logging 
The Setup Log takes a snapshot of the current Forms Printer Setup for the document being delivered. This 
includes all report and delivery setup information including the file, print, and Email settings. And, this 
snapshot records the setup level used, whether it was the report or company levels or per Master, Class or 
SOP Document Type ID settings applied. See Logging Inquiry for details about viewing recorded information. 

Transaction Delivery Logging 
The Transaction Log records each transaction delivered, whether the delivery occurred as a single document 
or as part of a batch, range, or multi-select Navigation delivery. The Transaction log records as much detail as 
is available about each delivery job. See Logging Inquiry for details about viewing recorded information. 

*Important Notes 
1. Logging occurs each time the final Print button of the process is pressed. For example, logging of 

Sales Transaction printing occurs when the Print button of the Sales Document Print Options window 
is pressed and not when the Print button from Sales Transaction Entry is pressed because the Sales 
Transaction Entry Print button opens the Sales Document Print Options window where printing 
options are selected before printing is initiated.   

2. While Forms Printer logs available information for each delivery, some information may be limited. 
For example, printer settings are recorded but with some limitation as to the detail that can be 
recorded depending on the printer selected during setup. 

3. Forms Printer Logging does not record any errors, or information provided, once E-mails are created 
and sent. For example: if, after sending an E-mail, it fails delivery on the receiver’s end. The failure 
notice back from the receiver is not available to be logged by Forms Printer. 

4. Only Forms Printer Base System reports are logged. Logging is not enabled for Forms Printer Plus. 

  



 

Logging Inquiry 
Logging Inquiry is used to view the logged Form Printer Job records and includes filters to narrow the search 
for specific Jobs. 

Window Buttons 
Buttons Description 
List Jobs Displays the Transaction Job Log records matching the selected restrictions. 

Window Fields 
Fields Description 

Master ID This checkbox enables the Master ID entry field where a valid Master ID 
can be entered to filter Job results. 

Activity Date This checkbox enables the Activity Date Picker where a date can be 
selected to filter job results. 

Company This checkbox enables the Company dropdown where a Company can be 
selected to filter job results. 

Report Name This checkbox enables the Report dropdown where a Report can be 
selected to filter job results. 

Document Number This checkbox enables the Document Number entry field where a valid 
Master ID can be entered to filter Job results. 

User This checkbox enables the User dropdown where a User can be selected to 
filter job results. 

Include Only Jobs with Errors This checkbox filters results to only jobs from which errors occurred. 

Sort by Job ID This radio group allows the displayed list to be ordered by ascending or 
descending order. 

Job List Scrolling Window 
The Job List Scrolling window displays the Job Log records meeting the entered restrictions. The fields 
displayed in the scrolling window include: 

Window Buttons 
Buttons Description 
Job ID Detail Expansion Button Displays the Transaction Job Log records matching the selected restrictions. 
Scrolling Window Additional 
Rows Hide / Show Button Expands and collapses the additional rows in the Job Detail scrolling window. 

Window Fields 
Fields Description 
Job ID The unique identifier for each delivery job logged. 
Report Display Name The name of the report delivered by this Job. 
Company Name The company from which the Job was initiated. 
User ID The ID of the user who initiated the delivery Job. 
Activity Date The date the Job occurred. 
Selected Job Delivery Options A brief description of the delivery methods selected for the Job. 
Print From Form The form which was used to print the Job. 
Start Time The time the Job was initiated. 
End Time The time the Job was completed. 



 

Job Delivery Result A brief description of the Job status. 
Print From Window The window which was used to print the Job. 
Emails The total number of Emails sent by the Job. 
Documents The total number of documents sent by the Job. 
Errors The total number of errors that occurred Emailing the Job. 

 

Window Example 

 

 

 

 

 

 



 

Delivery Job Detail Window 
The Delivery Job Detail window displays the transactions included in the selected Job ID. 

Window Fields 
Fields Description 
Job ID The unique ID of the selected Job. 
User ID The User who initiated the selected Job. 
Activity Date The date the Job was initiated. 
Start Time The time the Job was initiated. 
End Time The time the Job was completed. 
Company The Company from which the Job was initiated. 
Report Name The Report display name for the selected Job. 
Printed From Form The Form which was used to print the selected Job. 
Print From Window The window which was used to print the selected Job. 
Tool The report tool which was used to print the selected Job. 
Printed in Batch Displays the printed Batch ID if the Job was printed from SOP Batch Entry. 
Delivery Options Displays the default delivery methods used by the Job 
Delivery Result A brief description of the Job status. 
Emails The total number of Emails sent by the Job. 
Documents The total number of documents sent by the Job. 
Errors The total number of errors that occurred Emailing the Job. 
Transaction Scrolling Window Lists the transactions included in the selected Job. 

Additional Delivery Detail Text field displaying the results of the Transaction’s To File, To Printer, To 
Mail, or Error when one of those buttons is clicked. 

 

 



 

Window Example 

 

Job Transaction Scrolling Window 
The Job Transaction Scrolling window displays the Transaction Log records for the selected Job. The fields 
displayed in the scrolling window include: 

Window Buttons 
Buttons Image Description 
To Disk File Detail  Displays the Additional Detail of the transaction’s To File Delivery. 

To Printer Detail  Displays the To Printer Delivery settings in the Additional Delivery Detail field. 

To Mail Detail  
Opens the E-mail Detail window and displays the To Mail Delivery information in the 
Additional Detail field. 

Error Button ! Indicates an error occurred delivering the specified transaction and displays that 
error in the Additional Delivery Detail field. 

Setup  Opens the Setup Log window for the selected transaction. 



 

Window Fields 
Fields Description 
Transaction ID The unique identifier for each Transaction in the selected Job. 
Document Number String field showing the Logged transaction’s document number. 
Master ID String field showing the Logged transaction’s Customer or Vendor ID. 

Delivery Types 
Checkboxes showing Delivery methods used for the transaction and buttons to display 
additional detail for each delivery used. See the Window Buttons section for more 
detail. 

Delivery Status String showing the status of the transaction. 
Error Column displaying the Error Button with text “!” indicating when an error has occurred. 
Setup Column displaying the Setup Button. 

  



 

Setup Log Window 
The Setup Log window opens from the Setup button of the Job Transaction Scrolling Window and is used to 
view a snapshot of the setup applied to delivery of the selected Transaction. From this window, it is possible 
to determine the setup options as they were at the time of the transaction’s delivery. 

Window Buttons 
The Setup Log window includes six expansion buttons which open the Detail Window displaying the full detail 
of the field to which they are attached. If the field is empty, that setup value was not used and the Detail 
window will not open. 

Window Example 

 



 

Window Fields 
Fields Description 
Job ID The unique ID of the selected transaction. 
Delivery ID The User who initiated the selected transaction. 
Report The Report display name for the selected transaction. 
Engine The report tool which was used to print the selected transaction. 
Path The path and file name of the report file used for the selected transaction. 

Company Displays if the selected Transaction was printed based on the Company level of 
setup. Note that if other levels are displayed below, the Company was not used. 

Master ID Displays if the current transaction’s set up was based on the Customer Number / 
Vendor ID, Class ID, or SOP Document Type level of setup. Class ID 

SOP Document Type ID 
To Disk File Displays the options if delivery To File was set up for the selected transaction. 

To Printer Displays the options used if delivery To Printer was setup for the selected 
transaction. 

To Mail Displays the options if delivery To Mail was setup for the selected transaction. 
 

Detail Window 
The Detail Window is opened from the Expansion buttons found on the Setup Log window. The window 
display changes to show the setup of the different delivery options used for the selected transaction log 
record. 

Window Examples 
Below are examples of the Detail window when opened from the different field Expansion buttons on the 
Setup Log Window. 

The Detail window opened to display the To Printer and If No Email Printer settings: 

 

  



 

The Detail window opened to display the Scripted Mail To script: 

 

The Detail window opened to display the Additional Addresses options: 

 

The Detail window opened to display the Email Message. 

 



 

The Detail window opened to display the list of E-mail Attachments. 

 



 

Email Detail Window 
The Email Detail window is opened from the To Mail Detail button of the  Job Transaction Scrolling Window. 
Here you can view the E-mail setup  

Window Example 

 

Window Buttons 
Buttons Description 
View in Internet Explorer Opens the Internet Explorer window to display the message. If the body the Email 

 
  



 

Window Fields 
Fields Description 
Job ID Displays the unique identifier for the selected Job. 
Delivery ID Displays the unique identifier for the selected Transaction. 
Email ID Displays the unique identifier for the selected Email. 
From Displays the Email Address used as the selected Email’s Mail From. 
Reply To Displays the Email Address, if supplied, used as the selected Email’s Reply To Address. 
To, Cc, and Bcc Displays the Addresses used as the selected Email’s Mail To, Cc, and Bcc addresses. 
Subject Displays the selected Email’s Subject text with any tokens replaced with literal values. 
Body Displays the selected Email’s Body text with any tokens replaced with literal values. 
Attachments This scrolling window displays the list of attachments to the Email.  

Email Attachments Scrolling Window 
The Email Attachments Scrolling Window lists the file attachments of the selected Email. Columns shown 
include the file Attachment Name, the file’s display name as attached to the Email, the file Attachment Type 
as detailed below, and the Attachment File Path. The file path displayed indicates the original source for the 
attachment. In the case of the Main Attachment, this path is the path to the temporary file created by Forms 
Printer.  

Window Fields 
Fields Description 
Attachment Name The display name of the file attached. 

Attachment Type 

Indicates whether the attachment was: 
1. Main Attachment 
2. Additional Attachments  
3. GP Attachments 

Attachment File Path Displays the unique identifier for the selected Email. 
 

Attachment Types 
Main Attachment:   The transaction or document being Emailed.  

Additional Attachments:  Any File Attachments defined in the Additional Attachments window of Forms 
Printer Setup.  

GP Attachments:  Any files attached as part of the Document Attachment Management 
functionality in GP and having marked the GP Attachments option in the 
Additional Attachments window of Forms Printer Setup. 

 

  



 

View in Internet Explorer 
The Internet Explorer window opens when the View in Internet Explorer button is clicked from the Email 
Detail window and displays the Email Body text of the logged Email.  

If the Email body was designed to output an HTML formatted Email, the window will show the generated 
HTML content. 

Window Example 

  



 

Logging Utilities 
The Logging Utilities window is used to maintain the records in the Logging tables by removing records 
determined to no longer be needed whether that is based on a date, the log type, or a specific report. After 
making selection as to which records should be removed, clicking the Calculate button displays the total 
number of setup and transaction log. When the Remove Logging Records button is clicked, a verify dialog is 
presented as a final check on whether the deletion is intended.  

Window Buttons 
Buttons Description 

Calculate Prior to removing records, the Calculate button fills the Count of 
Records to be Removed field. 

Remove Logging Records Executes the deletion of the records as selected by the window 
settings. 

 

Window Fields 
Fields Description 

Remove All Logging Records Radio Button indicating all records, without restriction will be 
deleted from the logs. 

Remove Logging Records with 
Options 

Radio button allowing restrictions to be applied for which 
records will be deleted from the logs. 

Remove Transactions and Setup 
Record 

Radio button indicating records of both log file types will be 
deleted from the logs. 

Only Remove Setup Records Radio button indicating records from the Setup Log will be 
deleted but the transaction records will remain in the log tables. 

Remove Records older than This Date Picker allows a Date to be defined so that only records 
older than the selected date are removed from the logs. 

Remove Records for a selected 
Report Format 

This Dropdown list displays the Reports supported by Forms 
Printer Base System allowing for the log records for a single 
report to be deleted. 

Count of Records to be Removed 
Displays, based on the current window settings, the number of 
Setup and Transaction log records Removing Logging Records 
will delete. 



 

 
Window Example 

 

*Important Notes  
1. You are not required to enable Logging to use Forms Printer. 

2. Backing up of the Dynamics GP System database prior to using the Logging Utilities window is 
recommended. 

3. In environments where large volumes of transactions are delivered, the log files will grow very large. 

4. It is up to the administrator to maintain the log files using the Logging Utilities. 

5. If frequent truncation of the log files is necessary, it is recommended to schedule a job using SQL 
Server Agent. See Creating a Scheduled Job in SQL Management Studio. 

  



 

Creating a Scheduled Job in SQL Management Studio 
Using the SQL Server Agent, a Job can be scheduled to maintain the Forms Printer Log files, removing records 
automatically without the need to manually remove records using  the Logging Utilities window. 

Details for creating a scheduled Job can be found in SQL Server documentation. Below describes one part of 
that setup, the Job Step Properties and the values used to call the Forms Printer Stored Procedure to remove 
Logging records. 

Window Example 

 

  



 

Forms Printer Logging Utilities Stored Procedure  
The Forms Printer Logging Utilities Stored Procedure which should be used to remove Logging records is 
named ASI_FormsPrinter_TruncateLog and it is created in the Dynamics GP System database when Forms 
Printer is initialized. The stored procedure accepts the parameters: 

Parameter Data type Possible Values 

@TruncateDate char(10) 
Any Valid Date String 
Pass ‘01/01/1900’ to remove all records 
regardless of date recorded. 

@ClearSetupLog int Pass 1 to remove the Setup Log Files. 
Pass 0 to leave Setup Log Files. 

@ClearTransactionLog int Pass 1 to remove the Transaction Log Files. 
Pass 0 to leave Transaction Log Files. 

@ClearReportIndex int 

Pass as 0 to remove records for all report 
formats. Pass any Valid Report Index from 
the ASI12389 table to remove a single 
report format’s log files. 

@ExecType int 1 REQUIRED VALUE 
@JobID int 0 REQUIRED VALUE 

 

Command Example 
An example of Command text to enter in the Job Step Properties window might be:  

DECLARE @RC int 
DECLARE @TruncateDate char(10) = GETDATE()-30 
DECLARE @ClearSetupLog int = 1 
DECLARE @ClearTransactionLog int =1 
DECLARE @ClearReportIndex int = 0 
DECLARE @ExecType int = 1 
DECLARE @JobID int = 0 
 
EXECUTE @RC = [dbo].[ASI_FormsPrinter_TruncateLog]  
   @TruncateDate 
  ,@ClearSetupLog 
  ,@ClearTransactionLog 
  ,@ClearReportIndex 
  ,@ExecType 
  ,@JobID 

 
Command Parameter Values Explained 

• @TruncateDate value “GETDATE()-30” will remove records older than 30 days from the current date. 
• @ClearSetupLog & @ClearTransactionLog value of 1 indicates records in both logs will be deleted. 
• The value 0 for @ClearReportIndex indicates records for all report formats will be removed. 
• @ExecType of 1 causes the procedure to remove the records. 
• @JobID of 0 indicates all records meeting the passed criteria will be removed regardless of Job ID. 

  



 

Technical Support 
Troubleshooting Guide 
Initialization Error 
The Add-In Initialization Error occurs when there is a mismatch between the Forms Printer Add In dlls and the 
Forms Printer dictionary (.dic) file versions. The most likely cause of this is error is that the Forms Printer 
FPD1230.dic and ASI1655.dic files were not removed from the Dynamics GP client directory after the 
installation process and prior to launching Dynamics GP. 

The error dialog is shown below: 

 

 You can correct the error by removing or renaming the FPD1230.dic and ASI1655.dic files and then launching 
Dynamics GP again. 

Installation Errors 
SQL Installation Errors 
If you receive an unsuccessful message when installing on a SQL database, you may be able to determine 
what SQL Table or Stored procedure is causing the initialization to fail by using "Dexterity SQL Logging" on the 
workstation on which you are trying to initialize. This is done by editing the [General] section of the DEX.INI 
file to include the following lines: 

• SQLLogPath=c:\ 

• SQLLogSQLStmt=TRUE 

• SQLLogODBCMessages=TRUE 

Then log into Microsoft Dynamics GP and attempt to Initialize Forms Printer- a log file named c:\dexsql.log 
will be created, and if you open it with notepad at the point of the error, you will see the SQL statement that 
caused the error:  You may be able to delete the ASI123* table (if it contains no data) and its associated 
zDP_ASI123* stored procedures and then try again and see if you get past the issue. 

If you can send that dexsql.log to us, we may be able to determine what is happening. 

NOTE: After logging out of Microsoft Dynamics GP, be sure to remove the lines above from DEX.INI or set 
them to FALSE so as to not affect performance of your system or fill up your disk with the log file. 

Registration Errors 
When entering Registration keys, a failure to register warning typically occurs for 3 main reasons: 

Cause Resolution 



 

Mistyped Registration Keys 
 
Double check the keys entered and use cut and paste if possible. 
 

Incorrect Site name 

 
Double check the site name on the Registration Keys document 
provided by Accountable Software. If there is a discrepancy from your 
actual Site name, contact us to receive a new set of keys. 
 

Incorrect User Count 
Double check the number of licensed users enabled by the keys issued 
and compare to your number of System Manager users. If the keys 
enable fewer users you will need to contact Accountable for new keys. 

Report Parameter Errors 
The error ASI_SetParameters shown below occurs when the report being printed has fewer parameters than 
is expected by Forms Printer. 

 

 This error is followed by the dialog below which displays the ParamNumber, and the ParamValue.  

 

 ParamNumber indicates which Parameter on the report has the issue. ParamValue indicates the value that 
was passed to that report parameter. 

To correct report parameter issues, compare the parameters of the report being printed to the matching 
template report shipped with Forms Printer. 

  



 

E-mail Setup Errors 
In order to function properly, Forms Printer must find an Address list for possible lE-mail source addresses.  
By default, it attempts to use Outlook and an Address List named “Global Address List”, which exists by 
default in Microsoft Exchange environments. If Outlook or this address list is not found, errors will occur 
during Forms Printer Setup. 

The symptom, possible cause and resolution are listed below: 

Symptom Cause Resolution 
Forms Printer Setup 
Window either does not 
open or takes an 
unusually long time to 
open. 
 
OR 
 
Error “Can’t get address 
list object with this name 
from Redemption object” 
or similar.   
 
 OR 
 
Some functionality of 
Mail delivery is restricted 
similar to the restrictions 
for Crystal MAPI. 
 

Outlook is not 
installed or in use 
on the Client 
machine. 
 

If you are not using Outlook as your Mail Client, you may set 
the ASIFPUseOutlook Dex.ini setting to FALSE. This will disable 
the Outlook option completely, and Forms Printer will not try 
to connect to Outlook in any way. 
 
 

The client machine 
fails or causes a 
long delay while 
trying to retrieve 
the Exchange 
ServerGlobal 
Address List 
 

The cause of the dialog is that Forms Printer is unable to 
retrieve the Required Address List while communicating with 
Outlook. 
 
You can change which Address List Forms Printer attempts to 
use by changing the ASIFPOutlookFolder setting in the Dex.ini 
file. The list name entered in the Dex.ini must be a valid 
Outlook Address List. For Example, you could change the list to 
the Outlook ‘Contacts’ list by changing the Dex.ini setting to: 
ASIFPOutlookFolder = Contacts where by default it is 
ASIFPOutlookFolder = Global Address List. 
OR 
If your environment is such that you cannot create a Contacts 
or other common address list that would be available on each 
workstation, you can set the Address List to use to be 
“ASIFPOutlookFolder=NONE which will preserve most 
functionality, but only allow sending from “Default Outlook 
User”. 
 
This option is useful when using Outlook Offline while testing 
or demoing Forms Printer. 
OR 
You can edit the Address List and manually enter a list of as 
many From Address choices as needed, by entering a comma 
separated list. For Example, by changing the Dex.ini setting to: 
ASIFPOutlookFolder = person1@yourdomain.com, 
person2@yourdomain.com, person3@yourdomain.com 
 
Forms Printer will then present these choices in the E-mail 
From dropdown List of Forms Printer Setup. 
 

 

  



 

Invalid TLV Record Error 
When using Crystal Reports as the reporting engine, the “Invalid TLV Record” error is displayed for two 
known reasons: 

Cause Resolution 

The Crystal Report 
rpt file was saved 
using a Crystal 
Reports application 
version that is not 
compatible with the 
version of Crystal 
Reports dlls 
registered on the 
workstation. 

Re-run the Forms Printer install on the workstation, ensuring the correct Forms Printer 
and version of Crystal Reports is used. 
Or 
Open and save the report in a version of Crystal compatible with the version installed 
on the workstation. 
 
NOTE: 
 Advanced users may wish to use the Registry Editor to check the registered version of 
the Crystal dlls. That version can be found in the key: 
            HKEY_CLASSES_ROOT\CrystalRuntime.Application\CurVer 

The Crystal Reports 
dlls registered on the 
workstation do not 
match those installed 
to the Dynamics GP 
folder and being 
used by Forms 
Printer. 
 
Note that this occurs 
when an installation 
discrepancy between 
Crystal Reports XI 
and Crystal Reports 
XI “R2” (release 2) 
exists. 

 
Replace the dlls in the Dynamics GP folder with the version that matches the currently 
registered Crystal dlls. 
 
To replace these files first requires that the version registered is identified. To do this, 
advanced users can use the Registry and follow these steps: 

1. Find the key:      
HKEY_CLASSES_ROOT\CrystalRuntime.Application.11\CLSID   

2. Copy the listed GUID 
3. Search for that GUID  under the key: HKEY_CLASSES_ROOT\CLSID 
4. When found, expand to see the folder InprocServer32 
5. Click on the folder to see the results on the fight hand pane 
6. Check the Data column value. Here will be displayed a path to the 

registered Crystal dlls. 
If the path is: 

<drive>:\Program Files\Common Files\Business 
Objects\3.0\bin\craxdrt.dll  

Then the registered version is Crystal XI “r1” 
 
If the path is: 

<drive>: Program Files\Business Objects\Common\3.5\bin\craxdrt.dll  
Then the registered version is Crystal XI “r2” 
 

The resolution to this issue is to replace all dll files in the Dynamics GP client folder that 
begin “CRPE” with the correct version identified by the above procedure. The correct 
version of these files can be found at the paths listed above in blue. B sure to copy the 
matching version identified in the registry. 

  



 

Frequently Asked Questions 
Question:  Can I turn off the Print or Deliver or other Dialogs in Forms Printer Base System? 
Answer: Yes, see the Microsoft Dynamics GP Defaults File Settings section of the User Guide. 

Question:  What version of Crystal Reports does Forms Printer install and support? 
Answer: As of version 10.50 and greater, Forms Printer installs version XI (11) r2 of Crystal Reports. That installation 

means that Forms Printer is compatible with versions 9, 10 and 11 (r1 and r2) of Crystal reports. Note that 
Crystal 2008, 2012 and 2014 may also be used but any features added by these versions will not be available 
through the Forms Printer version of the Crystal runtime. So, any reports designed in any of those versions can 
be run with Forms Printer version 11.00. 

Question:  If we purchase Forms Printer, do we also have to purchase Crystal Reports? 
Answer: Forms Printer installs all of the files required to run a Crystal Report on a client workstation that is running 

Dynamics GP. In order to modify or create Crystal Reports you would typically purchase at least one copy of 
Crystal Reports and install it on the report designer’s workstation. No other Dynamics GP users would need a 
Crystal License. 

 Note: Crystal Reports licensing varies in the Terminal Server / Citrix environment. Please contact Business 
Objects for details on licensing compliance if using either of those environments. 

Question:  Do we have to purchase Adobe Acrobat Writer to print to PDF with Forms Printer?  
Answer: No. Forms Printer installs the Crystal runtime components and SQL Reporting Services files needed to export to 

PDF. No additional license or product is needed. 

Question:  I don’t see the report I want to print when I go Into Forms Printer Setup, why not?  
Answer: Forms Printer prints a very specific list of reports. If the report is not listed in the Forms Printer setup window, 

you can use Forms Printer Plus to add the report to any window in your Dynamics GP solution. 

Question:  How do I know if I need new Registration Keys for Forms Printer?  
Answer: New registration keys are required whenever you are installing a newer major version release of Dynamics GP, 

whenever you are increasing your number of System Manager user licenses, and when your Registered Dynamics 
GP Site name is changed.  

Question:  What version of SQL Server does Forms Printer support?  
Answer: When using the Crystal Reports Engine, SQL Server 2000 and higher are compatible with Forms Printer. 

In order to use SQL Reporting Services as the Reporting Engine you must be using SQL 2005 or higher. 

Question:  Can I E-mail using a Mail Client other than Outlook?  
Answer: Forms Printer includes specific functionality to support Outlook and can only use Outlook when using the SQL 

Server Reporting Services Engine. 
 

When using the Crystal Reports Engine and Crystal MAPI, any E-mail client supported by Crystal Reports can be 
used. Consult Business Objects’ documentation for E-mail clients supported by Crystal Reports.  

Question:  Why are there tables with names that begin with “ASI” in the report templates? 
Answer: In order to mimic the functionality of the Dynamics GP printing processes, Forms Printer must often create SQL 

Tables to store data that is generated during the Dynamics GP print process. When a template contains an “ASI” 
named table, it is typically required in order to properly print the report.  

Question:  Can bar codes be used on Crystal Reports? 



 

Answer: Yes. In order to use a bar code, you need to have a barcode font installed on all workstations that will print using 
Forms Printer, and you must modify your report to use that bar code font for the field(s) to be bar coded. 
Typically, you would use a calculated field that displayed the correct start and stop characters for the desired bar 
code type. 

Question:  Which Forms Printer Report Setup name maps to which Check Format? 
Answer: From the Print Payroll Checks window, you will see displayed the list of Check Formats. Below is a list of these 

formats with their corresponding Forms Printer Setup name: 
Check Format Forms Printer Setup Name 
Stub on Top - Continuous Employee Checks Stub on Top-D 

Stub on Bottom - Continuous Employee Checks Stub on Bottom-D 

Stub on Top and Bottom – Single Feed Employee Checks Stub on Bottom-L 

Other - Continuous Employee Checks Other -D 

Other - Single Feed Employee Checks Other -L 

Question:  Which Forms Printer Report template maps to which Project Accounting Report? 
Answer: A list at the end of this document includes all of the Forms Printer Template file names and their corresponding 

Project Accounting Report. 

Question:  Can Crystal Reports print a MICR bar code? 
Answer: Yes. In order to use the MICR Font for check printing, you must purchase and install a version of the MICR font 

then set the MICR field on the Crystal Report to use this Font Type. When printing MICR Checks, it is also 
necessary to have a MICR toner cartridge installed in the printer. You may also want to purchase special Non-
duplicatable paper for your check stock. 
Sources for MICR and barcode fonts: 

http://www.bizfonts.com 
http://www.micrfonts.com 
http://www.adobe.com/type/main.html 

These sources are provided for information only. Accountable Software does not endorse or support specific 
products from these companies. 

  

http://www.bizfonts.com/
http://www.micrfonts.com/
http://www.adobe.com/type/main.html


 

Project Accounting Report Mapping 
 

Below is the list of Sample reports and the Project Accounting report these samples are designed to support. It is important during Forms Printer setup, 
that the correct sample report be used when creating these mappings. These reports are not interchangeable, you must use the correct report, or you 
will receive no data, incorrect data or an error. 

Billing Format Name Forms Printer Setup / Report Writer Name Forms Printer Template Report Name 

T&M Summary A                                       PA Billing Summary A Report 
                                                                                                                                                                                                                              

PA Billing Summary A (.rpt or .rdl) 
T&M Summary B                                       PA Billing Summary B Report Format                                                                                                                                                                                                                              PA Billing Summary B (.rpt or .rdl) 
T&M Summary C                                       PA Billing Summary C Report 

                                                                                                                                                                                                                              
PA Billing Summary C (.rpt or .rdl) 

T&M Detailed A                                      PA Billing Detailed A Report Format                                                                                                                                                                                                                             PA Billing Detailed A (.rpt or .rdl) 
T&M Detailed B                                      PA Billing Detailed B Report 

                                                                                                                                                                                                                             
PA Billing Detailed B (.rpt or .rdl) 

T&M Detailed C                                      PA Billing Detailed C Report 
                                                                                                                                                                                                                             

PA Billing Detailed C (.rpt or .rdl) 
T&M Consulting Project                              PA Billing Invoice Format - Invoice Format 1                                                                                                                                                                                                                    PA Billing Invoice Format 1,2,5,6 (.rpt or .rdl) 
T&M Consulting Project With Tax Detail              PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                    
PA Billing Invoice Format 1,2,5,6 (.rpt or .rdl) 

T&M Consulting Contract                             PA Billing Invoice Format - Invoice Format 3                                                                                                                                                                                                                    PA Billing Invoice Format 3,4,7,8 (.rpt or .rdl) 
T&M Consulting Contract With Tax Detail             PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                    
PA Billing Invoice Format 3,4,7,8 (.rpt or .rdl) 

T&M Detailed Project                                PA Billing Invoice Format - Invoice Format 5                                                                                                                                                                                                                    PA Billing Invoice Format 1,2,5,6 (.rpt or .rdl) 
T&M Detailed Project With Tax Detail                PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                    
PA Billing Invoice Format 1,2,5,6 (.rpt or .rdl) 

T&M Detailed Contract                               PA Billing Invoice Format - Invoice Format 7                                                                                                                                                                                                                    PA Billing Invoice Format 3,4,7,8 (.rpt or .rdl) 
T&M Detailed Contract with Tax Detail               PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                    
PA Billing Invoice Format 3,4,7,8 (.rpt or .rdl) 

T&M Pre-Billing Worksheet                           PA Billing Invoice Format - Invoice Format 
                                                                                                                                                                                                                    

PA Billing Invoice Format 9-14 (.rpt or .rdl) 
T&M Basic                                           PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                   
PA Billing Invoice Format 9-14 (.rpt or .rdl) 

T&M Invoice 1                                       PA Billing Invoice Format - Invoice Format 11                                                                                                                                                                                                                   PA Billing Invoice Format 9-14 (.rpt or .rdl) 
T&M Invoice 2                                       PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                   
PA Billing Invoice Format 9-14 (.rpt or .rdl) 

T&M Invoice 3                                       PA Billing Invoice Format - Invoice Format 13                                                                                                                                                                                                                   PA Billing Invoice Format 9-14 (.rpt or .rdl) 
T&M Invoice 4                                       PA Billing Invoice Format - Invoice Format 

                                                                                                                                                                                                                   
PA Billing Invoice Format 9-14 (.rpt or .rdl) 

CP/FP Document Level Invoice                        PA Invoice Format CP/FP Document Level Invoice                                                                                                                                                                                                                  
 

PA Invoice Frmt CP-FP (.rpt or .rdl) 
CP/FP Contract Level 

                                                                                                                                                                                                                  
PA Invoice Format CP/FP Contract Level 

                                                                                                                                                                                                                  
 

PA Invoice Frmt CP-FP (.rpt or .rdl) 



 

Project Accounting Report Mapping (continued) 

CP/FP Project Level Invoice                         PA Invoice Format CP/FP Project Level Invoice                                                                                                                                                                                                                   
 

PA Invoice Frmt CP-FP (.rpt or .rdl) 
CP/FP Contract/Project Level Invoice                PA Invoice Format CP/FP Contract Project Level 

                                                                                                                                                                                                                   
 

PA Invoice Frmt CP-FP (.rpt or .rdl) 
CP/FP Pre-Billing Worksheet                         PA Invoice Format CP/FP Pre Billing 

                                                                                                                                                                                                                   
 

PA Invoice Frmt CP-FP (.rpt or .rdl) 
CP/FP Basic                                         PA Invoice Format CP/FP Basic                                                                                                                                                                                                                                   

 
PA Invoice Frmt CP-FP (.rpt or .rdl) 

CP/FP Invoice 1                                     PA Invoice Format CP/FP Invoice 
                                                                                                                                                                                                                               

PA Invoice Frmt CP-FP (.rpt or .rdl) 
CP/FP Invoice 2                                     PA Invoice Format CP/FP Invoice 2                                                                                                                                                                                                                               PA Invoice Frmt CP-FP (.rpt or .rdl) 
Fee Document Level Invoice                          PA Invoice Format Fee Document Level 

                                                                                                                                                                                                                    
 

PA Invoice Frmt Fee Document Level (.rpt or .rdl) 
Fee Contract Level Invoice                          PA Invoice Format Fee Contract Level Invoice                                                                                                                                                                                                                    

 
PA Invoice Frmt Fee Contract Level (.rpt or .rdl) 

Fee  Project Level Invoice                          PA Invoice Format Fee Project Level 
                                                                                                                                                                                                                     

 

PA Invoice Frmt Fee Project Level (.rpt or .rdl) 
Fee Contract/Project Level Invoice                  PA Invoice Format Fee Contract/Project Level 

                                                                                                                                                                                                            
 

PA Invoice Frmt Fee Contract - Project Level (.rpt or .rdl) 
Detail Page - Document Level Invoice                PA Invoice Format Document Detail Page 1                                                                                                                                                                                                                        

 
PA Invoice Doc, Con, Proj, Con-Proj Detail (.rpt or .rdl) 

Detail Page - Contract Level Invoice                PA Invoice Format Contract Detail Page 1                                                                                                                                                                                                                        
 

PA Invoice Doc, Con, Proj, Con-Proj Detail (.rpt or .rdl) 
Detail Page - Project Level Invoice                 PA Invoice Format Project Detail Page 

                                                                                                                                                                                                                        
 

PA Invoice Doc, Con, Proj, Con-Proj Detail (.rpt or .rdl) 
Detail Page - Contract/Project Invoice              PA Invoice Format Contract/Project Detail Page 1                                                                                                                                                                                                                

 
PA Invoice Doc, Con, Proj, Con-Proj Detail (.rpt or .rdl) 

Summary Page - Document Level Invoice 1             PA Invoice Format Document Summary Page 1                                                                                                                                                                                                                       PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Document Level Invoice 2             PA Invoice Format Document Summary Page 

                                                                                                                                                                                                                       
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 

Summary Page - Document Level Invoice 3             PA Invoice Format Document Summary Page 3                                                                                                                                                                                                                       PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Document Level Invoice 4             PA Invoice Format Document Summary Page 

                                                                                                                                                                                                                       
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 

Summary Page - Document Level Invoice 5             PA Invoice Format Document Summary Page 
                                                                                                                                                                                                                       

PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Contract Level Invoice 1             PA Invoice Format Contract Summary Page 

                                                                                                                                                                                                                       
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 

Summary Page - Contract Level Invoice 2             PA Invoice Format Contract Summary Page 
                                                                                                                                                                                                                       

PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Contract Level Invoice 3             PA Invoice Format Contract Summary Page 3                                                                                                                                                                                                                       PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Contract Level Invoice 4             PA Invoice Format Contract Summary Page 

                                                                                                                                                                                                                       
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 

Summary Page - Contract Level Invoice 5             PA Invoice Format Contract Summary Page 5                                                                                                                                                                                                                       PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Project Level Invoice 1              PA Invoice Format Project Summary Page 1                                                                                                                                                                                                                        PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Project Level Invoice 2              PA Invoice Format Project Summary Page 

                                                                                                                                                                                                                        
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 

Summary Page - Project Level Invoice 3              PA Invoice Format Project Summary Page 3                                                                                                                                                                                                                        PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
Summary Page - Project Level Invoice 4              PA Invoice Format Project Summary Page 

                                                                                                                                                                                                                        
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 



 

Project Accounting Report Mapping (continued) 

Summary Page - Project Level Invoice 5              PA Invoice Format Project Summary Page 
                                                                                                                                                                                                                        

PA Invoice Frmt Doc, Con, Proj Sum Pg1-5 (.rpt or .rdl) 
IV Document Level Invoice                           PA Invoice Format IV Document Level 

                                                                                                                                                                                                                     
 

PA Inv Frmt IV Document Level (.rpt or .rdl) 
IV Contract Level Invoice                           PA Invoice Format IV Contract Level Invoice                                                                                                                                                                                                                     

 
PA Inv Frmt IV Contract Level (.rpt or .rdl) 

IV Project Level Invoice                            PA Invoice Format IV Project Level Invoice                                                                                                                                                                                                                      
 

PA Inv Frmt IV Project Level (.rpt or .rdl) 
IV Contract/Project Level Invoice                   PA Invoice Format IV Contract/Project Level 

                                                                                                                                                                                                             
 

PA Inv Frmt IV Cont-Proj Level (.rpt or .rdl) 
GST PA Billing Blank Invoice Form GST PA Billing Blank Invoice Form                                                                                                                                                                                                                               PA Billing GST Invoice (.rpt or .rdl) 
GST PA Billing Blank Return Form GST PA Billing Blank Return Form                                                                                                                                                                                                                                PA Billing GST Invoice (.rpt or .rdl) 
GST PA Billing Blank History Invoice Form GST PA Billing Blank History Invoice 

                                                                                                                                                                                                                       
PA Billing GST Invoice (.rpt or .rdl) 

GST PA Billing Blank History Return Form GST PA Billing Blank History Return 
                                                                                                                                                                                                                        

PA Billing GST Invoice (.rpt or .rdl) 
PO Format A    (Project Accounting Only)  PO Format A                                                                                                                                                                                                                                                     PA PO Format 1-3 (.rpt or .rdl) 
PO Format B    (Project Accounting Only) PO Format B                                                                                                                                                                                                                                                     PA PO Format 1-3 (.rpt or .rdl) 
PO Format C    (Project Accounting Only)) PO Format C                                                                                                                                                                                                                                                     PA PO Format 1-3 (.rpt or .rdl) 
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